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1. Release Notes

1.1 Background / Environment

Oracle Financial Services Software Limited has developed Oracle Financial Services Lending and
Leasing solution. The suite is a comprehensive, end-to-end solution that supports full lifecycle of
direct and indirect consumer/Small Business/Business lending business with Origination, Servicing
and Collections modules. This enables financial institutions to make faster lending & leasing
decisions, provide better customer service and minimize delinquency rates through a single
integrated platform. It addresses each of the lending & leasing processes from design through
execution. Its robust architecture and use of leading-edge industry standard products ensure
almost limitless scalability.

1.2 Purpose

The purpose of this Release notes is to highlight the enhancements and bug fixes included in the
Oracle Financial Services Lending and Leasing Release.

1.3 Abbreviations

Abbreviation Detailed Description
OFSLL Oracle Financial Services Lending and Leasing
XML Extensible Mark-up Language
XSD XML Schema Definition
GL General Ledger
XLF Extended Log Format
JSF Java Server Faces
EAR Enterprise Application Archive
ul User Interface
WSDL Web Services Description Language
ACH Automated Clearing House
MDB Message Driven Bean
JMS Java Messaging Service
loT Internet of Things
SME Small Medium Enterprise
1-1 ORACLE
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1.4

1.5

Abbreviation

Detailed Description

UDF

User Defined Fields

Fl

Financial Institute

Product Summary

Oracle Financial Services Lending and Leasing Release built to meet various challenges faced by
financial institutions. It addresses each of the lending processes from design through execution. Its
unique value lies in its ability to provide the business with predefined processes and an excellent

framework that takes care of business risk and compliance needs.

Release Highlights

The key highlight of this release is to fix the critical bugs and to enhance the industry specific

requirements.
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2. Enhancements

Enhancement Description

Functional Enhancements

Payment Refund Usability and Operational Enhancement.
button in payment

: Customer Service User can refund the payment from ‘Payment Maintenance’
maintenance screen

screen. With one click, payment refund is posted on multiple accounts and
consolidated accounts payable is generated.

User Defined Fields Added User Defined Fields (UDFs) in Customer Servicing Account, Collateral
Management and Origination Credit Bureau to support customization.

Reschedule Billing Introduced Billing Cycle change transaction to support billing cycle change
Cycle Transaction during servicing stage and next bill is generated based on new billing cycle.

For example, a monthly Lease can be changed to Weekly Lease.

Batch Job This feature enables customer to configure Batch Jobs at each company
Configuration at level.

company level For example, if the Financial Institute (FI) has operations in multiple

Countries and they have Portfolio companies operate in Multiple Time Zones,
this feature enables them to define the Batch Jobs running at different times
based on time zone operations.

Close Account after Introduced a new ‘Close Account Indicator’ flag at product level to decide
paid off (and also overrides the system parameter ‘Close Account days after paid
off), whether account needs to be closed or not; after account is paid off.

If this flag is disabled, then OFSLL does not close the account.

Collateral Maintenance | The existing ‘Collateral Maintenance’ non-monetary transaction is enhanced

Non-Monetary to update additional Collateral fields.
Tracking Attributes Following are the changes for Tracking Attributes Bulk Update:
Bulk Update

e Capability to upload Tracking attributes for Customer,
Business and Account through generic file upload.

e Capability to update the tracking attributes of Customer,
Business, Account and Asset through web services.

Business ‘Only’ This Enhancement provides ability to create Business only
Account Applications/Accounts in OFSLL without the need to add a Primary
Enhancements Application/Customer.

This is a phase-2 of earlier enhancements and on a broad level, the impact
areas are handled as follows:

e AP Txn for Business Only Accounts

e Ability to create Business Only Loan, Line, and Lease by
removing dependency on the Correspondence, Edits,
Reports and so on.

e Master Account ODD generation for Business only
customer.

ORACLE

Financial Services



Enhancement

Description

New Billing Cycles

Following two new billing cycles support is added into OFSLL:

e BIENNIAL (Billing every 2 years)
e TRIENNIAL (Billing every 3 years)

Payment Hierarchy
Changes

Existing payment hierarchy is enhanced to include a new payment allocation
method ‘Due Ratio’ /Outstanding Amount ratio and formula.

Special Characters
handling

OFSLL ‘does not’ support the following special characters while accepting
data through Ul, web service and file upload process.

<>{}N\"[1"

New field ‘Payment
Mode’ at Application
and Account

Following are the changes as part of new ‘Payment Mode’ field:

e New ‘Payment Mode' field is introduced at Application and
Account level, which is used to identify whether the customer
is on Auto pay/Non-Auto pay.

e New transaction provided to update this ‘Payment Mode’
field in Servicing/Collections.

Events Framework
Enhancement

‘Events’ framework in OFSLL is enhanced with following:

e Enhanced the list of Entities, Event Types and Actions
e Enhanced User Defined Action Parameters

e New ‘Events’ Dashboard screen

e New ‘Pending Events Actions’ screen

Collateral Substitution

While adding collateral to an account, a provision is made to substitute or
non-substitute existing collateral linked to the account.

The ‘Substitution’ flag is made editable in ‘Customer Service>Collateral’
screen while adding from Ul, web service, and file upload.

Master Account Phase
Il changes

Following are the Master Account related Phase Il enhancements:

e Due Day Change Transaction Validation
e Master Account Maintenance Transaction changes
e MASTER CUSTOMER STATEMENT update

Note: Read the full requirement to understand the functionality changes.

Master Account Rolled
Up Summary

e Provided the ability to display rolled-up balances at the
Master Account level, which includes Master Account and its
Associated Accounts.

e These Rolled-Up balances are displayed in ‘View-Only’
fields. Ability to send rolled-up balances as a part of the Get
Account details for the Master Account.

e New ‘Master Account rolled-up Balance Details’ web service.

GL Enhancements

Configurable support to Header/Detail segments at the GL setup.

User Defined
Parameters

This feature enables customers to store business specific data, perform
calculation on the fields and display the result in Ul.
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Enhancement Description

Account Contract New non-monetary transaction is introduced to update Account Contract
Maintenance Non- Information like Amount Financed, Disbursed Loan Amount, Total Down
Monetary transaction Payment Amount, Total Sales Price, and Application Channel. This
Transaction does not have financial Impact.

Vacation Ownership Changes

Asset Billing This enhancement covers the following Vacation Ownership functionalities of
Enhancements Master Account and Associated Accounts:

e Collateral Changes [Origination, Servicing/Collections,
Collateral Management]

e Asset Billing Rate Setup

e Asset Billing Rate Setup Upload file (Create and Update)
e Billing batch job related changes

e Linked Account Changes

e Add Balance Non-Monetary transaction to Account

e Consolidation of Points

e  Pro-ration of TXN amount

Associated Accounts This enhancement provides ability to view all Associated Accounts of a
View Master Account from Associated and Master Account in Customer Service.

Tier Calculation In points based Vacation Ownership Industry, Tiers used to classify
memberships into different levels based on total points at Master Accounts.
Each level of membership offers more perks than the level before it like
different billing rates or servicing care levels and so on. This feature
enhances OFSLL to support Tier Calculation at Master Account.

Trade of Accounts This feature enables user to trade the existing account with a new account
within a same company.

Revenue Recognition This feature enables user to configure Current and Target Revenue
Recognition. Once target is meet on an Account then system marks the
Account as qualified.

Metro Il Enhancements

Metro-II File OFSLL is enhanced to support Metro Il Account Status 89 reporting for
Generation for Home ‘Home’ collateral.
collateral

Sensitive Bug Fix

SCRA Bug Fix The Contract Rate is not defaulted from previous account and user is
expected to enter the rate during Funding process.

Technical Enhancements
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Enhancement Description

Financial Services Financial Services Clean up — The ‘Fax in’ feature is deprecated and the
Clean-up corresponding C libraries are removed.

e Solaris Libraries clean up
e ZIP Data type discrepancy

Web Services Enhancements

Handled limitation of

i Web service framework has been enhanced to support multi region based
WS Region Code

Dependency deployment.
New Web Service Following is the list of New Web services provided:
e Asset tracking attribute Update Service
e Credit Bureau Update Service
e Master Account Rolled-up Balance Details
e Update account tracking attribute Service
e Business tracking attribute Update Service
e Customer tracking attribute Update Service
e Create Securitization Service
e Delete Account Service
e Calculate Parameter Update Service
Enhanced Web Following is the list of updated Web services:
Services

e Validate Token Service

e Asset Create Service

e Asset Update Service

e Asset Fetch Service

e Producer Service

e Producer Update Service

e Calculator Service

e Account Onboarding Service

e Account Details

e Account Tracking Attribute Fetch Service

Reports Enhancements

List of New Reports Five new reports are introduced and existing GL Posting Log report is
modified based on release enhancements:

e Funding Accounts Log Details Report

e GL Posting Log Report

e Payment Allocation Detailed Log Report
e Master Account Payment Log Report

e Account Asset Details Report

e Traded Contracts Report

2-4
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2.1 Payment Refund from Maintenance screen

2.1.1 Overview

This is Usability/operational enhancement giving a flexibility to ‘Refund Payments’ at one click, which
appropriates payment to different accounts using ‘Multi-Account’ facility in Payment Entry Screen / service.

2.1.2 Description

A new ‘Refund’ button is added in Servicing - Payment - Maintenance screen

2-5

System triggers ‘Payment Refund’ transaction and refunds the FULL payment, which are
‘GOOD PAYMENTS' on every account associated to payment for ACTIVE and
CHARGED-OFF accounts. (If the payment results in ‘Excess Payment’ on any account,
system reverses the excess payment balance.

Generates AP transaction with equivalent amount, corresponding to each account for
payment refund with reference to system parameter - UIX_REFUND_PAYMENT_MODE
(REFUND PAYMENT AS (CHECK/ACH)).

Refund Amount is driven by system parameter -
TPE_PMT_REFUND_CURRENCY_SRC_CD with options Payment currency or Account
Currency to choose.

If the ‘Payment Refund’ transaction is marked for Authorization = Y, system allows to
post for single account payment; but shows error message for multiple account payment
as - ‘Transaction marked for authorization’ and hence cannot be processed.

Multiple & Master Accounts Scenarios:

If multiple payments are associated to payment, system generates requisition with
Account Currency.

If the payment posted using ‘customer id’ or common customer exists in all accounts
involved in current payment, then system creates only one requisition of entire payment
amount using the customer details.

System checks if Master Account# used during payment posting and then system creates
only one requisition of entire payment amount using the master account details.

In all above scenarios, combined AP requisition will generate, but individual payment
refund txn will posted on all involved accounts.

This transaction will not execute on any account, in case of exception aroused during
posting of transaction on any associated account. (Execute either on all accounts or
none).

Refund Transaction

4 Do you want to rofund this payment?

Yes | Mo
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2.1.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.2 User defined fields

2.2.1 Overview

Added the following Configurable features in OFSLL for Account, Collateral and Credit Bureau:

Ability to configure to hide / unhide user defined fields in a screen.
Ability to Change the Label based on language and Division.

Ability to change the tool tip.

Ability to control access of hon-mandatory fields based on responsibility.

2.2.2 Description

Provided User Defined Extensible fields at each Entity in all layers Ul, Services, backend.
Support the following Entity level UDE fields in the respective screen:

> 50 (10 Text, 30 Number and 10 Date)

Corresponding web services updated to include the UDF's.

These UDFs added to corresponding Conversion, O Table, OO Table and X Tables.

‘Update’ button in label configuration screen is enabled only if the system parameter
(UIX_CUSTOM_LABEL_ENABLED_IND) value is setto Y

Changes handled in following screens / services:

Field Count Screen Name Web Services Comment

50 UDF Fields (GET)

10 Text, Producer Comment Fetch
Producer Screens Service (GET)

30 Number Producer Compensation

10 Date Fetch Service (GET)

Producer Service (POST)
Producer Update Service
(PUT)

Producer Comments
Create Service (POST)
Producer Contacts Create
Service (POST)

Producer Fetch Service

Producer Contacts Fetch
Service (GET)

Producer Holdbacks
Fetch Service (GET)
Producer Statements
Fetch Service (GET)
Subvention Detail Service
(GET)
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Field Count Screen Name Web Services Comment
Customer Service=> Customer
Service = Checklists > Checklist
50 UDF Fields | Types
10 Text, Customer Service - Customer .
Service = Checklists > Action - No.SerV|ces and hence
30 Number Regular no impact handled
10 Date Customer Service-> Customer
Service~> Checklists> Action -
Document
Customer Service - Customer
Service > Correspondence—>
Correspondences
Customer Service->Customer
Service->Correspondence )
>Documents No Services and hence
] no impact handled
Customer Service > Customer
Service >Correspondence >
Document Elements
Customer Service = Customer
Service > Letters
; Collateral Asset > Get ,
50 UDF Fields Customer Service 2 Collateral Put, Post
Customer Service - Account ]
10 Text, Details Account Onboarding >
Post
30 Number Conversion = Collateral ) .
10 Date . ) Account Details Service
Conversion = Account Details > Get
50 UDF Fields
10 Text, Origination - Credit Bureau
(Report Header Details and all 10 NA
30 Number sub tabs)
10 Date
2.2.3 Seed Data
Refer ‘Appendix: Seed Data’ chapter.
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2.3 Reschedule Billing Cycle

2.3.1 Overview

New Re-Schedule transaction introduced to change the billing cycle during servicing.

e Applicable for Open Ended and Close Ended Loans (Vehicle, Home Loan, Unsecured) /
Lease / Line and for methods like — IBL and Amortized.

e Reschedule of billing cycle is not applicable for Pre compute Loans

e Reschedule of billing cycle is not applicable for Lease — Rent Factor Method (OFSLL
currently supports only Monthly cycle for Rent Factor Lease) and Agreement Type —
Usage / Rental.

2.3.2 Description

Monetary Transaction for ‘Billing Cycle change’

Following new monetary transaction introduced with parameters:

Txn Code | Descri | Gro | Act | Mon | System | En | Txn/ | Stmt | Batc | Ma | Stmt | G
ption up ion | etary | Defined | abl | Bal Txn h nu | Print | L
e Type | Type al
RESCHE RESC RES | PO | Y Y Y NON | NON | N Y N N
DULE_BIL | HEDUL | CH ST E E
L CYCLE | EBILL | ED
CYCLE | ULE
Transaction Parameters:
Para Description Man Data Type/ Default | Field Validation | Applica | Master /
meter dator | Size Values and Comments bility Linked /
Code y Y/IN Individual
Txn Transaction Y Date Field System Loan, ALL
Date Date Date Line,
Lease
Proce | Indicates Y LOV - N If Yes = Loan, Master
SS whether to YES NO _C Reschedule Line,
Associ | process D billing cycle Lease
ated associated transaction will
Accou | accounts be posted on
nts attached to master and
master associated
account accounts.
If No = shows the
error message
encountered for
first account and
rollbacks all the
changes.
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Para Description Man | Data Type/ | Default | Field Validation | Applica | Master /
meter dator | Size Values | and Comments bility Linked /
Code y Y/N Individual
New Input New Y LOV - Monthly Loan, Both
Billing | Billing Cycle LOAN_BILL Line,
Cycle _CYCLE_C Lease
D
Same | SelectY/N Y LOV — NO Select Y to post Loan Master
Produ YES NO _C transactions on
ct D accounts belongs
Type to same product
Only type or if the flag
value = N, post to
ALL accounts.
Pre-Bill | Input New Pre- | N Text Box - 0 If this field is O, Loan, Both
Days Bill Days Numeric system retains the Line,
Pre-days existing Lease
on account.
Due Input New Due | N Text Box - 0 If this field is 0, Loan, Both
Day Day Min Numeric system retains the Line,
Min existing value on Lease
account
information.
Due Input New Due | N Text Box - 0 If this field is 0, Loan, Both
Day Day Max Numeric system retains the Line,
Max existing value on Lease
account
information.
Max Input New Max | N Text Box - 0 If this field is O, Loan, Both
Due Due Day Numeric system retains the Line,
Day Change Days existing value on Lease
Chang account. System
e Days has to do
compatibility check
for selected billing
cycle.
Due Input New Due | Y Date 0 This is set to ‘Next Loan, Both
Date Date Due Date’ and not Lease
be less than ‘Last
Due Date’ (Current
Due Date).
See Notes Below**
Payme | Input New N Text Box - 0 If value = 0, system | Loan, Parameter
nt Payment Numeric auto-computes new | Lease applicable
Amoun | Amount payment amount or for
t if greater than O, ‘Individual’
system considers Alc.
the payment
amount given in
parameter.
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Para Description Man | Data Type/ | Default | Field Validation | Applica | Master /
meter dator | Size Values | and Comments bility Linked /
Code y Y/N Individual
Term Input New N Text Box - 0 Refer validation Loan, Zz;g{l;stt?tr
Term Numeric below. Lease should not
be greater
than 0.

Residu | Input New N Text Box - 0 Mandatory if Lease Both
al Residual Value Numeric Maturity date is
Value changed for Lease

account
Late Input new late N Text Box - 0 If this field is O, Loan, Both
Charge | charge grace Numeric system retains the Line,
Grace | days existing value on Lease
Days account.
Lease Input new early | N Text Box - 0 If this field is O, Lease Both
Early termination Numeric system retains the
Termin | term existing value on
ation account.
Term
Comm | Input billing N Text Box NULL Loan, Both
ent change reason Line,

Lease
*Notes:

e System accepts ‘Next Due date’ after Current Due Date.

e Next Billing Date must be after current due date i.e., Next Due Date — Pre Bill Days.
e Backdating is allowed until last due date.

e Paid Term is auto-computed considering the back dated payments (if any).

Action on posting of transaction:

System updates the ‘Billing Cycle’ on account or master account based on flag in transaction.

Parameter Name | Condition Impact Comment
Due Date Input Date DUE DATE | Txn Date = Txn Date
CHANGE

Due Day = Derived Due Day from Due Date.
Due Date = Due Date

ACH Due Date Change = ACH Due Date change
Notes:

Current validations of Due Day Change - checked after
updating the new bill cycle.
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Parameter Name | Condition Impact Comment
Change Payment Where Termis | CHANGE Txn Date = Txn Date
Amount Greater than PAYMENT Pmt Amt = Pmt Amt
ZERO or both | AMOUNT mtAmt=rmtAm
term or Pmt Auto Compute Indicator = N (if Payment is greater
payment than ZERO else passes Y
greater than
zero Term =0
Balloon Payment Amount = Balloon Amount
Change Term Where CHANGE Txn Date = Txn Date
Payment TERM _
amount is Pmt Amt = Pmt Amt
greater than Balloon Payment Amount = 0
ZERO

Notes:

In case of amortized loans, system generates the new schedule considering the old and
new billing cycle.

System directly update the ‘Account Information’ like ‘Early Termination Term’ for Lease
without posting any non-monetary transaction (Direct Table update).

Reversal of ‘Reschedule Bill Cycle’ is allowed with following restrictions:

> System changes ‘Account back dated date’ as date of posting of transaction and
hence no monetary transaction allowed to post on or before that date. This implies,
system does not allow the user to reverse the ‘Reschedule billing transaction’ on
same date.

> System does not allow to reverse the transaction, if any monetary transaction is
posted (except payoff quote), after posting reschedule billing transaction.

- User expected to reverse the monetary transaction manually, to reverse the
reschedule billing transaction.

Backdating of the monetary transaction is allowed up to last due date only, otherwise
shows error message ‘Backdating allowed till last due date only’.

System sets the value of ‘Account Back Dated’ date as date of transaction posting date.
Billing cycle change transaction is not allowed to post in following cases:

> During ‘Promotion’ Period (Assumption — Promotion end period is considered to end
promotion and hence billing cycle change may not affect with this transaction).

> If subvention is defined for account.
> If ‘Repayment Type' in contract is NOT UNDEFINED.

‘Billing Cycle Change’ Transaction Validations:

Field Validation Error Message
Txn Date Throw error, if the date is future date Transaction Date cannot be in future.
Process If no accounts are linked to master No Accounts attached to Master Account.
associated account and flag value = Y; show error
Accounts message.

ORACLE
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Field

Validation

Error Message

than due day max.

New Billing If the existing billing cycle is same as Transaction cannot be posted, as New
Cycle new billing cycle or new billing cycle is | Billing cycle is same as existing billing cycle.
Daily or Hourly. Shows error message ‘Billing cycle is not
If billing cycle code is not enabled in enabled'.
lookup
Pre-Bill Days | If pre-bill days provided are not Standard system contract validations.
supportive of new billing cycle.
Due Day Min | Due day Min cannot be zero or greater | Due day minimum cannot be greater than

due day maximum.

Standard system contract validations.

Due Day max

While posting the transaction, system
validates the following:
New billing cycle — Weekly:

If existing value in contract is greater
than 7 or user inputs greater than 7 in
txn parameter, show error message 1.

Standard setup contract validations for
other cycles.

Due Day Max - For weekly billing cycle
maximum due day cannot be greater than 7

Standard setup contract validations.

Max Due Day
Change Days

New billing cycle — Weekly:

If existing value in contract is greater
than 6 or user inputs greater than 6 in
txn parameter, show error message 1.

Standard setup contract validations for
other cycles.

This parameter drives the following: Specify
the maximum number of days allowed to
move the due date.

Max Due Day Change Day - For weekly
billing cycle, max due change days cannot
be greater than 6. (For monthly this is
restricted to 28)

Standard setup contract validations for
other cycles.

Due Date System derives due day based on due | Standard Error message of Due Day to
date provided in parameter. Here, validate with selected new billing cycle.
System validates the ‘Due Day’ Existing Behaviour:
compatibility for selected billing cycle. 9 ’
Ciampl: Due Day for Accountis 15| SYSET] Corsders e Bue Dai (and
and billing cycle is Weekly, system 9 ys, :
shows error message. If ‘Due Day’ is given (without due date),
Note: The validation of ‘Due Day’ is r31)($(ttetgri1“conS|ders this day for generating
done after considering the Min, Max '
and Max Due Day change days values
provided as input in transaction
parameter.
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Field

Validation

Error Message

Payment If field value is ZERO, system posts Existing ‘'CHANGE PAYMENT AMOUNT’
Amount ‘CHANGE PAYMENT AMOUNT’ validations would be triggered
transaction with ‘Auto Compute’ =Y . .
Line Error Message:
If field value is Greater than ZERO, Term or Payment amount should not be
system posts ‘CHANGE PAYMENT reater thar?O
AMOUNT transaction with ‘Auto 9
Compute’ = N (Parameter values
explained above).
Line Validation:
For Line: This field is always be zero
Term Not applicable for Master account and | Refer Table 1**
Line Account. . )
Line Error Message:
Term or Payment amount should not be
greater than 0
Residual If user tries to give more ‘Residual Residual percentage is greater than
Value Value’ than available on asset; shows maximum allowed.
error
Residual If user tries to give ‘Residual Value’ No change in Term. Hence residual
Value change without change in term, shows | percentage change not allowed.

error.
For Loan and Line Accounts:

Input value ignored in this parameter.

Late Charge

If this field is 0, system retains the

Standard setup = Contract error messages

Grace Days existing value on account. shown based on new billing cycle.
Lease Early If this field is 0, system retains the If the Early Termination Term is greater than
Termination existing value on account. new term, show error message.
Term
** Table 1:
Pmt Term | Action Comment
Amount
>0 >0 Similar to — Change Payment Billing Cycle is as follows:
N Payment Amount = User Input
Pass Auto Compute =N Term = User Input.
Maturity Change = Yes Maturity Date = Due Date Next + New Term + 1
0 0 Similar to — Due Date Change | Billing Cycle is as follows:
n Payment Amount = System Calculated
Lr:ggers - Change Payment Term = System Calculated
Pass Auto Compute = Y Term calcglatmq: .Matunty Date — Due Date Next
converted into billing cycle.
2-14 ORACLE

Financial Services



Pmt Term | Action Comment
Amount
Maturity Change =Yes
System will not post this If Linked Account =Y
transaction on any account
(including linked accounts)
unless this transaction qualifies
on all accounts.
0 >0 Similar to — Change Payment Billing Cycle is as follows:
N Term = User Input Value
Pass Auto Compute =¥ Payment Amount = System Calculates based on
Maturity Change = Yes Term.
Maturity Date = Due Date Next + New Term + 1
>0 0 Similar to — Due Date Change | Billing Cycle is as follows:
n Payment Amount = User Input Value
Similar to - Change Term Txn _ -
Term = System calculates remaining term based
Pass Auto Compute = NA on payment amt
Maturity Change = Yes Maturity Date = Due Date Next + New Term + 1

Assumptions:

1.

After posting of ‘Billing cycle change’ transaction, 5 Due Buckets on account refers to
different billing cycle.

Example: Billing cycle change transaction posted (Monthly to Weekly) after 2 cycles,
then first two dues represents monthly and subsequent dues represent weekly.

No impact / impact not handled for following :

e Insurance

e Accounting / GL Impact

e  Securitization Pool

e For Line / Stage Funded loans, no impact on ‘Advance Disbursements’

e For Producer Compensation payment or chargeback, system will consider the TERM with
absolute numbers and does not consider the change in billing.

e PDC and Escrow need manual adjustment.

e No impact on Metro II.

System does not allow making the contract parameter as ZERO (unless defined as ZERO
during contract definition).

If user inputs ‘Residual value’ while posting transaction on master account; system considers
this amount for all the associated lease accounts.

2.3.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.4 Configuration at company level

2.4.1 Overview

1. Configuration supported at company level (not branch level).

e OFSLL supports Multiple Portfolio Companies definition working under an Organization,
and if these Portfolio companies operate in different time zones, nightly batch jobs have
to run as per the operating hours of these portfolio companies.

e ltis the business team’s decision to configure the setup at organization level or at
company level.

> If the decision is to configure the setup at organization level, no specific change is
required.

> If the decision is to configure the setup at company level, ensure to follow the
recommended setup as below.

2. Configuration supported at company level (not branch level)

If user want to configure only one EOD schedule for one or all companies:

User can configure batch jobs at ALL level (with or without out having multiple company
definitions). This helps the existing customers (upgrading from lower version to current
version) to continue with their existing ALL company level scheduling of batch job run.

3. If user want to configure EOD for each company independently:

e Users can define GL date at each company level. This implies that user can schedule to
run batch jobs at each company level. Scheduler will change the GL date of specific
company, after the successful completion of batch job run.

e Useris advised to ‘Enabled’ flag at ALL GL date level; but disable batch jobs at ALL level;
so that scheduler does rollover the date but doesn’t pick up batch jobs for EOD run.

e After EOD run, system will rollover the GL date or ALL company entry, after completion of
run of other specific company GL date rollover.

e ‘System under maintenance’ also set Y for corresponding company during EOD run of
same company.

e Company Start of Business Time configured at company level. If the parameter value is
set to ‘0500, it implies that scheduler rollover the GL date based on this time.
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> System refers the ‘Company Time Zone’ (new field at company definition page) to
identify the time zone in company parameter.

l Organization ‘

| |
I Company 1 l Company 2 Company “n”
B . b B, .

Batch Jobs

Batch Jobs Batch Jobs

Holiday Setup Holiday Setup
Schedule EOD Schedule EOD

Holiday Setup
Schedule EOD

1. Day 0: Setup Definition of Company

Define Company and date format
o Define company at ‘Companies Definition’ page and ensure to maintain ‘Company Time
Zone’.
e Define company code with ‘Alphanumeric’ characters only.

e Ensure to define the ‘Display Format’ organization Definition = Division Definition >
Display Formats.

¢ Note: Simple date format definition is one time setup for each company and Admin user
not expected to change again in lifetime. Currently system allows to select only
MM/DD/YYYY format.

System parameters

e System is shipped with Seed Data of company level GL date as All / All by default.
e User has to create and define following company level parameters:

> GL POST DATE - COMPANY IN MM/DD/YYYY FORMAT (UPDATED BY
SCHEDULER IF ENABLED)

> CMN_SYSTEM_UNDER_MAINTENANCE — SYSTEM UNDER MAINTENANCE

> JSC_START_OF BUSINESS_TIME (COMPANY START OF BUSINESS TIME
(24HR FORMAT)

> PTX_TXN_LAST_PURGE_DT - LAST PURGE DATE OF TXNS
> PUP_TUP_LAST_PURGE_DT - LAST PURGE DATE OF TXNS UPLOAD
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Ex: If three companies defined with three different time Zones - USA, UK and Australia.

|— Company A —| |— Company B
| ]

Branch 1 Branch2 Branch 3 Branch 1 Branch2 Branch 3

(APPLICATIONS/ACCOUNTS)

USA UK AUS
GL Post Date 31 Dec 2019 02 Jan 2020 02 Jan 2020
CMN_SYSTEM_UNDER_MAINTENANCE | Y N N
JSC_START_OF_BUSINESS_TIME 0500 050 0500
PTX_TXN_LAST PURGE_DT 01/01/2019 01/01/2019 01/01/2019
PUP_TUP_LAST PURGE_DT 01/01/2019 01/01/2019 01/01/2019

Holiday Setup
01 Jan 2020, recorded as holiday in OFSLL
Example:

»  Scheduler picks up the jobs for EOD run based on ‘Next Date and time’ set at each
batch job level.

>  After successful completion of job run for the individual company, system rollovers
the date for respective company.

> Once the EOD run and date rollover is completed for individual company, system
now verifies the ‘Enabled’ indicator for ‘All' company. If none of batch jobs enabled,;
system rollovers the ALL GL date.

> Being 01 Jan 2020, recorded as holiday, scheduler rollovers the next date to 02 Jan
2020.

Batch Jobs

> System is shipped with batch jobs with ‘All’ company by default.

> User has to define the company and copy the batch jobs. (All batch jobs are copied
at one go).

Day 0: Setup with Multiple Companies in Same Time Zone / Different Time Zone

With introduction of new field ‘Company Time Zone' at ‘companies’ definition page, user
can define the company level time zone.

This parameter considers the Company level, Start of Business Time and user can
configure the same time zone or different time zone for scheduler to process EOD / BOD.

Company wise file upload facility is supported as follows:
As part of creating company, following things are automated:
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> Directory objects creation in database

> System parameter creation for directories

> External table creation for selected uploads - collateral and txn upload automatically
> Physical directories need not be created

> Directory permissions is manual

e If customer is using Company specific file upload jobs- file upload process will happen
from company specific folders

Setup when New Company is added subsequently (not on Day zero)

e Follow the same steps to be followed on Day zero setup.
e Raise SR to execute script of directory creation of new company for file upload.

2.4.2 Description
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Defining configuration at company level

System shows the details at each configured company level

1. System Monitor = Batch Jobs
e Introduced new field ‘Company’ with in Batch Job Sets tab as shown in the picture.

e User can copy the list of job sets for each company defined on select company from LOV
and click of ‘Create Copy'.

e |If the batch job sets are already available for the selected company, system shows error
message stating ‘Batch Job Set already available for company'.

o Duplicate validation is in place as mentioned in common validations section.

e User can configure and run batch jobs for each company combination.

e Following tabs have new set of LOV showing Company with default value as ALL. On
selection of corresponding ‘Company’, system lists the batch jobs defined for that
combination.

>  System Monitor = Batch Jobs

>  System Monitor = Jobs - Batch

> System Monitor - Jobs - Background

>  System Monitor = Jobs - Credit Request
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New ‘Company’ field in Setup = Batch Jobs (Here COPY feature copies all batch jobs of
selected company, and not only the selected row).

Batch Jobs (=l

Batch Jobs  Job Holidays

Batch Job Sets Select a company from the kst fit | [5] View || < Audit
view » Format ~ [ Frocze ] Detach Wia i company ALl [~ ¥ Create Copy
&
Comparny Set Code Job Set Description ALS01 quency vahse Start Time Critical Enat
usol SET-AAT ACCOUNT CREATION P04 Ly 10:00 AM N N A
P04 SET-AAL ACCOUNT CREATION ons LY 10:00 AM N N
ALISO1 SET-AAL ACCOUNT CREATION LY 10:00 AM M N
ALL SET-AAI ACCOUNT CREATION w01 LY 10:00 AM N N
ALL SET-ACR ACCRUALS AND DELINGUENCY uso1 LY 22:30 PM Y Y
4 P04 SET-ACR ACCRUALS AND DELINQUENCY DATLY CAILY 22:30 PM ¥ ¥
uso1 SET-ACR ACCRUALS AND DELINQUENCY DAILY DAILY 22:30 PM Y Y
AUS0L SET-ACR ACCRUALS AND DELINQUENCY DAILY DAILY 22:30 PM ¥ Y
Uso1 SET-ADT UPDATE ALIDIT TABLE (AFTER TABLE EXPORT-IMPORT) SPECIFIC DAY SPECIFIC DAY 10:00 AM N N
ALL SET-ADT UPDATE AUDIT TABLE (AFTER TABLE EXPORT-IMPORT) SPECIFIC DAY SPECIFIC DAY 10:00 AM M N .

~
v

Batch Jobs 4 Add P Ea [ view || o Audit
View > Format = (5 Freeze [ Detach Wira 7]
Sy Job Type Job Code Job Description Threads Commit Count Errors Allowed
[ 1.0000 PROCEDURE AAIPRC_B)_100_01 APPLICATION TO ACCOUNT INTERFACE 1 100 100,
2.0000 PROCEDURE TXNACT_B1_100_01 ACCOUNT ACTIVATION 1 100 100
< »

2. Batch Jobs - Job Holidays

e Introduced new field called Company as shown in the picture.

e User able to define holidays for each company combination.

e Duplicate validation is in place as mentioned in common validations section.
e Default values are provided as ALL as Company for all records.

Baichi Jute  Julb Holidays

1oh Holidays spadd | FEdt | vew | of Ayt
View ~ Format = [ eere  fjoetach

Holday Dt Deswrivtion Company | Enabted
L 12/09/2015 PUBLIC HOLIDAY usat N

12/25/3003 CHRAISTMAS us01 -

3. System Monitor >JMS Queues > Messages

e Introduced new LOV — Company under ‘JMS Queues > Message Tab as shown in the
picture with default value as ALL.

e System displays JMS error message at company level.
e Company LOV shows only those values, where logged in user has access to view.

System Monitor [

Batch Jobs  Jobs  Services Database ServerLogFiles  Parked Transactions  Users  JMS Queues

Company AL [+] ViewLast @ 1Day @ 1Week(@ 1Month () By Date Start Dt £nd Dt )

Stats  Messages

Messages
View v Formatv [ Freeze EfiDetach ¢l Wrap et}
Service Description Submitted Completed Falled Resubmitted
ROUTEGNE MDB ROUTEGNE INTERFACE MOB 7 0 7 0
BIP MDB BIP INETRFACE MDB 47 47 0 0
EVENTS MDB EVENTS MDB 105 105 0 0
< 1 v

4. System Monitor - Jobs - Background

e Company Start of Business Time configured at company level. If the parameter value is
set to ‘0500, it implies that scheduler rollovers the GL date based on this time.
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> System refers the ‘Company Time Zone’ (new field at company definition page) to
identify the time zone in company parameter.

Company Definition
Hsaemdsty | [ Sove awdRetn | GaBetum

Conpany - C-0001 * Company Tina fone WET ~ Extn
* Name CEMD BANK LEA
* Shost Name USO1 Remittance Address
* Curr ; v
Commery LIS DONLAR: *Country UNITED STATES T *Fax 1 (123)H36-7890
® bl [7] i § = a2
Remittance Address Line 1 LINEL
* Coundr SITED STATES T .. 5
i Remitance Address Live 2 LINE Lgadglersst fon)
Addess Line 1 LINEL 553 = " 12345067590
Ackdress Line 2 LINE2 NW P * Contact SETME
*Ip 533H ' e MIBRENGLE * Cougon Order Code A
Eatn 7255 S * MDA OFFICE OF THE COMPTROULER OF |

State MINNESOTA
* Oty MINNEAPOLES
=phone I (123)-156-8888
* State MINNESOTA

5. Change at Setup = Standard Payees

e Introduced new fields called Company / Branch as shown in the picture.

e System shows only corresponding company / branch list of values in LOV, based on
‘Country’ selected.

e User able to define standard payee for each company / branch combination.
e Duplicate validation is in place as mentioned in common validations section.
e Default values provided as ALL as Company / Branch for all records.

e User can define payee bank account for each company.

e AP Requisition batch job is modified to consider the account number with consideration
to company.

e Funding process including account on boarding and conversion is able to consider the
account number based on company / branch combination to generate requisitions.

Standard Payees

Payes Definition
Maw = Rormat = 3 " i Detasn . ™
& 1001
Payes = T Pt Mot Ersticd County ity Store Address Lne 1 Address e 2 - Extn Phane 1

101 acn Ao ¥ UNITEDSTATES | LEXIGTon LGS LirE vz assay 12356788

Payes Definition

6. Change at Setup - Data Files = Input

e Introduced new fields called Company and ‘External table name’ fields as shown in the
picture.

e Introduced COPY facility to copy the Input file definition and corresponding column
definitions.
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> If user selects the row and target company for which records needs to be created and
clicks on ‘Create Copy’ system does copy of following records:
- ITU_TXN_UPLOAD
- ASSET_ASE_UPLOAD
- ASSET_ATA_UPLOAD
- ASSET_ATR_UPLOAD
- ASSET_AVL_UPLOAD

e Records for above files created with ‘External Table Name’ as ‘External Table Name_
Company code’.

Data Files £
Output Input
Input Data File Definitions deadd | P e [ View | o Audt
View = Format ~ [ ez [ Detach B company  B001 7] [9 Create Copy
4
- Record
Mare File Mo Description Directory Poth Dulimnter i External Table Nome Compary  Enabled
ASSET_ATA_UPLOAD IT_ATA_UPLOAD.CSV ASSET TRACKING ATTRIBUTES FILE UPLOAD 10T ’ VARIABLE ASSET_ATA_UPLOAD_EXT_USO1 usit ¥
ASSET_AVIL_UPEOAT TUT_AVL_UPLOAD.CSY  ASSET VALLIATRONS FILE LUPLOAD e » VARIARLE  ASSET_AVI_LF OAD_EXT LIS usm Y
TTU_THN_UPLORD TTU_TXN_UPLOAD.CSV TANS FILE LPLOAD s . VARIABLE TXNS_LWLOAD_EXT_UISDL usot ¥
5 ASSET_ASE_UPLOAD 1IT_ASE_UFL ASSET FILE UPLOAD toc ; VARIABLE ASSET_ASE_UFLOAD_EXT_USO1 usox ¥
ASSCT_ATR_UPLOAD IUT_ATR_UPLOAD, SV ASSET ADDONS FILE LIPLOAD 1o uson Y

Column Definitions deadd | FEm [ vew | o audt
View~ Formate S fieeze (] Detach Wrap 0]

Seq Colurn Name Colurnn Description Date Type  Formet Mask  Length Sort Enabled

2 ATA_RSE_ e CHARACTER  MOT APPLIC.. 30 2 ¥

3 ATA_ASE WG SYS XREF CHARACTER MOT APPLIC, 30 3 ¥
ATA_NTE_FTB_TABLE d ; HARMCTER  HOT APPLIC | ¥
ATA_FTA_TABLE_ATTRIBUTE TiA TTRIBUTE HARACTER  NOT ¥

1 ATA_OPERATION_IND OPERATION IND CHARMCTER MOT APPLIC. 30 1 ¥
ATA_VMNLUE VALLIE CHARACTER O APPL I &0 Y

Other Impact Areas:
e UserInfo > GL Date
> Remove ‘GL Date’ from User Info page.
e Company Parameter - GL Date
> Branch LOV shows ALL only to configure.
7. Scheduler:

e Scheduler picks up the company specific scheduled batch jobs and update the GL post-
date of specific company, on completing batch job run for that specific company.

8. Debug Logs

e Batch level Debug logs maintained at system parameter level. (Debug system
parameters not moved to company level). This means user can enable / disable ‘debug
batch job logging’ at system parameter level only.

e User can enable the batch job level debug jobs by system parameters (By enabling in
user defined table).

e System appends the Debug log file generated with ‘company name’.

e Date format in debug logs are MM/DD/YYYY — Standard Format only, irrespective of logs
generated for any company.

9. Setup Screens
e All setup screens refers to system date for validation. Example: Start and End Date.
10. File Uploads

e If customer is using only ALL company definition — file upload process will continue to use
the existing folder and infrastructure.

e As part of creating company, following things are automated:
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> Directory objects creation in database

> System parameter creation for directories

> External table creation for selected uploads - collateral and txn upload automatically
> Physical directories will not be created

> Directory permissions is manual

e If customer is using Company specific file upload jobs, file upload process will happen
from company specific folders.

> Input File: Changes done to the file structure. Place the input file under
input/directory/company specific folder.

- If certain file does not have company definition like ‘Asset Upload’, user can
place file in any company to process and upload records.

- Some of the input files are ‘not programmed’ to refer Data Files = Input file
definitions and hence any date in the file will follow MM/DD/YYYY format.

Example: Call activity posting promise date is required in the same format.

- Some input files ‘are programmed’ to refer Data Files = Input file definitions and
hence system expects the date in the file as defined as date format in definition.

Output File: Output file name appended with company name and generated in
one folder.

Note:

e A script provided to create directories and to create folders for each defined company
and user has to run script on day zero.

e CLOB indicator retained at system parameter level.
11. Transactions

e Monetary transaction refers the company specific GL date.
e Non-Monetary transactions refers to system date.

e Transactions data in the account will continue to show the dates with reference to ‘Fixed
simple date format’ maintained at company level.

12. Web Services

e GL date of service would refer company level GL date.

e User has to pass/send ‘Company’ for some specific services to take reference of
corresponding company GL date.

13. Letters, Correspondence

e Letters generated based on ‘Company level’ batch job run.

e Date format in letter is ‘not controlled’ by company level display format and continues to
refer the letter template.

14. Reports

e Changes taken at report template level and reports are generated with company name
appended to file and generated data for specific company, where the job is run.

e Date format in report is ‘not controlled’ by company level display format and continues to
refer the report template.

15. Credit Bureau & Metro Il

e Bureau pull does not have any impact to handle; reason being user has to select the
specific company and bureau will trigger the pull from UI.

e Metro Il — No impact. System generates file for all companies; but based on product level
flag and with configured setup.
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16.

17.

18.

19.

20.

21.

22.

23.

24,

25.

26.

GL

e Current GL Setup [Attributes, Translations and Transaction Links etc.] is at Company
level and hence there is no impact.

ODD1, ODD2, ODD3

e ODDL1 (Producer ACH, Adverse Action letters, Adverse Action Condition Letter file) job
generates the data at company level; if job ran at company level.

e ODD2 (Account ACH, Vendor ACH, Statement, Letter File and so on) job generates the
data at company level; if job ran at company level.

e ODD3 job generates the data at company level; if job ran at company level.
Migration

e For all screens, where company has been added, default value ALL is provided. (User
expected to enable this in seed data screen).

Conversion

e API tables already have definition of company and hence no specific impact.
e User can upload the conversion files based on company.

Archive

e Parameter to specify the archive days are available at system level.

e However, user can run the Archive batch jobs at each company level; which purges data
for that specific company.

Purge
e Parameter to specify the purge days and following parameters moved to company level.

> PTX_TXN_LAST_PURGE_DT - LAST PURGE DATE OF TXNS
> PUP_TUP_LAST_PURGE_DT - LAST PURGE DATE OF TXNS UPLOAD

Standard Payees

e User would be able to define payee bank account for each company / branch
combination.

e AP Requisition batch job generates the requisition considering the account number
defined at company level.

Data Masking

e Not handled this module and hence data masking can be configured at organization level
only.

WFP Module
e Not handled any impact in current release.

List of batch jobs handled to run at company level

List of Batch jobs at
company level.xIsx

List of File uploads, handled to run at company level

File Upload.xIsx
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Assumptions

e System considers the criteria defined for company and ignores the branch level

differentiation across application.

e Hence, even if user defines multiple records as follows, system still consider the
combination as same and executes records are company level.

Company = AUS and Branch = ALL
Company = AUS and Branch = Sydney

Origination ~ Criteria Based Condition  Customer Service  Call Action Results  Activity Tracking  User Groups
Criteria Definition prdd | ZEi [ View | o Audi
views Fomaty [ [[Freere ffipemh  @dwap @) o Checkormea
& A ) £}
Name Description Start Lt End Lt Saq|Company Branch Enabled
TEST_MAC_CONDITION CONDITION BASED ON COMPANY 01/01/2019 ifo1/2020 0fAUEDL ALL hd
Criteria Details ~ Corndilions
Criteria padd | Fedt | [ view o Audi
Vieww Formatv [ Freaze [} Detach wap | @
. Comparison . . Logical
Sy Paranmd e s Crileria Vahu: ) i Friabilesd
0 ACCOUNT MASTTR ACCOUNT TNDICATOR FQuA hif Y
3 H . 1
Refer ‘Appendix: Seed Data’ chapter.
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2.5 Close Account after Paid-off

2.5.1 Overview

e Some business models demand not to close the account, even if the account is Paid Off.
e To address this business requirement, new flag introduced at product level.

2.5.2 Description

New flag at product level

e New Flag ‘Close Account after Paid-off’ introduced at Setup = Product definition level for

loan/ line and lease

> If the flag value =Y, system closes the account after no. of days specified in the
system parameter.

> If the flag value = N, system ignores the system parameter and does not close the
account.

> TXNCLS_BJ_100_01 - VOID/PAID ACCOUNT CLOSE PROCESSING refers to this
flag and does not close Paid off accounts.

> In addition, the new flag is information shown at Servicing = Account Details >
Others (View only field).

> While converting the accounts from the legacy system, system accepts the flag value
as per the product set up and on-board the accounts

Loan Product
Save and Stay Save and Return || {aReturn
Product AUS LOAN VEHICLE (FR) * Customer Credit Limit [] *Biling Cycle | MONTHLY v
* Description BGM LOAN VEHICLE {FR) * 5ame Biling Cycle [] * Category | STANDARD ”
* [ * Enabled
StartDt | 10/23/2019 [:“G .l . M Index Rounding  NO ROUNDING TO INDEX RATE ~
*endDt 12314000 | B Collateral Type | VEHICLE COLLATERAL v
" 251 © Reschedule Method | UNDEFINED .
* Direct [] * Collateral Sub Type  PERSOMAL PROPERTY VEHICLE ~ el .
R Vi 0.0000
* Flexible Repayment * Credit Bureau Portfolio | jysTALLMENT = SseneduE vels
* Close Account After Type
Paid-Off * Credit Bureau Account Type | AUTO ~

2.5.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.6

Collateral Maintenance

2.6.1

Overview

Existing Non-monetary transaction ‘Collateral Maintenance’ enhanced to support additional
details and validations.

2.6.2 Description

Non- Monetary Transaction — Collateral Maintenance

Enhanced non-monetary transaction 'Asset Maintenance' with below parameters.

TXn Descript | Group Acti | Mon | Syst | En | Txn/ Stmt | Bat | Man | Stm | GL
Code |ion on etary | em abl | Bal Txn ch |ual |t
Defin | e Type | Type Prin
ed t
ASSE | ASSET ACCOU | PO | N Y Y NONE | NON | N Y N N
T MAINTE | NT NON | ST E
MAIN NANCE MONET
TENA ARY
NCE
Transaction Parameters:
Parameter | Description Mandat | Data Field Validation | Default | Comments
Code ory YIN | Typel Size Values
Txn Date | Transaction Y Date Field | Does not allow System
Date any back dated Date
or future dated
transaction.
Asset # Asset Number | Y Number Asset # should NA
exist
Asset Asset Class N Char Asset Class is NA Refers
Class validated from HOME_ASSET CL
look up per ASS CD
Collateral type -
of Asset # VEHICLE_ASSET _
inputted CLASS CD
OTHER_ASSET_CL
ASS_CD
Asset Asset Type N Char Validated from NA Setup->Asset Types
Type Asset Type per Collateral Type
Setup
Asset Sub | Asset Sub N Char Validated from NA Setup->Asset Types
Type Type Asset Type per Collateral Type
Setup
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Parameter | Description Mandat | Data Field Validation | Default | Comments
Code ory Y/N | Type/ Size Values
Registrati | Registration# | N Char Allowed only for | NA
on# VEHCILE/OTHE
R collateral type
Make Make N Char NA
Model Model N Char NA
Estimated | Estimated Life | N Number NA
Life
Country Country N LOV NA Refer
COUNTRY_CD
Zip Zip N Char Validated from NA Refers
Zip matrix based .
on Country code git(;f: User->Zip
inputted
State State N LOV NA Refers
Setup-> User->Zip
Codes
STATE_CD
Address # | Address # N Char NA
Address Address Line N Char NA
Line 1 1
Address Address Line N Char NA
Line 2 2
Reason Reason N LOV NA Reason Code for
Code posting the
transaction
Comment | Input N Char Null
Comment
Validations:

On Save, system does the following validations and throw error messages:

Field Name Validation Error Message
Asset # Check if the asset number exist in system Asset #: <Asset nbr> does not exist for
or else show error message. this account.
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Field Name Validation Error Message

Asset Class Check if the Asset Class inputted is as per | Shows Error message as ‘Asset Class :
HOME_ASSET_CLASS_CD for HOME <Asset class> does not exist for Asset #
collateral : <Asset nbr> Collateral Type’
VEHICLE_ASSET_CLASS_CD for Example:

VEHICLE collateral Asset # 10001 is of Collateral type

OTHER_ASSET_CLASS_CD for =HOME then Asset Class should be
HOUSEHOLD GOODS AND OTHER from lookup
COLLATERALS HOME_ASSET_CLASS_CD.

Asset Type Check if the Asset Type provided is from Shows Error message as ‘Asset Type :
Setup->Asset Types per Collateral Type of | <Asset Type> provided does not exist
inputted Asset # for Asset # : <Asset nbr> Collateral

Type’

Asset Sub Check if the Asset Sub Type provided is Shows Error message as ‘Asset Sub

Type from Setup->Asset Types->Asset Sub Type : <Asset subtype> provided does
Type per Collateral Type of inputted Asset | not exist for Asset # : <Asset nbr>
# Collateral Type’

Registration # Check if Registration # is provided for Shows Warning message as
Asset # having Collateral Type =HOME ‘Registration # : <Registration nbr> not

required for Asset # : <Asset nbr> since
Collateral Type=HOME’

Zip Check if Zip code provided is validated Shows Error message as ‘Zip Code :
based on Country code provided and <Zip code> provided is invalid for
Setup-> Zip Codes or else display error country: <Country>’
message

On successful posting of transaction, following actions done on account:

e Shows transaction-posting message ‘Transaction Posted Successfully’.

e System updates Collateral Details and same reflected in CUSTOMER SERVICE->
COLLATERALS tab-> HOME/VEHICLE/OTHERS and

e SERVICING->COLLATERAL MANAGEMENT->COLLATERAL DETAILS

Access Details:

Provided Access Details as follows:

Transaction User Action Definition dpadd | ZEdt | [E]view | o Audit
View v Formatv Freeze  {fiDetach ap W
Access Type Access Value Allowed? YesNo System Defined Yes/No
ACCOUNT CONDITICN AL Yes MNo Yes(@ No
ACCOUNT STATUS AL
Transaction Product Definition dpadd | AEdt | S vew | o Audt
View v Format v [} Freeze  ffDetach Wrap 5]
Product Type Funding Type Alowed? Yes/No
ALL ALL Yes No
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[
Dats  Soreen

Baports | Cormespandes

wdence  Tramsaction

Transaction Super Group

View = Format =

o
s [ Detach
&F ACTOUNT MR MONETARY

Super Groun

[ ACEOUT FeCs MONETARY TN
Transaction Codes At || ] wew || o dds

view = Format = | frecem [ Detseh
&

Code Descripton Authrorize Onatiec

[ ¥ -

2.6.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.7 Tracking Attributes - Bulk Update

2.7.1 Overview

e Generic file upload to update tracking attributes.

e User can upload Tracking attributes for Customer, Business and Account through generic
file upload.

e User can update the tracking attributes of Customer, Business, Account and Asset
through web services.

2.7.2 Description
o Bulk upload of the Account Tracking attributes is applicable for Loan, Line and Lease

e Capability to upload Tracking attributes for Customer, Business and Account through
generic file upload. (For Asset tracking attributes, there is already separate service is
available and hence same can be used).

e Capability to update the tracking attributes of Customer, Business, Account and Asset
through web services PUT service.
File Upload:

e New batch job - ITRPRC_BJ_100_01 (TRACKING ATTRIBUTES UPLOAD) has built
under SET-IFP.

01-File Definitions xls

 New batch job file upload built to enhance OFSLL ability to upload Tracking attributes.

Web services:

e Anew set of PUT Web services is created to update the Account, Customer, Business
and Asset Tracking Attributes

> Specifications of PUT service to update the Tracking Attributes

01-Account Tracking 02-Customer 03-Business Tracking 04-Asset Tracking
Attributes WS SpecificTracking Attributes W Attributes WS SpecificAttributes WS Specific

> Sample request

i A A= A

01-Account Tracking 02-Customer  03-Business Tracking 04-Asset Tracking
Attributes WS json Tracking Attributes W Attributes WS json  Attributes WS json

Validations for WS and File Upload

e If Tracking Attributes are not loaded, bulk update first Loads the Tracking Attributes and
then updates.

e  Error Handling:
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https://docs.oracle.com/cd/F22291_01/pdf/refdocs/ofsll_release_notes_attachments/Account_Tracking_Attributes.json�
https://docs.oracle.com/cd/F22291_01/pdf/refdocs/ofsll_release_notes_attachments/Customer_Tracking_Attributes.json�
https://docs.oracle.com/cd/F22291_01/pdf/refdocs/ofsll_release_notes_attachments/Business_Tracking_Attributes.json�
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> Attribute is disabled:
- Example: <<ACT_LOAN_002: NOT ENABLED>>
» Data Type Mismatch
-  Example: <<ACT_LOAN_002: DATA TYPE MISMATCH>>
> Size Mismatch
- Example: <<ACT_LOAN_002: Size Mismatch>>
> Lookup Mismatch
- If Lookup does not match, system gives error message.

2.7.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.8 SCRA for Existing Customers (Bug Fix)

2.8.1 Overview

e SCRA rate population for existing customers has bug and fixed in 14.4 release onwards.
The fix is available in current release.

2.8.2 Description

Existing Behaviour:

e Contract Rate for the New Account of the Existing Account defaulted from previous
account of the Customer.

e Marks Account Level SCRA Flag as YES
e Posts “Borrower on Military Duty” Condition on the Account

New Behaviour:

Irrespective of the channel of receipt of application (On-boarding Web service, Conversion
process, Application Entry Web service, Application Contract Creation Web service) in to OFSLL,
system behaves as follows:

e Contract Rate not defaulted from previous account and to be entered as part of the
Funding process

e Contract rate is from the Account Contract
e Does not Mark Account Level SCRA Flag as YES
e Does not post “Borrower on Military Duty” Condition on the Account

2.8.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.9

29.1

29.2

2-34

Enhancements for Business only Account

Overview

Previously, OFSLL enforces to add Primary Applicant along with the Business/SME detail as part
of the Account Onboarding web-service. After this release, the user can create the Business only
account i.e., user can create the account without any individual customer and service using the
business details.

There are different places where the system is referring to the customer details instead of
business details. Now, during the servicing, the system will refer the business details for Business
Only Account.

Note: Creating the business only account from origination is not supported in this release.

Description

Servicing > Vendors > Work Orders

While creating the work order, if the user selects the Business Only Account, then the system
populates the service address with enabled Business’s current and mailing address.

Customer Service > Business Preference
e Added ‘Business’ to the Relation Type for Small Business and Business accounts.

» If an account is business only, then the system does not show customer relations.

» Ifan account is SBL, then the system shows all enabled customer relations and
business.

» If an account is individual, then the system shows all enabled customer relations.
e On selection of relation as ‘Business’ and if communication Mode is

> Email Address — system populates Email Id of enabled business record

> Telecom — system shows the ‘Type’ LOV with Business Address and Telecom
Details

> Ad-hoc Telecom — system enables all fields for editing and Type LOV will refer the
telecom type LOV

Note: At any point in time, there will be only one enabled preference of the same
communication mode will be there.

- i.e., Only one Email address will be ‘Y’ and/or
- Only one Telecom/Ad-hoc Telecom will be *Y’.

> If a user accessing the business-only account, this tab is displayed as ‘Business
Preference’

> If the account is Small Business, then system shows the customer relation types with
all enabled/non-deceased customers and one Business.

Customer Service > Bankruptcy

e |If the account is business only or small business, system populates the Business Name
to the ‘Customer’ LOV

e On selection of Business Name, system populates the Relation as ‘Business’
e Renamed the Customer label to ‘Customer/Business’ irrespective of account class type

e If the user saves new record with an enabled indicator as ‘Y’ for the same relation,
system disables the previous current record to ‘N’ [existing behavior]
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Servicing > Batch Transactions > Advance > Advance Entry > Advance Allocations

e Added ‘Business’ to the ‘Type’ LOV. If user select the ‘Business’, system populates the
business number linked to that account selected in the ‘Advances’ block [applicable to
SBL and BUS account class type]

e On selection of the record, system shows the Payee Number with ‘Business’ number and
name with ‘Business Name’

e Added business details to the search parameter in the ‘Advances > Search’

Customer Servicing > Summary > Business Only Account

If the selected account is business only, system hides the ‘Customer Information’ and
‘Employment Information’ blocks; instead, it shows the ‘Business Information’ along with the
Business address and business telecom details.

Customer Servicing > Collections > For Business Only Account

If the selected account is business only, system hides the ‘Customer Information’, ‘Employment
Information’ and ‘Customer Preferences’ blocks; instead, it shows the ‘Business Information’
along with the Business address and business telecom details.

Setup > Data Files > Output > Data File Definitions changes

e ODD statement files refer the business details for business only account and if the
account is business only, system sends blank data in customer details (first name, last
name, middle name, generation code, language code and SSN)

e Customer Statement changes: [SET-ODD2 > OSTPRC_BJ_100 _01]

> If the account class is BUS, the following fields refer to the Business and its Address
details which has ‘Current’ indicator
- HOUSE #, ADDRESS LINE, CITY, STATE, ZIP CODE, ZIP EXTN

» For SBL and BUS class, added the following new ‘Column Definitions’ under Setup >
Data Files > CUSTOMER_STATEMENT > CUSTOMER RECORD

- 62- Business Name | 63- Tax Id # | 64- Legal Name
> Renamed data file “CUSTOMER STATEMENT” with ‘Customer/Business Statement’
> Renamed file name file “CUSTOMER_STATEMENT” with
‘Customer_Business_Statement $(PROCESS_DATE_YYYYMMDD).dat’
e Master Customer Statement Changes: [SET-ODD2 > OSTPRC_BJ 100 02]

If the account class is BUS, the following fields refer to the Business and its Address

details which has ‘Current’ indicator

> Under MASTER ACCOUNT RECORD, if the Master Account is Business only, the
following fields refer to Business and its Address details which has ‘Current’ indicator
- HOUSE #, ADDRESS LINE, CITY, STATE, ZIP CODE, ZIP EXTN

- For SBL and BUS, add the following new ‘Column Definitions’ added under
Setup > Data Files > MASTER_CUSTOMER_STATEMENT > MASTER
SUMMARY RECORD

60 - Business Name | 61 - Tax Id # | 62- Legal Name

> Under ACCOUNT RECORD, if the account is business only, the following fields refer
to Business and its Address details which has ‘Current’ indicator

- HOUSE #, ADDRESS LINE, CITY, STATE, ZIP CODE, ZIP EXTN,

- Add the following new ‘Column Definitions’ under Setup > Data Files >
MASTER_CUSTOMER_STATEMENT > ACCOUNT RECORD

67 - Business Name | 68 - Tax Id # | 69 - Legal Name

e Renamed data file “MASTER CUSTOMER STATEMENT” to ‘Master Customer/Business
Statement’
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¢ Renamed File Name
“master_customer_statement_$(PROCESS_DATE_YYYYMMDD).dat” to
“master_customer_business_statement_$(PROCESS_DATE_YYYYMMDD).dat”
Servicing > Collateral Management

e Provided a new Lien Entity as ‘Business’. If a user selects it as Business, Entity Name
becomes an LOV.

e |f the Asset linked to an Account then, Entity Name LOV populates the enabled Business
name.
Servicing > Interfaces > Conversion Accounts
e If the account is business only, system disables the Applicant Tab
o Added new fields to the following tabs
> Business Details

- Update Business Info | Email | Time Zone | Privacy Opt Out | Insurance Opt Out |
Marketing Opt Out | Share Credit opt Out

> Telecom
- Time Zone | Best Day to Call | Start Time | Period | End Time | Period
> Address

- Confirmed Indicator

Customer Service > Account(s)
e After opening any business-only account,

> On selection of ‘Show AllI’ button, system lists out the list of business account which
matching with ‘Tax Number’ with the business enabled in other accounts

> On selection of Group Follow-up button, system shows the list of business only
accounts if any business only accounts are grouped for follow-up

e Ifitis SBL, system continues to show the accounts based on the customer only.

Customer Service > Field Investigation

¢ Renamed the Customer LOV with Customer/Business in a table and also in
Add/Edit/View

e Lov will also show the Business Name if account class is ‘SBL’ or ‘BUS’

Customer Service > Maintenance
e New transactions available for Business Only and SBL Accounts

Txn Code Txn Description Txn Parameters

BUS_BANKR | BUSINESS BANKRUPTCY | BANKRUPTCY INDICATOR
UPTCY_INFO | REPORTING INDICATOR BANKRUPTCY DISPOSITION

BANKRUPTCY TYPE
EFFECTIVE DATE

e While adding new Business from Customer Service > Customers > Business screen or
using the non-monetary transaction, system validates if the existing business has
bankruptcy indicator as 'Y’, then shows an error “Can’t add New Business. Existing
Business is Bankrupt”
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Batch Job Changes

While running the below batch jobs, if the account is business only, then system refers

the Business Details to process it

> SET-ESC > TESDSB_BJ 100 01/ TESANL_BJ 100 02/ TESANL_BJ 100 04 >
ESCROW ANALYSIS

» SET-ODD2 > OCNPRC_BJ 100_01 > CUSTOMER COUPON BOOK GENERATION

> SET-ODD2 > OCPPRC_BJ_100_01 > OUTBOUND CUSTOMER EXTRACTS TO

PAYMENT AGENCIES

2.9.3 Screen Changes

Servicing > Vendors > Work Orders

Account(s): 20198801112: TEST FINANCE
view — Pormat ~  [F Freese [ atach 3l wrap @R & @ curentO show AN Group Fellow up () Associal ted Accounts
Branch Sub Unit Account = Master Account = Master Account Product Biling Cyell
SARL UNDEFTMNED 20198301112 UMDEFINED L LOAN-VE-PAVAN MONTHLY
sramary sl “ustamer Service  Aceount Detale | Business Detsils  Busness Sreferences || Transaction History | Pt Modes Bk RepofFormcdonse  Defieen ol
Business
Business Details
View ~ Format = [~ 3 Freere [ Detach Bl show s [
Current Dusiness = Organization Type  Type of Dusiness  Dusiness Categiry" Name of the Dusiness Legal Name Tee
[ L 0000001004 © CORP CORPORATE TEST FINANCE TEST FINAMNCE PVT LTD o
<
Addresses  Telecoms | Parters | Affiliates | Trocking Attribules || Business Sesre
Address Information
View = Format - (2 ceze  pf Detach
Current Maileg Address = Address Type Permission to Call  Perméssion to Text  Confrmed Country ity
x x 10231 HOME ¥ ¥ ra SALOL ARAR RITADH
o $

Customer Service > Business Preference

Account(s): 2019880111 1: TEST FINANCE [Elven | v ms
View = Format = 5} warn o Dmtach B 4 ) Currer () Show Al Groun Pollow-up () Associated Accounts
Clans Company Brah Sub et Acemnt 8 Mater Actount B Master Account  Prickact g Cycie apous Biays Pt bum Comrency Eay O Ast
0 usthess oy | SAUCH SRl UnoErpen 801111 LrOErTeD L LOANYESAVAN MOMTHLY 188 MR L2830.60
»
7 ) T e e, 500 5 ) 5 o s
Business Preferences e Add | e Ve 7 Rudt
Wew= Fomat= [ | |Freem Eipetn o W ']
Relation Tyoe: Commuricaton Mode Tyoe Emal #hone. Extn Permisson to Cal  Time Zone Best Dary o Call
Busginess Preferences
Hsremisd | [ deve muitug | [ Seenadbenan | Cafienan
I * Ritaben Type BLSDESS = I Phore (35)-855.7881 e T
] Fenad
* Communcation Made  TELECOM w| Gty e End Tme
*Type [PHORE : 5855567881 L] e . e
ADDRESS : 0 [ 1 Best Day o Cal Enalied []
PHOML : 555567801
ADCRIESS § 7611666
PO : 45111343
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Business Preferenoes e pd | B hew | o Al
View v Formatv B Frere [lioeman | Jdwe @)
Relaon Tyoe Commraation Hode Tyoe Emad Prene: Extr Pormsion to £l Time Zore Best Doy b Cal
< »
Business Preferences
Elsseeandadd | [ seve sndsmy || (] Save sdienm || Cagetum
* Riedabon Type  DUSINESS wel et the commurcation sode = rabied [J
* Communcation Mode [EMAL ADDRESS | %3
Bl PAA GGHAL M
Bankruptcy Details 4k add | A Edit | [5] view || o Audit
view v Format= [y Freeze fiDetach | ol wrap 5]
Current Followup Dt Disposition Type Customer/Business _ |Relation Comment File Received Dt Bankruptcy Start Dt Bankruptcy End Dt
My 12/31/4000 11/16/2019
Bankruptcy Details
[ saveand Add | [ Saveand Stay. | [ Save and Return CaRetun
* Current
*Folowup Dt 12/31/4000 (%5 Comment
= Disposition [
Type [<] | Select the customer o business account
PR ———— File Received Dt B
Bankruptey StartDt | 11/16/2019 B
Bankruptcy End Dt [E2Y

Servicing > Batch Transactions > Advance > Advance Entry > Advance Allocations

Advance Allocations
View v Format~  [5p
Amount Payee #

| | 0.00

<

Advance Allocations

Freeze ﬁ Detach &l Wrap Gﬁ

Hame Type Mode Coun

Validate Payee
= Amount | 0.00

try

City State

Address Line 1

zZp
*Type | BUSINESS ] City
*Payee ¥ hd State
* [ame 0000006003 LINE-BUS-BIENNIAL Bank Name
=Pt Mode 0000006003 LINE-BUS-BIENNIAL Routing #
* Country SEarch.. o ACH Account

Address Line 1 Zp
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Customer Servicing > Summary > Business Only Account

t Product Billing Cycle Class Purpose Days P
LIMNE-BIEMMIAL BIEMMIAL BUSIMESS OMLY
Hon History | PmtModes  Bankruptcy — RepofForeclosure | Defidency  Collateral | Timeline  CrossfUpSela >
» Conditions
Other Information
Collateral Information
Primary Description Identification # fear Asset Class Asset Type 51
¥ 2015 HOMDA ACCORD SEDAMN 2015 MEW VEHICLE Ci
< >
usiness Information
Business . N . .
# Mame of the Business Organization Type  Business Category  Type of Business Legal M
QO0000... LIME-BUS-BIEMMIAL C_CORP c LIME BI
R+ >
Email PAVAN@GMAIL.COM Management 3 Stop M
Contact PAVAN NAPHADE Since Correspondence
Person Bankruptcy ¥ Privacy Opt Qut M
Start Dt 12/18,/2000 Skip Y TimeZone ASIA/RIYADH
Outbound Call History{All Accounts)
Today 0 Last 30 days 0
Last Fdays 0
Address Information
Address Permission =
e Current ¢ e Mailing Address 1 Contact Phone
HOME ¥ ¥ (054)-355-5333
Telecom Information
Telecom Type Current i;g;ﬁsmn Phone Extn Time Zone Best Day to C
PHOME Y Y (045)-111-1433 1212
< >
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Customer Servicing > Collections > For Business Only Account

Account(s): 2019011017: LINE-BUS-BIENNIAL
View v Format~ B Freeze " Detach ol Wrap (e (®) Current i) Show alli_) Grouy
Class Company Branch Sub Unit Account # Master Accou
BLUSIMESS OMLY SALDI SAR1 UMDEFINED 2019011017 LINDEFIMED
<
Account Details
Business Information
Business ) N ) )
= Mame of the Business Organization Type  Business Category  Type of Business Legal Mz
000000... LINE-BUS-BIEMMIAL C_CORP C LIME EIE
< >
Email PAVAN@GMAIL.COM Management 3 Stop N
Contact PAVAN MAPHADE Since Correspondence
Person Bankruptcy Y Privacy Opt Out M
Start Dt 12/18,2000 Skip TimeZone ASIA/MRIYADH
Outbound Call History(All Accounts)
Today 0 Last 30 days 0
Last 7days 0
Address Information
Address Permission .
s Current to Call Mailing Address 1 Contact Phane
HOME b Y Y (054)-355-5333
Telecom Information
Telecom Type Current E;:l;:n:ﬁsmn Phone Extn Time Zone Best Day to Cz
PHOME Y i (045)-111-1433 1212
< >
Collateral Information
Primary Description Identification # Year Aszet Class Aszet Type 51
b 2015 HOMDA ACCORD SEDAM 2015 MEW VEHICLE )
< >
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Setup > Data Files > Output > Data File Definitions

Data File Definitions e Add || 2 Edit
View + Format - Freeze Detach cﬂ Wrap E‘ﬁ
MName Description ﬁe MName

View || < Audit

CUSTOMER _BUSINESS_STATEMENT CUSTOMER,/BUSINESS STATEMENT

customer_business_stmt_${PROCESS_DATE_YYYYMMDD).dat

MASTER _CUSTOMER. _BUSINESS _STM MASTER CUSTOMER,/BUSINESS STATEMENT
<

master_customer_business_statement_$(PROCESS_DATE_YYYYMMDD).dat

MASTER_CUSTOMER_BUSIMESS _STM
<

>
Record Definitions a4k Add | 7 Edit view || o Audit
View  Format « % Freeze Detach cﬂ Wrap E‘ﬁ
Record Type Description Record Format Delimiter Terminator
1 HEADER. RECORD VARIABLE | CARRIAGE RETURM AND LINE FEED
W= {CUSTOMER RECORD IVARIABLE 1 CARRIAGE RETURN AND LINE FEED
3 TRAMSACTION RECORD VARIABLE | CARRIAGE RETURM AND LINE FEED
4 MESSAGE RECORD VARIABLE | CARRIAGE RETURM AND LIME FEED
5 FOOTER RECORD VARIABLE | CARRIAGE RETURMN AND LINE FEED
Column Definitions o Add || 7 Edit View || o Audit
View + Format |' Freeze [: Detach Qﬂ Wrap Glﬂ
Seq 2% Column Mame Data Type Format Mask Length Data Column Output Column
54 LEGAL MAME VARCHARZ MOT APPLICABLE an o4 04 A
53 TAX ID VARCHARZ MOT APPLICABLE 30 &3 &3
52 BUSIMESS MAME YVARCHARZ MNOT APPLICABLE 80 52 52
651 RATE CURRENT NUMBER. (g, 2) 999999999.90 11 61 61
50 DUE DATE DATE MM/DDMYYY 10 =] =]
59 PRINCIPLE BALANCE MNUMBER. (5, 2) 999999993.30 12 59 59
58 POCOL VARCHARZ MOT APPLICAELE 30 58 58
57 STATEMENT DATE DATE MM/DDYYYY 10 57 57
556 STATEMENT CLOSING D... DATE MM/DDYYYY 10 56 56
55 OLDEST DUE DATE DATE MM/DDYYY 10 55 55 W
Data File Definitions o Add || Edit View || < Audit
Wiew + Format - Freeze ¥ Detach qﬂ Wrap E]ﬂ
& %LMASTER ¥
Mame Description File Mame

MASTER _ACCOUNT_MOCK_STATEMENT MASTER ACCOUNT CUSTOMER MOCK STATEME... master_account_customer_mock_stmt_$(PROCESS_DATE_Y
MASTER CUSTOMER (BUSINESS STATEMENT

master_customer_business_statement_S{PROCESS_DATE_Y

>
Record Definitions 9P Add || 7 Edit View || o Audit
View v~ Format = [P Freeze Detach <l Wrap e
Record Type Description Record Format Delimiter Terminator
1 HEADER. RECORD WARIABLE | CARRIAGE RETURM AMD LIME FEED
2 MASTER. SUMMARY RECORD VARIABLE | CARRIAGE RETURM AMD LIME FEED
W= {ACCOUNT RECORD WARIABLE | CARRIAGE RETURN AND LINE FEED
4 BALAMCE DETAILS VARIABLE | CARRIAGE RETURM AMD LIME FEED
5 TRAMSACTION RECORD VARIABLE | CARRIAGE RETURM AMD LIME FEED
-] PAYMENT ALLOCATIONS VARIABLE | CARRIAGE RETURM AMD LIME FEED
7 MESSAGE RECORD VARIABLE | CARRIAGE RETURM AMD LIME FEED
a8 FOOTER RECORD VARIABLE | CARRIAGE RETURM AMD LIME FEED
Column Definitions 9P Add || 7 Edit View || o Audit
View v~ Format = [P Freeze <l Wrap e
Seq Column Mame Format Mask Length Data Column
|| 69 LEGAL NAME NOT APPLICABLE 80 69 A
68 TAX ID VARCHARZ MNOT APPLICABLE 30 =15
67 BUSIMESS NAME VARCHARZ MNOT APPLICABLE 80 a7
66 DUE DATE DATE MM /DD Y 10 =1}
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Data File Definitions

View + Format + -' ﬁf Detach

Freeze

dwep @

Mame Description

& %MASTER %

File Name

MASTER _ACCOUNT_MOCK _STATEMENT _MASTER ACCOUNT CUSTOMER MOCK STATEME... master account customer mock_stmt gPROCEES DATE Y

o Add | 7 Edit view || g Audit

I MASTER. _CUSTOMER. _BUSIMNESS_STM MASTER CUSTOMER/BUSINESS STATEMENT

master_customer_business_statement_S({PROCESS_DATE_Y I

£ >
Record Definitions P Add || 7 Edit view || < Audit
View v Format~ [ Freeze  EAf Detach <l wrap ]
Record Type Description Record Format Delimiter Terminator
1 HEADER. RECORD VARIABLE | CARRIAGE RETURM AMD LINE FEED
. 2 ASTER SUMMARY RECORD SVAR_IAELE | CARRIAGE RETURM AMD LINE FEED
3 ACCOUNT RECORD WARIABLE | CARRIAGE RETURM AMD LINE FEED
4 EALAMCE DETAILS VARIAELE | CARRIAGE RETURM AMD LINE FEED
5 TRAMSACTION RECORD VARIABLE | CARRIAGE RETURM AMD LINE FEED
[} PAYMENT ALLOCATIOMNS VARIABLE | CARRIAGE RETURM AMD LIME FEED
7 MESSAGE RECORD WARIABLE | CARRIAGE RETURN AMD LINE FEED
a8 FOOTER RECORD VARIABLE | CARRIAGE RETURM AMD LINE FEED
Column Definitions o add || Z Edit View | < Audit
View v Format - E? Freeze ﬁf Detach qﬂ Wrap Gﬂ
Seq Column Mame Data Type Format Mask Length Diata Column
. 62 LEGAL NAME VARCHARZ MOT APPLICAELE a0 B2
6l TAX ID VARCHARZ MOT APPLICABLE 30 a1
60 BUSINESS MAME VARCHARZ MOT APPLICABLE a0 al
59 STATEMENT DATE DATE MMDD Y 10 a8
58 STATEMENT CLOSI... DATE MM,DD Y 10 58
57 TOTAL PRIMCIPLE ... NUMBER (9, 2) 999999959.90 12 57
56 TOTAL MEW BALA... NUMBER (9, 2) 995999959.90 12 56
55 TOTAL OUTSTAMD... NUMBER (9, 2) 999999399.90 iz a5
54 TOTAL OUTSTAMD... NUMBER (9, 2) 999999999.90 iz 7
53 TOTAL PAYOFF A... NUMBER (9, 2) 9959999599.30 iz 53w

>

Servicing > Collateral Management

Customer Service Collateral Management  Data Files

Condition GOOD CONDITIOMED L
VIM Validation

Usag
Rollover/advance
Reset Frequency
Elastic Term Calc

Lien Details Method
Usage/Rental Calculation
Lien Status  UNDEFIMED L
Lien Event Dt &y Calc Method TIERED
Second Lien Holder Usage/Rental Receipt
Comments
" Usage /Rental
Details
Usage Details(Life)
Lien Release Entity  BUSIMNESS o
Entity Name - Start (12
Base 12
LIME-BUS-BIEMMIAL Extra 12
Search... Total 12

=
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Servicing > Interfaces > Conversion Accounts

Address Information
View = Format = B Freeze 4 Detach ol Wrap L]
Permission to Call Permizsion to Text  Address Type Country Address # City State d
L
£
Address Information
E Save
* Current Comment
- -
Permission to Cal * Postal Type NORMAL ADDRESS |
* Permission to Text
N Address #
* Mailing !
Street Pre w
* Confirmed []
* pddress Type | Street Name
Street Type
* Country UNITED STATES | ¥R (]
Street Post
Own/Lease | (]
Apt #
Business Reguest Dedsion Contract Master Account Collateral  AccountDetails ~Comments — Verification
Business Details 9k Add | A Edit | [S] View | o Audit
View v Format v (& Freeze  {fiDetach | ol Wrap
Existing Business #  Organization Type  Business Type Business Category  Business name Legal Name TaxID # Start Dt #of Employees(Cur)  # of Employees Contact Persor
|| noooooooon CCoRP SERVICE CORPORATE EVER GREEN EVER GREEN 09874874 01/01/2010 25.00 25 RAJESH
< >
Business Details
[ saveandstay | [ saveandRetumn || CaRetun
Existing Business # 0000000000 + % of Employees 25 * Existing Business []
* Organization Type  C CORP ™) Contact Person RAJESH Existing Business Mame
. Update Business Info [_]
* Business Type | SERVICE ] Business Checking Bank SBI BANK OF AMERICA o
Business Category | CORPORATE =] N privacy Opt out [
gory v Bank Acc # 249838494 * Insurance Opt Out []
*Business name | EVER GREEN *Currency US DOLLAR ] * Marketing Opt Out [ ]
*Legal Name |EVER GREEN = Avg Checking Balance  124,344.00 * Share Credit opt Out [
=TaxID # 09674874 * Loan Currency Avd 42,342.00 Email | HELP@EVERGREEN.COM
Checking Balance
*StartDt 012010 | B ° Time Zone | US/PACIFIC [~
* # of Locations 2
+ & of Employees(Cur) 25
* Maniagement Since | 2010
Telecom Information G add | FEdit | [ view | o Audit
view v Formatv  [Ep Freeze {fDetach ol wrap
Type Permission to Call  Permission to Text Phane Exin Current Time Zone BestDay toCal  StartTime Period End Time
| ¥ ¥ N N
< >
Telecom Information
| Saveand Add || [ SeveandStay | [ SaveandRetun || CaRetun
* Permission to Call Extn Start Time
* Permission to Text * Current [ period =
o
Type [~ Time Zone End Time
Phone Best Day to Call [v] Period ]
Customer Service > Account(s)
Account(s): 20198801112: TEST FINANCE
View ~ Format~ (5 Freeze G Detach &l virap W 8 O current(O) Show All @ Group Follow-up () Assodiated Accounts
Class Company Branch Sub Unit Account £ Master Account #  Master Account Praduct iling Cyde Purpose Days Pasf
[BUSINESS ONLY ~ SAUDI SARL UNDEFINED 20198801112 UNDEFINED N LOAN-VE-PAVAN MONTHLY
SMALL BUSINESS SAUDL SAR1 UNDEFINED 20190100011639 UNDEFINED N LEASE VEHICLE MONTHLY VEHICLE LOAN OR.
BUSINESSONLY  SAUDL SARL UNDEFINED 20198801111 UNDEFINED N LOAN-VE-PAVAN MONTHLY
<
Account(s): 20198801112: TEST FINANCE
View= Formatv & Freeze [iDetach ol Wrep W & Ocurent@ishow al O Group Follow-up O Associated Accounts
Class Company Branch Sub Unit Account # Master Account #  Master Account Product Biling Cyde Purpose Days Past]
'BUSINESS ONLY SAUDI SAR1 UNDEFINED 20198801112 'UNDEFINED N LOAN-VE-PAVAN MONTHLY
SMALL BUSINESS  SAUDI SARL UNDEFINED 2019010011633 UNDEFINED N LEASE VEHICLE MONTHLY VEHICLE LOAN OR..
BUSINESS ONLY  SAUDI SARL UNDEFINED 20198801111 UNDEFINED N LOAN-VE-PAVAN MONTHLY
<
Total Pay Off Amt 41,423.20 T
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Customer Service > Field Investigation

Summary || Colectons  Customer Service | AccountDetais | Customer Detals | Customer Preferences || Transaction History | PmtModes | Bankruptey | RepofForedosure | Deficency | Collateral | Bureau | Timeline | Cross/Up Sel Activities | Exten >
Call Activities | Maintenance | Comments | Promises | Checklists || Tracking Attributes | Field i References G Letters | Document Tracking || Access History
Field Investigation dpadd | LEdt | [Fview | o Audt
View » Formatv [P Freeze HfiDetach | ol wrap 5]
Verification Type  Verification Agency Status
Field Investigation
A saveandAdd || [ SaveandStay | [ Save andRetum | CaRetum
Select the customer or business name
*Status ~ # of Attempts
* Verification Type Spoke to * Result ~
* Verification Agency | SEV call Dt [}
LINE BUS
Business Details
dp add | A Edit | 5 view | o audit
View v Formatw [y Freeze EdiDetach | ol Wrap R showal (1
Current Business & Organization Type  Type of Business  Business Category  Name of the Business Legal Name TaxID # Start Dt #ofEmployees(Cur)  #:
| 0 0
¥ 0000002002 C CORP CORPORATE SETME GEV GEVLTD 0003424 01/01/2019 50
< >
= = & Error x
Business Details
Cant add New Business, Existing Business is Bankrupt (SYS-5YS-5Y5-UCS-002030) 5 save and pcd || [ save and stay, || [ save andRetun || Gagetun
oK
* Organization Type C CORP v L I35 A TCU Y DGR Lt * Inspurance Opt Out []
*Type of Business  SERVICE v *Bank Acc # 03490859854 * Marketing Opt Cut E

2.9.4 Seed Data
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Refer ‘Appendix: Seed Data’ chapter.
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2.10 New Billing Cycles for Loan/Line/Lease

2.10.1 Overview

Following new Billing Cycles introduced for Loan/Line/Lease to support Vacation Ownership (VO)

industry:

e Biennial (Once every 2 years)

e Triennial (Once Every 3 years)

2.10.2 Description

e Introduced new Biennial, Triennial billing cycles i.e.,

> Biennial does billing once every 2 years
> Triennial does billing once every 3 years

e In case of Lease, these new billing cycles are applicable only for Calculation Method =

Interest Rate

> Applicable for both Rent Collection Methods: Advance and Arrears.

> Flexible repayment > Skip Months are not allowed
>  Allowed for Balloon Method — N+1
> New billing cycles are not allowed for Agreement type, Usage, Rental, Rental Usage

e In case of Loan, these new billing cycles are applicable only for Product Category =

standard

> Applicable for both Advance and Arrears.
- Advance >> First Payment Date = Contract Date
- Arrears >> First Payment Date > Contract Date
> Flexible Repayment > Skip Months are not allowed

> Allowed for Balloon Method — N+1 and N

e System takes care of the following:

Accrual Method

Accrual Type

Applicable for

Average Daily Balance | Interest Bearing | Loan/Line
Actuarial — Monthly Pre-compute Loan/Lease
Sum of Digits Pre-compute Line
Interest Bearing Interest Bearing | Loan/Lease
Straight Line Pre-compute Loan

e Tools > Loan/Lease calculator > Calculate Term
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> Based on the information provided by the user and on clicking calculate:

- Biennial if it goes beyond 15 then give an error ‘Term is going beyond max,
refine the input data

- Triennial if it goes beyond 10 then give an error ‘Term is going beyond max,
refine the input data
e ACH generated according to the new cycles configured

e System assesses the Late Charge, Delay Fee and Periodic Maintenance Fee in
according to the new cycles

e Metro Il Reporting is not supported for these billing cycle’s accounts, hence user should
open the STOB CB condition on to such accounts.
e Following monetary transactions considers these new billing cycles

> CHANGE_BALLOON | CHANGE_PMT_AMT | CHANGE_TERM |
LS_CHANGE_PMT_AMT | LS_CHANGE_TERM | RESCHEDULE_INDEX |
RESCHEDULE_PAYMENT | RESCHEDULE_PC2S| | RESCHEDULE_RATE |
DDCHANGE

2.10.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.11 Payment Hierarchy Changes

2.11.1 Overview

Currently system distributes the amount only using the Equal [system defined] and Column
Based hierarchy [setup based]. Now enhanced to allocate when excess payment amount
received and supports two more methods

Appropriate payment using “Due Amount Ratio”

> When payment received on Master Account/Customer/Business, system
appropriates in the ratio of due amount of each account.

Appropriate payment using “Out Standing Balance Ratio”

> When payment received on Master Account/Customer/Business, system
appropriates in the ratio of outstanding balance amount of each account.

The payment hierarchy now maintained at master account level.

2.11.2 Description
Setup Changes:

2-47

Added three new fields to Setup > Payment Hierarchy
> Hierarchy Type — it will have four values

- Equal — system does the allocation equally out of the resulted accounts

- Due Amount Ratio — system does the appropriation based on the Amount Due
of the resulted accounts

- OQutstanding Balance Ratio — system does the appropriation based on the
Outstanding Balance of the resulted accounts

- Column Based - system does the allocation based on the Amount Due of the
resulted accounts in a sequence configured under ‘Hierarchy Order’
System enables “Account Selection Criteria” tab for all Hierarchy types and Enable
“Hierarchy Order” tab only for “Column Based” Hierarchy type
> User can define multiple Hierarchies with same Hierarchy type
> While enabling the record, system checks that, there is at least one Account
Selection Criteria that exist and that Criteria is valid.

From the Customer/Business Payment WS or File Upload, if user doesn’t pass any
hierarchy i.e., none/blank is passed and auto-allocation is required then system will refer
the system parameter ‘CUSTOMER DEFAULT PAYMENT HIERARCHY

If the system parameter is disabled, then system will be done using the default method
i.e. DUE_RATIO. System picks all accounts of customer/business

If payment hierarchy is ‘Due Amount Ratio’ or ‘Outstanding Balance Ratio’ while
populating the list of accounts, system considers only the amount up to the total of
resulted accounts and the remaining amount looks into excess payment method value.

When user selects the ‘Populate Accounts’ button from Payment Txns screen, system
considers the excess payment method and populate the excess amount with the option
provided for that payment hierarchy.

If the hierarchy type is ‘Equal’, and while populating the account if system does not find
any accounts, then system allocates based on the Excess Hierarchy method.

When system goes with excess payment allocation, system loops only once.
Provided following new LOVs in the screen
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Field Type | Reference Comment
Excess LOV | PMT_HIERARCHY _ Suspense — populate account with ‘0’
Handlin EXCESS_METHOD_CD . __ .
9 - - Hierarchy Based- <it will enable the ‘Excess
Method ) )
Hierarchy Name’' LOV>
Excess LOV | List of all Hierarchy User can select any method and system
Hierarchy Definition Names from reallocates the excess amount based on the
Name the same ‘Hierarchy’ Hierarchy Definition selected
setu . o .
P If selection criteria used for Excess Hierarchy
Code did not return any account, then the
excess amount will go to Suspense [account
number 0]
Disable when the Excess Payment method is
Suspense
Shows only enabled records
This field is mandatory when Excess Handling
Method is Hierarchy Based
Payment Hierarchy [] Close
Hierarchy Definition ok Add | Edit S| View | o Audit
View » Format + g Freeze i Detach Wrap 0]
&
MName Description Hierarchy Type E:;ﬁs;jHand"ng E’;ﬁ:s A=
EQUAL _AMOUNT EQUAL AMOUNT EQUAL AMOUNT SUSPEMSE
L4 >
Hierarchy Definition
Save and Stay, Save and Return (‘;| Return
*MName EQUAL_AMOUNT Excess Handling Method = SUSPENSE ~
* Description  EQUAL AMOUNT Excess Higrarchy Mame
I* Hierarchy Type EQUAL AMOUNT v I Enabled v
Account Selection Criteria
Account Selection Criteria 4k Add || 7 Edit =| view | o Audit
View + Format - % Freeze ﬁ' Detach Wrap @ﬂ ¢ Check Criteria
Seq ( Parameter g;rg;ﬂfon Criteria Value )] Ié?;l'—::lmr Enabled
o STATUS EQUAL ACTIVE Y
£ >

Application Entry > Applicants / Business

e Added new non-mandatory ‘Payment Hierarchy’ LOV to the Applicant and Business tabs;
it shows the all enabled records form the payment hierarchy setup.

e When users copying the Applicant Details or Business details from the search screen,
system will also populate the Payment Hierarchy to the Customer Service >
Customer/Business details.

e For an existing customer has a value, and If user changed the Hierarchy, and Update
Customer/Business info flag is checked then after funding, system updates the Payment
Hierarchy in Servicing > Customer / Business details
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Underwriting > Master Account

e Added a Payment Hierarchy field in the Origination > Master Account Details tab. This
field shows the Payment Hierarchy setup details.

o If user enabled the ‘Master Account’ checkbox, then system enables this LOV
e After funding this account, system populates this value to the account.
e Shows it on “Customer Service > Account Details > Additional Details

Customer Service changes
e Provided a new Non-Monetary transaction ‘Master Account Payment Hierarchy
Maintenance’ to update Payment Hierarchy for the Master Account
>  This transaction has the following parameters
- Transaction Date

- Payment Hierarchy — free text field and user need to get the Hierarchy Definition
Name from the setup input

- Reason
e System validates the Payment Hierarchy value based on the setup.
e This transaction is allowed to the ‘Master Account’ only

e Inthe ‘Payments > Payment Entry > Payments > Add’ after user inputs the Customer #
and/or Master Account Number system populates the Payment Hierarchy field with
Master Account’s Payment Hierarchy.

> If user provides only customer number then system populates with Customer’s
Payment Hierarchy

e When user enabled the ‘Multi’ checkbox, Payment Hierarchy LOV is available in the
‘Payments > Payment Entry > Payments > Add/Edit > Payment > Payment Hierarchy’
searchable LOV.

e System default is based on Customer or Master Account [if both system parameters are
enabled, then it defaults with Master Account’s Payment Hierarchy]

Amount Due Ratio:
o After providing the Customer # and/or Master Account Number, and clicking ‘Populate
Accounts’ button,

> if Payment Hierarchy's Hierarchy Type = Due Amount Ratio, system populates the
‘Payment Txns’ records with the Amount as below

> System derives the total of Customer Service > Amount Dues for all resulted
accounts based on Account Selection Criteria

> System derives the ‘Amount’ for each account using the following computation

Amount Due * Payment Amount
Total Due Amount

That means:

Accl Amount DuexPayment Amount + Acc2 Amount DuexPayment Amount

Payment Amount =
Total Due Amount Total Due Amount

Acc N Amount Due * Payment Amount

Total Due Amount

e Due Amount Ratio will appropriate the amount up to amount due. The remaining/excess
amount will allocate based on the Excess Allocation. If the payment is underpaid (less
than total due) allocate based on due.
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e If the total of Due Amounts are zero, then system ignores the accounts and does not
populate the account in UL.

Outstanding Amount Ratio:

e After providing the Customer or Business # and/or Master Account Number, and clicking
on ‘Populate Accounts’ button

» if Payment Hierarchy's Hierarchy Type = Outstanding Balance Ratio, system
populates the ‘Payment Txns’ records with the Amount as below

> System derives the total of Customer Service > Outstanding Balances for all
resulted accounts based on Account Selection Criteria

> System derives the ‘Payment Amount’ for each account using the following
computation

Outstanding Balance * Payment Amount

Total Outstanding Balance

That means:

Payment Amount =

Accl 0/S Balance » Payment Amount Acc2 0/S Balance x Payment Amount

Total 0O/S Balance Total 0O/S Balance
4 Acc N O/S Balance * Payment Amount

Total 0O/S Balance

e Outstanding Balance Ratio appropriated to the amount up to outstanding due. The
remaining/excess amount will allocate based on the Excess Allocation. If the payment is
underpaid (less than total outstanding due) allocated based on it.

e |If the total of Outstanding Balances are zero, then system ignores the accounts and does
not populate the account in UL.

Web service changes

e Customer-Based Payment WS, Business Based Payment WS

>  If Payment Hierarchy Code passed then it should exist in Hierarchy Setup. If
none/blank is passed and auto-allocation is required then it will be done using the

system parameter. If the system parameter is disabled, default method is used i.e.,
DUE_RATIO

e Account On-Boarding changes

>  Currently, system is auto-populates Payment Hierarchy from the system parameter
for applicants and Business. If the request does not have the data, then system

continues to populate the system parameter value even for Master Account Payment
Hierarchy also.

> If the AOB has is no master account (i.e., MasterAccountindicator flag is ‘N’) and if
user is passing the MasterAccountPmtHierarchy at account level, then system
ignores the value and populates it with undefined/null. if MasterAccountindicator is ‘Y’
then system validates the Hierarchy Name with setup [name should be present in the
setup and it should enable] and creates the account
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> Added new elements to the AOB request

Parent Element Element Data Type | Mandatory | Description
o MasterAccountPmt Master Account
ApplicationData . Varchar No Payment hierarchy
Hierarchy name
Primary Applicant
PrimaryApplicantData ngment Varchar No Payment hierarchy
Hierarchy
name
Pavment Other Applicant
OtherApplicantData ay Varchar No Payment hierarchy
Hierarchy
name
Pavment Other Applicant
BusinessDetails ay! Varchar No Payment hierarchy
Hierarchy name

Conversion changes

e During Migration/API Conversion or Payment processing, if Pmt Hierarchy Code is
passed then it should exist in Hierarchy Setup.

e |f the converted account is not master account (i.e., Master account flag is ‘N’) and if user
passing the payment hierarchy at account level, then system ignores the value and
populates it with undefined/null. if Master account flag is ‘Y’ then validated the Hierarchy
Name with setup [name should be present in the setup and it should be enabled]

2.11.3 Screen Changes

Application Entry > Applicants / Business

Applicant
[ saveand stay, || [ Save andReturn || {Return
* Relation Type PRIMARY e Existing Customer ID NONE [0]
Existing Customer # 0000000000 Refel #
Salutation MR ~ J ki
* Update Customer Info [] Siatue T
*First Name | ASSET
MI Other Details FATCA
* Last Name VEHICLE %
Name in Local Language Birth Place
Family N
Sy Gender UNDEFINED o & .
Suffix 5 Birth Country ~
o o P [5“(9 Mather's Maiden Name Permanent US Resident [ ]
g d Education UNDEFINED - ol
55N XX-XXX-7667
*language ENGLISH ~ Power of Attorney:
*Class  NORMAL ~
* Dependents 1
Category INDIVIDUAL ~ . Power of Attorney [
Marital Status  UMDEFINED w Holder
Email PAVANEGMAILL.COM i - e
ECOA INDIVIDUAL v Address
Time Zone - i = ey
; Mationality
Identity Information Ethnicity UNDEFINED ~
Telephone Number
* Disability []
=y N
Nationality  SALDI ARABIA - *Privacy Opt Out 2] Pkt St
*National ID -685-8785 * Insurance Opt Ouf
Passport # * Marketing Opt Out] ERUAL_ AMOUNT je Military Duty []
OUTSTANDING BALANCE RATIO ;
Passport Issue Dt [E:) * share Credit Opt Ouf] i Effective Dt
e [ * Prior Bankruptcy} Quder Rek &
Passport Expiry Dt ] COLUMN BASED 1 Release Dt By
Visa # Bankruptcy Discharge DY cearch, .
2 i I Payment Hierarchyl .42
License #
License State ~ KYC
Prior Applicant
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Business Details e
| Bl saveandstay || [ saveandRetun | CaRetun |
Existing Business # = *Start Dt [£5) * Avg Checking Balance
* Organization Type [ * £ of Employees(Cur) 0 Luga (érirrerécy" Avg 0
* Business Type | CORPORATE [v] * = of Employees 0 tiﬂ:i;:’;: -
* Business Category ] Contact Person * Management Since 0
* Business Name * Business Che‘j“”a Existing Business
Banl =
* Legal Name ek ki Existing Business Name UNDEFINED
. ~ =
Tax ID # * Currency E| Payment Hierarchy i
Address Telecoms | Financials || Liabiities | Partners | Affiiates || Other Detais | Tracking Attributes EQUAL_ AMOUNT
OUTSTANDING BALANCE RATIO
. DUE RATIO
Address Information o —
Underwriting > Master Account
Summary Applicant Business Request Decision Bureau Master Account  Collateral Gogn > ™
Master Account Details &7 Edit =] Wiews = Audit
View ~ Format~ B |Freeze L Detach ol wrap (B
Link to Master
Master Account A G E
Master Account Details
| [l save and stay || [ save and Return || <= Return
* Master Account
Link to Existing Master Account LUNDEFINED bt
Linked Account UMDEFINED -
-

Payment Hierarchy

DUE RATIO
COLLUMM BASED
Search...

EQUAL_ AMOUNT
OUTSTAMNDING BALAMCE RATIO

1

please check th
* Master Account ;:::E
#* Link to Existing Master Account UMDEFIMED
* Linked Account  UMNDEFIMED
Fayment Hierarchy

is to make it as master account

Interest and Accruals Lease Amt Recovered % 0

Additional Details
Total Term 12
Paid Term 0
Maturity Dt 01/01/2020
Security Deposit 0,00
| Payment Hierarchy OLTSTANDING BALANCE RATIO |

Accrual Start Dt 01/01/2019
Last Accrual Dt 01/01/2019
Stop Accrual
Accrual Method  INTEREST BEARING
Base Method 30,360
Accrued Interest 1,236.67
Index Type FLAT RATE
Index Rate 0.00
Margin Rate 7.00
Rate 7.00

Recourse Details

o tion Val 16.000.00 Recourse Agreement Type  UMDEFINED
epredation Value 16,000,

R i) Payment Mode IMSTITUTION DRAFT / CHECK
Residual Value  4,000.00 | eeeares Tiee v /

End Date
Days to Time Bar

Settlement Information

Effective Dt
Good Through Dt
Agreed Amt

Paid Till Dt

Usage/Rental Details

2.11.4 Seed Data
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2.12 Metro Il Changes for Home Collateral

2.12.1 Overview

Enhanced to support the Account Status code 89 for a home loan account.

2.12.2 Description

Changes in the non-monetary transaction

When user posts the ACCOUNT EVENT NOTIFICATION [ACC_EVENT_NOTIFY] non-
monetary transaction with Event Type ‘Deed in Lieu Completed’, system posts IVR|DIL
call activity and updates the DIL condition start date with ‘Event Notification Date’.
» Here account status should be ‘Active’ and Account Collateral type is ‘Home’

> In addition, the account Portfolio Type (PT) should be ‘M’, ‘C’ or ‘I'. If the PT is ‘I’,
then Account Type should be 6D

Changes in Metro Il Reporting

Base/17(A) — Account Status
> If the account status is in ‘Active’
> Account has active ‘DIL’ condition and

> Condition Start Date is less than or equal to the Metro Il process date, then system
reports this field with 89.

Base/18 - Payment History Profile

> When the Account Status (Field 17A) reported with 89 this field also reports with
complete 24 months payment history for the first time when Account Status Code 89
reported.

> In subsequent months (2" time, when system is reporting with 89), the entire
Payment History Profile will be blank filled.

Base/21 - Current Balance*

» If account has CNL (Customer Not Liable for Payment) condition and Account Status
reported with 89, then system continues to report this field with Account Outstanding
Total Amount.

» Ifaccount has DIL but does not have CNL, then Report this field as Zero (0)
Base/22 - Amount Past Due*

> If account has CNL (Customer Not Liable for Payment) condition and Account Status
reported with 89, this field continues to report Account Outstanding Total Amount.

» Ifaccount has DIL but does not have CNL, then system reports this field as Zero.
Base/26 — Date Closed
» If account has DIL condition, and

- If Account Outstanding Total Amount is greater than zero or account has active
CNL condition, then system reports this field with DIL condition’s start date

- If Account Outstanding Total Amount is less than or equal to zero, then system
reports this field with Account Paid off Date.

*Note: In subsequent reporting, if there were any payments applied on to the account, then report
the declining Account Outstanding Total Amount.

2.12.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.

2-53

ORACLE

Financial Services



2.13 Special Character Standardization

2.13.1 Overview

In OFSLL, system supports a different sets of special characters at different layers (Ul / WS / File
Upload). Currently system standardized to support specific set of special characters at all levels.

2.13.2 Description

As part of this release, OFSLL allows only the following Special Characters as part of the text
fields:

1@$S%*-+_ ()&,.21#

and doesn't allow the following Special Characters:
<>{}\"[1"

This change is applicable for all Input File Uploads, Ul screens and Web services — i.e. after this
change, all Varchar fields and text fields are affected.

2.13.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.14 Payment Mode Field Details

2.14.1 Overview

e New ‘Payment Mode’ field introduced at Application and Account level and this identifies
whether the customer is on Auto pay/non-Auto pay.

e New transaction provided to update this ‘Payment Mode’ field in Servicing/Collections.

2.14.2 Description

OFSLL enhanced with ‘Payment Mode’ field. Below are the high-level impacted areas.
Origination:

e Origination > Contract > Others

e Origination > Contract > ACH

Customer Service:
e Customer Service > Account Details > Contract Information > Others
e Customer Service > Account Details > Account Details
e Customer Service > Pmt Modes > ACH

Origination Changes:

e Provided new ‘Payment Mode’ LOV field at ‘Origination > Contract > Others’ as shown in
Figure 1.

e Provided new ‘Payment Mode’ LOV field at ‘Origination > Contract > ACH as shown in
Figure 2. [Note: Only AUTO PAY related LOV options provided.]

e New lookup ‘REPAYMENT_PMT_MODE_CD'’ provided and mapped, for ‘Payment Mode’
field in above two screens. Description of LOV will have this text (Sub code is used to

identify AUTOPAY)
> Toidentify if the mode is AUTOPAY or not, user is expected to use Sub Code =
AUTOPAY.

> Seed data has sub code AUTOPAY for lookups AUTOPAY (ACH), AUTOPAY
(CREDIT_CARD) and AUTOPAY (DEBIT_CARD).

» CREDIT_CARD, DEBIT_CARD and PDC disabled in product seed data.

e During Origination “Contract > Payment Mode” value is automatically updated to “ACH >
Payment Mode”, if active Recurring ACH record is created.

Provided Contract Edits as Warnings:

Type Edit Description Default Enabled

Contract Edits ‘Payment Mode’ field is AUTO PAY TYPE, and WARNING | No
then at least one active ACH would exist.

Contract Edits ‘Payment Mode’ field is INSTITUTION DRAFT / WARNING | No
CHECK then no active ACH record should exist.
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Field Details:

Field Name | Type | Reference Comments | Values in LOV/ Default Value
‘Payment LOV | REPAYMENT_P | Ability to INSTITUTION DRAFT / CHECK -
Mode’ in MT_MODE_CD | know Default Value
Contract repayment
screen mode AUTOPAY (ACH)
AUTOPAY (CREDIT CARD)
AUTOPAY (DEBIT CARD)
POST DATED CHECKS
‘Payment LOV | REPAYMENT_P | Ability to AUTOPAY (ACH) — Default Value
Mode’ in MT_MODE_CD | know ACH
ACH screen repayment AUTOPAY (CREDIT CARD)
mode AUTOPAY (DEBIT CARD)
Figure 1:

Delggivsetion

Contract Information

Conlract

Hate Cops and

) Sove andd stay | [ Save snd Ratian

G et

ACH Information

se ] Detach

Statis

tions  Tradeln  Subwestion  Insurances

Dl
¥ n2f012019

Staet Dy

® Start 0t 02/01/2019

@

ESC  Procods Distursements  Fees

Ered E Y

PHEARRANGED PAYMENT AND DEF S

SEC Code

) save and Add | [ Seve and Stay || ) Seve and Retum | GaBeturn
E c &

Customer Service Changes:

e Provided ‘Payment Mode’ at ‘Customer Service > Account Details > Contract Information
> Others’ as shown in the Figure 3 below.

e For current ‘Payment Mode’ update in Servicing, provided ‘Payment Mode’ field at
‘Customer Service > Account Details > Account Details’ as shown in the Figure 4 below.

e Origination ‘Payment Mode’ field populated to above-mentioned two screens in Servicing.

e Provided LOV field as ‘Payment Mode’ at ‘Customer Service > Pmt Modes > ACH >
Recurring and One-Time Phone’ as shown in the Figures 5 and 6 below. [Lookup
‘REPAYMENT_PMT_MODE_CD’ mapped].
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e During Servicing, user can automatically update to ACH if Active Recurring ACH record
found (direct or thru Txn).

e ‘Payment Mode’ in ‘Customer Service > Account Details > Account Details’ is in sync with
‘Customer Service > Pmt Modes > ACH’ i.e. when ACH is updated for ACTIVE
RECURRING record, system updates ‘Account Details > Payment Mode’ field as well.
System updates for both direct screen update and transaction posting.

Field Details:
Field Name | Type | Reference Comments | Values in LOV/ Default Value
‘Payment Displ | Populates Ability to NA
Mode’ in ay Origination know
Contract Field | ‘Payment Mode’ | Contract
screen repayment
mode
‘Payment Displ | Populates Ability to NA
Mode’ in ay Origination know
‘Account Field | ‘Payment Mode’ | Account
Details’ Details
screen repayment
mode
‘Payment LOV | REPAYMENT_P | Ability to AUTOPAY (ACH) — Default Value
Mode’ in MT_MODE_CD | know
ACH > recurring AUTOPAY (CREDIT CARD)
Recurring repayment | AUTOPAY (DEBIT CARD)
screen mode
‘Payment LOV | REPAYMENT_P | Ability to AUTOPAY (ACH) — Default Value
Mode’ in MT_MODE_CD | know One-
ACH > One- Time AUTOPAY (CREDIT CARD)
Time Phone Phone AUTOPAY (DEBIT CARD)
screen repayment
mode

Non- Monetary Transaction:

‘Payment Mode Maintenance’ new non-monetary transaction is provided for updating the
‘Payment mode’ field in ‘Customer Service > Account Details > Account Details’.

Transaction Code Details:

T>n Descri Actio | Mon System Enab | Txn/Ba | Statement

. P Group Defined | led | Type | Txn Type
Code tion n etary

(Yes/No)

ACC_P E{.?‘YME ACCOUNT
MT_CO NON POS
DE MA MODE MONETAR | T N NO Y NONE | NONE
INT MAINT Y

ENACE
Batch Manual St?‘temem GL

Print
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System Enab | Txn/Ba | Statement

TXn Descrip Actio | Mon .
Code tion Group n etary Defined | led | Type | Txn Type
(Yes/No)
N Y N N
Transaction Parameters:
Paramet | Descrip | Mandat | Data Type/ | Field Validation Default
er Code | tion ory Y/N | Size Values
Txn Date | Transac | Y Date Field Will not allow any back dated or | System
tion future dated transaction. Date
Date
Payment | Paymen | Y Same New System avoids posting INSTITU
Mode t Mode LOV transaction, if same payment TION
Code [REPAYME mode already exists. gﬁég;/
NT_PMT_M | Error Msg: Mentioned Payment
ODE_CD] Mode already exists.

Impact on Existing Transactions:

o ‘Payment Mode’ LOV field provided as Transaction Parameter for below existing non-
monetary transactions after ‘ACH BANK ROUTING NUMBER’ parameter.
[REPAYMENT_PMT_MODE_CD] lookup mapped to this field.

e Validation: Only Auto Pay type, ‘Payment Mode’ needs to select for below transactions.

Error Msg: “Payment Mode should be of Auto Pay type”.

e ACH MAINTENANCE
e NEW ACH MAINTENANCE
e ACH ONE TIME PHONE PAY

Impact on Web Services:

e ‘Payment Mode’ field provided for below web services at respective Origination level and
Servicing level.

» Account onboarding [Added in ACH & ApplicationContractDetails block].

» Account Details [Added in AccountDetailSummary, AchDetails & OneTimeAchDetails
block].

> ACH [GET/POST].
Impact on Web Services Validations:
o ‘Payment Mode’ field is mandatory in all the mentioned web services.

e ‘Payment Mode’ field element value validates with [REPAYMENT_PMT_MODE_CD]
lookup.

Migration Impact:
e Payment mode added to the Conversion process.

e Payment Mode field in ‘Account Details’ and ‘Contract Details’ are updated with Default
value as “INSTITUTION DRAFT / CHECK”.

e ACH details updated with Default value as “AUTOPAY — ACH".
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Figure 3:

Customer Service > Account Details > Contract Information > Others

ta
s

Total of Pets 6,315.00
Down Pmt .00
Total Sale Price 6,315.00
Payment Amt 526.25
Fanal Pmt Amt 526.25
Resdual Days 0
Index Type  FLAT RATE
Index Rate 4.99
Masgin Rate (+) 4.99
Interest Bate (=) 9.98

Aconsad Post Matunty ¥

Matirity Treex FLAT RATE
Maturity Margin Rt 4.99
APR 979
Principal Balance 5,000,00

15t Pre Deduction Allowed

Pmi Deductaon Days 0
Pret Rl Allrwed ¥

tst Pt Refund Days 14

Instrument LOAN INSTRUMENT - FIXED RATE
Stort Dt Bass  EFFECTIVE DATE
Accrusl Method | INTEREST BEARING
Stast Das 0
Stop Accrual Days 99,999
Accrusl Base  ACTUALIS0
Uilkng Method  LEVEL
Bilng Type STATEMENT

Tame Counting Method  ACTUAL DAYS

Instaliment Method EQUATED PAYMENTS
Contract Recwd Dt 10/01/2019

Billing

Billng Cycle  MONTHLY
Pre Bl Deys 0
Mutiphe Bilkng Asset Rate

Hate Cap & Adjustments

Max Rate Increase [ Year 0.00
Max Rate Increase [ Life 0.00
Max Rate Decrease [ Year 0.00
Max Rate Decreass / Life 0.00
Max # Adpstments [ Year 99.00
Max # Adjustments | Life 999.00
Min Interest Rate (Floor) 0.00
Max Interest Rate (Ceiling) 35.00

Max Pmt Increase | Year 0,00
M P Increase | Life 0.00

Pre Compute _
Rebate Method  NONE
Rebiate Term Method  NEAREST CURRENT CYCLE
Rebste Min Fin Chg Method  NONE

Escrow

Escrow Alowed
Escrow Opt 0wt ¥

Bank Information

ACH Fee Ind _
POC

Promotion

Promotion MONE
Type NONE

Proematicnal Period Type
Promaotonal Period 0
Cancellation Delg Days 0
Tederance Amt 0

Index Raste 0.
Marpn Rate (+) 0
Promoticnal fiate (=) 0.

)

00
o
o

Dthers

| Favmri Mode INSTITUTION DRAFT / CHECK |

Satement

Stmt Preference Mode
Mok Sraternant B

Figure 4:

Customer Service > Account Details > Account Details

Account Information

Interest and Acorsals

fecrual Start Dt 11/07/2009
Last Accrual Dt 11/25/2019
Stop Acorual __
Accrual Method  INTEREST BEARING
Base Method  ACTUAL/B60
Rebate Method  NONE
Accrued Interest 0.00
Index Type FLAT RATE
Index Rate 4.99
Hargin Rate 4.99
Rate 9.98
Rate Start of the Year 4,98
Last Rate Ad) Dt
# of fate Adys (Year) 0
¥ of Rate Adjs (Life) O
Reschedule Method  UNDEFINED
fleschedule Value 0.00

Imputed Interest

Impated Rate

Extn and Dye Dates

# of Extensions (Year) 0

Paryment Hesrarchy

Advance Details

Approved Amt 0.00
Consumed Amt .00
femaining Amt 0.00

Last Advance Amt 0.0
Last Advance Dt

Beoourse Details

Recourse

Recourse Type
Recourse Reason
Max Recourse % 0.00
Recourse Amt 0.00

Cure Letter

Start Date
Expiry Date

Amortized Loans
Extra Principal Pad 0,00

Others

[ soveand sty | [ Seve and Rewsn || G Betum
Mock Pre Statesnent Days 0
Time Bar Details

Start Date 13/25/2019
End Date 13/24/2018
Darys to Tene Bar 36154

Scttlenvent Information
Effective Dt
Good Through Dt
Agreed Ame

Pad THl Dt
[ Payment Mode INSTITUTION DRAFT / CHECK]

Custom Helds

Additonal Place Holder Strng 10 P
Additonal Pace Holder Number 10
Additsonal Place Holder Nusber 11
Additional Place Hobder Number 12
Additional Place Holder Number 13
Additonal Place Holder Number 14
Additonal Flace Holder Number 15

Additonal Place Molder Nuenber 16

Figure 5:

Customer Service > Pmt Modes > ACH > Recurring

* SEC Code  PREARSLANGED P %

* Acecunt 8

® ot At Excess 000

= pent Freq MONTHLY -

Custiner Service
Susmary | Colections. | Custonses Servien Accourt Details | Cusioener Dotails | Customen Preforonces | Transaction Hisory Pt Modes | Baisuptey | RepafTomcknore  Deficiency. | Colateial | Duresu | Tamelos | CrosfUp Scld » =
ACH  Coupon  Post Dated Checks | Mayment Amangement
ACH Information
e add | o 1w | o e
View > Format v (5 Froene [l Dot | gl W 3 Cne-Tione: Pl Al J Cooy
Reference # Bank Marme Routing # Acceount Type SEC Code Account # BIC 18AN Sequence Type Pert Dy Pret Amt Pt Aeit
UHDEFINED. 1 L
< >
| ACH Information
bl Seve ondndd |k Sove and Sty || b Save s Retum | GaRetum
Weference 8 UNDEFINED e - Diree Db Fee []
* lank Name A )
* Routing # e Typse OME TIME BULLET CONTRACT REPAYMENT @
= Pt Dy 1 L]
* Accounit Type  CHECKING & = e et 0.00

* Siatus ACTIVE -

=1
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Figure 6: Customer Service > Pmt Modes > ACH > One — Time Phone

Customer Service

Sumensry  Colectiors  Customer Seevica  Account Detsls  Customer Detads | Custoener Drefwrencis  Transaction History | Prat Modes  Bankruptey  RepnfForeclosure  Deficsmcy | Collsbersl  Bures  Timbne  CrossfUp Sl 3 7

ACH Coupon  Post Dated Checks  Payment Arrangement

ACH Information

4 add | Edn | yiow o At
View~ Format~ [ Froeze [l Detach | gl Wi B | Becurring ® Cne-Time Phane /Al oo
Reference # Banik Name Bank City Barik state Raouting & Account Type SEC Code Hame On Account  Account # BIC BN Sequence Typ
I UNDEFINED
< >

. ACH Information

) seveand dad | ] Saveand Sty | ] Sove and fiztun | G fetum

Reference # UNDEFINED

Bl i Reference

* Banik Nams 18 Drarwes Relation Type =
Sark; City Sequence Type ONE TIME BULLET CONTRACT REPAYMENT Drawer Name
Bank State e * Dbt Dt & Ovawer Adéress]
hng & * Pt Amt 0,00 Dvawer Adcress?

Derect Debt s ] Do 7ip -

= pe CHECKING - * Few At 0.00 Drawer Cry

* SEC Code TELEPHONE INIT, = Secret Question > Drawer Statn v

* Hame On Account Secrot Answer Status ACTIVE ~

* ocount & Prowided Ta Whorm

2.14.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.15 Events Enhancements Phase 3

2.15.1 Overview

OFSLL events enhancement framework enhanced with following:

e Enhanced list of Entities, Event Types and Actions

e Enhanced Event Action Parameters to provide “User Input” during execution of Action.

e User Defined Action Parameters
e Events Dashboard Screen
e Pending Events Actions screen

2.15.2 Description

e OFSLL events enhanced with following list of Entities, Event Types and Actions.

2-61

Copy of Worksheet
in BRD_OFSLL_14.8.0.

e Events framework enhanced to support a new Value Type “USER INPUT” in Event
Action Parameters. This allows users to provide input during execution of Event Action.

e Provided User Defined Action Parameters for existing ‘Correspondence Event Action’,

following load parameters are provided:
> USER DEFINED ELEMENT
> USER DEFINED CONSTANTS

Events

Criteria Details  Action

Actions
View » Formatw [ reeze ] Detach Wray 7]

Action Type Action Code Seq Enabled
WEBHOOK NOME Ly
SEND JMS MESSAGE NONE 1y
WEBHOOK NONE 1Y
SEND CORREPONDANCE LOAN CORRESPONDENCE 2y
POST COMMENT NONE 3Y
SEND LETTER NOME 3Y

v Actions

Action Type SEND CORREPONDANCE

Action Code LOAN CORRESPONDENCE

Seq 2

Action Parameters
View w Formatv [ reeze G Detach (%))

* Enabled [v]

[ seveand Siay | [ Save and Retum | (3 Retun

o Load Parameters

Description Value Type

COMMENT CONSTANT | ¥
PINCODE CONSTANT |

Value

LOAN APPLICATION STATUS IS UPDATED

110022

Required

A new dashboard ‘EVENTS’ provided in ‘DashBoard > System Monitor’ to display list of Events

that triggered in OFSLL. This supports:
e Resubmit failed Event Actions.
e View Events that did not meet Event Criteria.
o Event Parameters, not allowed for updating.

e ‘Resubmit’ button is used to resubmit FAILED status Online Event Actions only, whereas
‘Resubmit’ is not allowed for ‘WEBHOOK'’ and ‘SEND JMS MESSAGE' actions, as same

functionality provided in JIMS Queues.
e Once resubmitted, ‘Failure Count’ increments by one.
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o “View Options” used to filter this data based on Event Action Status.

System Monitor

Haich Jos  Jobs  Services  Detabase Server Log Files

Event Actions
Vicw Options  ALL

View = Format= [ cre [ Dotoch z ]
Eveat Code Event
. EVENT TO PROCE.. PENDING_EVENT_ACTIONS
- ACTIONS

Action Parameters

Evert Action

(] Chose

View v Formatw  [B wwa [ Detach Wira "]
Event Actions:
Field Type | Reference Comments Values in LOV/ Default
Name Value
Entity A/N NA Entity Number on NA
Nbr which event generated
Event A/N Based on Event Event Definition NA
Code Setup Description
Event A/N Based on Event Event Criteria NA
Query Setup Definition Description
Event A/N Based on Event Event Action NA
Action Setup Description
Process | A/N Based on lookup | Online/Batch NA
Type EVENT_PROCE
SS_TYPE_CD
Failure Num | Based on Failure | Failure count gets NA
Count ber status updated after resubmit
Status A/N Based on new Event Action CRITERIA NOT MET
lookup Execution Status SUBMITTED
VOID
COMPLETED
FAILED
READY
ALL
WAITING FOR USER INPUT
Run Dt Date | NA Event Action NA
Generation Date Time
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Action Parameters:

Field Type | Reference Comments Values in LOV/
Name Default Value
Descript | A/IN Based on Event Event Action Parameter NA
ion Setup Description.
Value A/N Based on Event Event Action Input Parameter NA
Type Setup Type.
Value A/N NA This field is user enterable, if the NA
value type is USER INPUT.
Require | AIN Based on Event Used to determine if the Action NA
d Setup Parameter is mandatory.

A new screen ‘Pending Event Actions’ provided at ‘Customer Servicing’ that allows to
Submit/Void “WAITING FOR USER INPUT” transactions.

e Radio buttons ‘Waiting’, ‘Failed’ and ‘All' are used to display “WAITING FOR USER
INPUT”, ‘FAILED’, ‘VOID’ and ‘COMPLETED’ Event Actions.

e “POST” button enabled to submit “WAITING FOR USER INPUT” actions. A Ul validation
provided to check if all the “USER INPUT” and required fields entered before clicking on
‘Post’ button.

e ‘Status’ updated to “FAILED?" if there is any issues during execution of Event Action.

e On click of “VOID” button, system stops Event Action execution and updates the status of
Action to “VOID".

o ‘Edit' button allowed in Action parameters if the Event Action status is “WAITING FOR
USER INPUT". Only ‘USER INPUT’ parameters value fields are editable.

Pending Event Actions X T
Event Actions

Ve () 1 Mo L (]

P:-.-\.: B Voud

7 Ed o view | o it
Event Actions:
Field Type | Reference Comments Values in LOV/
Name Default Value
Entity A/N NA Entity Number on which event NA
Nbr generated
Event A/N Based on Event Event Definition Description NA
Code Setup
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Field Type | Reference Comments Values in LOV/

Name Default Value

Event A/N Based on Event Event Criteria Definition NA

Query Setup Description

Event A/N Based on Event Event Action Description NA

Action Setup

Status A/N Based on new Event Action Execution Status VOID

lookup COMPLETED

FAILED
WAITING FOR
USER INPUT

Run Dt Date | NA Event Action Generation Date NA

Time

Action Parameters:

Field Type | Reference Comments Values in LOV/
Name Default Value
Descript | A/N Based on Event Event Action Parameter NA

ion Setup Description.

Value A/N Based on Event Event Action Input Parameter NA

Type Setup Type.

Value A/N NA This field is user enterable, if the NA

value type is USER INPUT.

Require | A/N Based on Event Used to determine if the Action NA
d Setup Parameter is mandatory.

2.15.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.

2-64 ORACLE

Financial Services



2.16 Collateral Substitution

2.16.1 Overview

“Substitution” flag made as editable field in ‘Customer Service—>Collateral’ while adding from
User Interface.

2.16.2 Description

Existing Process:

In “Customer Service - Collateral”, addition from User Interface defaults the “Substitution” (read
only) flag and marks all the Assets linked to the account, changed to Substituted.

Updated Process:

e “Substitution” flag provided as editable field in “Customer Service > Collateral”.

e When a New collateral added with this “Substitution” flag as checked, all the other
existing collaterals, in the account, marked as “Substituted”.

e When a New collateral added with this “Substitution” flag as unchecked, all the other
existing collaterals in the account does not have any impact to the Asset Status.

Impact on Web Services:

e “Asset Create Service” enhanced to accept “Substituted” flag, when an Asset added to
account, same Ul behaviour followed.

e Based on the Flag
> IfYES, system adds new Asset and mark all the existing Assets as “Substituted”
> IfNO, system adds new Asset and not change in any existing Asset status.

Conversion Impact:

While converting the accounts from the legacy system, this flag handled manually, during account
on boarding. Value either Yes or No is expected to be passed at this time.

Impact on Existing Transactions:

e ‘Add New Asset’: When an asset is linked using transaction, old asset not Substituted
(This behaviour persists).

e ‘Substitution of Asset’: “ Asset Substitution Indicator” added as transaction parameter to
mark all other assets as substituted.
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> If parameter is set as “YES”, system adds new Asset and marks all the existing
Assets as substituted.

> If parameter is set as “NO”, System adds new Asset and not change any existing

Asset status.

\%

This transaction parameter is Mandatory and Default value is “YES”.

Customer Service x

Vehicle  Seller

Vehicle

View w Formatw  [5p e i Detach
Primary Description Status
Wy
Y 0 HONDA ACCORD  ACTIVE
»
Vehicle

Type & Description

* Asset Type
* Sub Type
* Registration #  UNDEFINED
Status ACTIVE

Summary || Collections | | Customer Service || Account Detalls

Asset Type Lien Status

VEHICLE LIEN SENT FOR P.

* Country  UNITED STATES
County
Address #

Address Line 1

LS Address Line 2
b4 Zip
= Zip Extn

City

Customer Detalls || Customer Preferences | | Transaction History

Lien Event Date

11/22/2019

Second Lien Holder Comments

[ save and Add

v

v

[ Close
Pt Modes | | Bankruptcy || RepofForeciosure || Deficency || Collateral || B > ~
g Add F Edit Vie it
Lien Release Entity  Entity Name
LIEN SENT FOR P. CUSTOMER LOAN SBL VEHIC ™
»
“
[l save and stay. || [ Save and Retum || GaReturn
* Start 0
* Base 0
* Bxtra |0
* Total [0
Custom Fields
*BEST FIELD  UNDEFINED
Hisar Mafined Field Char 10 TINDEFINED =

2.16.3 Seed Data

Refer ‘Appendix: Seed Data’
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2.17 Master Account Phase Il Enhancements

2.17.1 Overview

e Provided ability to update linked account with Master Account # when the “MASTER
ACCOUNT MAINTENANCE” posted at Associated Account.

e Enhanced “MASTER CUSTOMER/BUSINESS STATEMENT” to provide new Record
Types like BALANCE DETAILS, PAYMENT ALLOCATIONS and so on.

2.17.2 Description
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The following transaction parameter added to “MASTER ACCOUNT MAINTENANCE”

Transaction.
Parameter | Parameter | LOV Default | Displayed | Mandatory Comments
Name Type Values | Values | (Y/N) (Y/N)
Process VES This parameter used
. to decide whether to
Linked Lov NO NO Y Y update the Linked
Account
Account or Not.

e If the above Parameter is setto Y and MASTER ACCOUNT MAINTENANCE ACTION
TYPE = ADD, System adds Master Account # to Associated Account and its Linked
Account when the transaction is posted from Master Account or Linked Account or

Associated Account.

Comment posted in Linked Account saying <<MASTER ACCOUNT # <XXXXX>

ADDED>>

o If the above Parameter is setto Y and MASTER ACCOUNT MAINTENANCE ACTION
TYPE = UPDATE, system updates the new Master Account # to Associated Account and
its Linked Account when the transaction is posted from Master Account or Linked
Account or Associated Account.

Comment posted in Linked Account saying << MASTER ACCOUNT # UPDATED
FROM {OLD MASTER ACCOUNT #} TO {NEW MASTER ACCOUNT #} >>

If the “Process Master Associated Accounts = Y” then there is no significance of
above parameter, as this parameter processes all Associated Accounts (Assuming
Linked Account also one of the associated account of Master) of the Master Account.

o If the above Parameter is setto Y and MASTER ACCOUNT MAINTENANCE ACTION
TYPE = REMOVE, system removes Master Account # from Associated Account and its
Linked Account when the transaction is posted from Master Account or Linked Account or

Associated Account.

Comment posted in Linked Account saying <<MASTER ACCOUNT # <XXXXX>

REMOVED>>

If the “Process Master Associated Accounts = Y” then there is no significance of
above parameter, as this parameter process all the Associated Accounts (Assuming
Linked Account also one of the associated account of Master) of the Master Account.

e Following fields highlighted in excel are added to “MASTER CUSTOMER STATEMENT"
in respective Record Types.

Following Statement also consists of Account Balances.

Cus_Master_Statem

ent v11.xlsx
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https://docs.oracle.com/cd/F22291_01/pdf/refdocs/ofsll_release_notes_attachments/Customer_Master_Statement.xlsx
https://docs.oracle.com/cd/F22291_01/pdf/refdocs/ofsll_release_notes_attachments/Customer_Master_Statement.xlsx�

> Sample Customer/Business statement file.

=

Customer_Business
_statement.txt

e Following validation added to “DUE DATE CHANGE" and “DUE DATE CHANGE
OVERRIDE” transactions.

> If the “PROCESS MASTER ASSOCIATED ACCOUNTS = N” and Account level
“Statement Consolidation flag = Y, system does not allow to post the transaction and
shows an error message saying “ Transaction not allowed to post as Statement
Consolidationis Y ".

2.17.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.

2-68 ORACLE

Financial Services


https://docs.oracle.com/cd/F22291_01/pdf/refdocs/ofsll_release_notes_attachments/Customer_Business_statement.txt
https://docs.oracle.com/cd/F22291_01/pdf/refdocs/ofsll_release_notes_attachments/Customer_Business_statement.txt�

2.18 Master Account Rolled Up Summary

2.18.1 Overview

Provided the ability to display rolled-up balances at the Master Account level, which
includes Master Account and its Associated Accounts.

These Rolled-Up balances are display only.

Ability to send the Rolled-Up balances as a part of the Get Account details for the Master
Account and new “Master Account Rolledup Balance Details” web service.

2.18.2 Description
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A new “Summary” widget with following rolled-up details (Read only) added in Servicing >
Account(S) > Associated Accounts sub tab for Master Accounts and Customer Credit Limit >
Customer > Master Account > Associated Accounts table.

Total LC — display’'s sum of ‘LC’ (ACC_DUE_LATE_CHARGE_AMT) of Associated and
master account.

Total NSF - sum of ‘NSF' (ACC_DUE_NSF_AMT) of master account Associated
accounts.

Total Other Due — Sum of ‘Other Due’ (ACC_DUE_OTHER_AMT) of master account and
Associated accounts.

Total Due — ‘Total Due’ (ACC_DUE_TOTAL_AMT) of and master account and
Associated accounts.

Total Due (include Current Due) —sum of ‘Total Due (include Current Due)’ of Master
Account and Associated accounts.

Number of Active Accounts in Master and Associated Accounts
Number of Closed Accounts in Master and Associated Accounts
Number of Paid off Accounts in Master and Associated Accounts

The Existing “Total Delq Due and Total Payoff Quote Amount” fields are moved to Rolled-
Up Details widget.

The “Product Type” radio buttons added to filter the “Associated Account Details” table and
respectively show the Rolled-Up Details in “Summary” widget.

If user selects “LOAN” radio button, system filters the “LOAN" Accounts associated with
Master Account, which has same currency as Master in “Associated Accounts” table and
Rolled Up details shown for respective filtered accounts including Master if the Master
Account has a Product Type of LOAN.

If user selects “LINE” radio button, system filters the “LINE” Accounts associated with
Master Account, which has same currency as Master in “Associated Accounts” table and
Rolled Up details shown for respective filtered accounts including Master if the Master
Account has a Product Type of LINE.

If user selects “LEASE” radio button, system filters the “LEASE” Accounts associated
with Master Account, which has same currency as Master in “Associated Accounts” table
and Rolled Up details shown for respective filtered accounts including Master if the
Master Account has a Product Type of LEASE.

If user selects “ALL” radio button, system filters the “ALL” associated Accounts
irrespective of Product + Funding Type of Master Account, which has same currency as
Master in “Associated Accounts” table and Rolled Up details shown for respective filtered
accounts including Master Account.

Product Type radio button defaulted based on the Master Account Product Type.
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e “Statement Consolidation only” check box is added to filter the accounts which has
“Statement Consolidation flag = Y”.

»  This checkbox works in conjunction with selected Product Type radio button.

»  If this check box is checked, system filters the accounts having “Statement
Consolidation flag = Y”, respective rolled up dues and Account statistics in
conjunction with selected Product Type radio button shown at Summary widget.

> If this check box is unchecked, system filters all the accounts irrespective of
“Statement Consolidation flag”, respective rolled up dues and Account statistics in
conjunction with selected Product Type radio button shown at Summary widget.

e The “Show All" Check box renamed to “All Currencies” which shows the Associated
Accounts with all the currencies.

> When user selects this “All Currencies” check box, system shows associated
accounts with all the currencies. However, the “Summary” widget shows the Dues as
“0” and Account counts displayed.

Servicing >Customer Service>Associated Accounts

Customer Servies

Sewrch - Customer Service: HTR_BTIAP 02 | Fvew Reguest (Fendng: 5) | Queue dasgnmest

Account(s): MTR_BTIAP_07: DREW AKS ) e oF ot
e & Dt s O s vl

Associated Account Details
Pk | B | L5 e ] _— T
B Tide Pridect Cutranty g Cyrie Dl Dy

0l LE_BTIAP 0 DREW S UINE WITH CREDE . ARGENTINE PESO MONTRLY ws

lretdcston Cemarny

Sumemary

Servicing >Customer Credit Limit > Master Accounts

Assoclated ACcount Details

e Prateat [ —— o dmat AmesiDw | DeemDuedls e mTe dmesATE S mme Gy -
o ian e RN W LI T CREDE . RAGINTING P50 MONTHLY e 3 wen RS w1 AT 0BG oear s 155 NI PeAGE T = L ¥
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Web Service Changes:

e A new segment “MasterAccountRolledupSummary” added Get Account details service to
provide rolled up details at Master Account.

> The rolled up details are of all the associated accounts of Master Accounts including
Master Account.

Note: No filtering based on Product Type provided as part of service rolled up details.

e Anew “Master Account Rolledup Balance Details” web service created to provide the
rolled up details at Master Account with following filter options.

> Product Type
> Funding Type
> Statement Consolidation Indicator

Note: Please refer Swagger for more details on Web Services.

2.18.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.19 General Ledger Enhancement

2.19.1 Overview

Currently, the GL Header/Detail Segments are hardcoded. However, provided a configuration to
select the Header/Detail segments.

2.19.2 Description

e A new user define table “GL ATTRIBUTES” added to define the GL Header Segment
attributes and Details Segment attributes.

> A new “Attribute Name” LOV field added in Setup > General Ledger > Attribute
Definition to Define which value to be populated in Attributes.

Attribute Definitions

> This User defined table allows adding Account Parameters.
> This LOV populated from new User Defined table for Header Attributes (Only enabled

records).
e Attribute Name assigned for Header Attributes used as Criteria to Categorize the
Transactions
e Following hardcoded, Header Segments removed and configuration provided to select
the same.
# Segment Description
01 PRODUCT TYPE: Product Type
02 BACKDATED TXN Backdated Transaction
03 PRODUCT: Product Code
04 STATUS Account Status
05 NON-PERFORMING Account Non-performing Indicator

e Sample Data provided for Header Segment 1 to 5 with following fields in Setup> General
Ledger >Attribute Definitions > Segment Value

> Header Segment 01 with Segment Value: PRODUCT TYPE: Product Type

> Header Segment 02 with Segment Value: BACKDATED TXN: Backdated
Transaction

> Header Segment 03 with Segment Value: PRODUCT: Product Code
> Header Segment 04 with Segment Value: STATUS: Account Status

> Header Segment 05 with Segment Value: NON-PERFORMING: Account Non-
performing Indicator

e This LOV populates from new User Defined table for Detail Segments (Only enabled
records).
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e Once user selects a Detail Attribute Name for a Segment in Attribute Definition tab,
system will show the respective field values in General Ledger >Transaction Definition
>GL transactions >Segments >Debit/Credit Segment Combo LOV.

o “DERIVED VALUE” option added to All the Detail Segment LOV’s

e When Transactions are posted, they are posted with Detail Attribute Name value
configured in General Ledger >Transaction Definition >GL transactions >Segments
>Debit/Credit Segment.

e The following hardcoded Detail Segments removed.
> Segment 01:Account # - The natural account number in the GL for the transaction
> Segment 02:Branch Customer Branch
> Segment 03: Pool
> Segment 04: Sub unit

e The Sample Data for the Details Segments added from 1 to 4 with following fields in
Setup> General Ledger >Attribute Definitions > Segment Value

> Detail Segment 01 with Segment Value: Account # - The natural account number in
the GL for the transaction

> Detail Segment 02 with Segment Value: Branch Customer Branch
> Detail Segment 03 with Segment Value: Pool
> Detail Segment 04 with Segment Value: Sub unit
e The “Attribute Name” filed added as seed data in GL ATTRIBUTES Data file.
> This filed only accepts enabled parameters from new user defined table.
> This filed will update the “Attribute Name” filed in Setup> General Ledger >Attribute

Definitions.
ORACLE
Financial Services Lending and Leasing
Data Files M Do
Data File Definitions g acd || e || [ view || WP Audn
View = Format = = = Y
4

Record Dafinitions drand || S || [view || oF aum
B veww romatv | B & vetach : Y
P Typme Dusespicns Fcand Foumnat [ jeT—
1 FILE DETAILS RECORD VARIAN | I CAMSLAGE R TLEN ANGD LINE FEED
Column Definitions o naa || P | [ [ view | [ o mus

2.19.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.20 User Defined Parameters

2.20.1 Overview

In lending and leasing industry, there are multiple business specific calculations to be performed
on Account/Applications on day-to-day basis. This feature enables customers to store business
specific data, perform calculation on the fields and then show the result in the user interface.

2.20.2 Description

OFSLL supports adding custom/user defined fields at different entities like producers, accounts
etc. This enhancement will enable customers to populate business specific calculations into these
additional fields.

A new setup screen “User Defined Parameters” is added to define business specific calculations.
This screen allows customers to defined two types of calculation parameters.

Parameter | Description
Type

Formula Formula parameters are used for computation of the target parameters.

Parameters OFSLL product provides seed data of factory shipped formula parameters like

GL date, System Date etc.

Customer can also assign values of formula parameters by associating with
tables. For example ACC_DLQ_DAYS etc.

Formula parameter definitions ‘can be based’ on other formula parameters.

These parameters does not persist the calculation result into the table columns
of database.

These parameters does not have any selection criteria.

OFSLL supports predefined set of calculation based Formula Parameters. These
parameter definitions start with’ $’ in User Defined Tables. Detail list of formula
parameters is available below

These are based on User Defined Table Type: USER DEFINED: CUSTOMER
SERVICE FORMULA TYPE CODE

Target These parameters persist the calculation result into the table columns of
Parameters | database.

These calculations are based on formula parameters and other target
parameters.

A selection criteria is available for each calculation. If a target parameter
calculation falls into multiple criteria then system will throw an error during
calculation.

System throws an error during calculation, if any invalid expression or
mathematically incorrect formula is calculated.

These are based on User Defined Table Type: USER DEFINED: CUSTOMER
SERVICE TARGET TYPE CODE
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Predefined list of formula parameters are given below

Parameter

Description

$GL_DATE

Value of GL Date System Parameter

$SYSTEM_DATE

Current System Date

$COLLATERAL_VALUE

Sum of all collateral current valuation

$PRIMARY_COLLATERAL_VALUE

Sum of primary collateral current valuation

$ASE_GRAND_FATHER_POINTS

Sum of all grandfather points

$ASE_TIER_POINTS

Total Tier Points

$INTEREST_ACCRUED

Interest Accrued on Account for a specific date. This is
used to calculate Trade Equity Calculation.

If date is not provided, then it is calculated as per GL
date

$OUTSTANDING_AMOUNT

Current Account Outstanding Amount

$OUTSTANDING_BAL_ (BALANCE
TYPE *)

This is a dynamic balance value calculation based on
type variable.

For example

- SOUTSTANDING_BAL_ADV - Will calculate
outstanding Advance/Principal amount
- SOUTSTANDING_BAL_LSR - Will calculate
outstanding Lease Receivable amount

$PAID_BAL_(BALANCE TYPE *)

This is a dynamic balance value calculation based on
type variable

For example

- $PAID_BAL_ADV - Will calculate paid
Advance/Principal amount

- $PAID_BAL_LSR - Will calculate paid Lease
Receivable amount

$SUM_PRIN_ESC_MAX_EXPIRY_
DT

This is used to calculate sum of total principal amount
till Extended Service Warranty Max Expiry Date

$TOTAL_ITM_GRP_ (ITM GROUP*)

This is a dynamic itemization group value calculation
based on type variable.

For example

- $TOTAL_ITM_GRP_IDC - Will calculate total ITM
LOAN AMOUNT DOWN PAYMENT CASH group
amount

- $TOTAL_ITM_GRP_IPF - Will calculate total ITM
PREPAID FEE group amount
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Parameter Description

This is a dynamic itemization value calculation based
on type variable

For example

$TOTAL_ITM_ (ITM*) - $TOTAL_ITM_IDC_1 - Will calculate total ITM DOWN
PAYMENT amount

- $TOTAL_ITM_IUN_4 - Will calculate total ITM CASH
DOWN amount

Both formula and target parameters supports calculation for the following data types.

e Number /Integer: Used to represent integer and floating point numbers. System support
all arithmetic operators.

e Date: Supports Add and Minus arithmetic operators
e Character: Supports only Add operator and used to represent concatenation of Strings.

Note the following:

e To enable any target parameters, ensure that there is at the least one enabled Formula
Parameter and selection criteria defined.

e While defining target parameters, ensure that there is no circular dependency where two
or more parameters are either directly or indirectly dependent on each other.

e For example, if formula parameter A is defined as ACC_FIELD1 + formula parameter B
and formula parameter B is defined as ACC_FIELD2 + formula parameter A. In such a
case, system displays an error indicating ‘CIRCULAR DEPENDENCY DETECTED FOR
PARAMETER:<<PARAMETER NAME>>'.

e During update of Target Parameters, system looks into the enabled user defined
parameters, and considers only those accounts matching the selection criteria.

e Target Parameters can be updated using below:

Option Trigger Description
User Clicking ‘Calculate On every click, field values are computed
Interface Parameters’ button in and updated for an account.

Account Details screen,

Batch Job | On executing batch job On execution of scheduled batch job, all
USER DEFINED TARGET matching accounts as per the selection
PARAMETERS criteria are updated.

CALCUATOR in SET-CUP

batch job-set This will pick an account only once per

day.
Event Configured Event Action Used to update Target Parameters when
Type — UPDATE USER a specific event occurs in OFSLL.
DEFINED PARAMETERS.
Restful Calculate Parameter Update | Can be used by third-party application to
Web Service (available in update specific or all Target Parameters
Service common Swagger module) for a single Account.
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Customer Service = Account Details = Account Details

Account Details = Statements = Rate Schedule = Insurances = Condition Details = Securitization |~ Contract Information = Trade Details

Account Information Z Edit || [ view || & Audit
View = | Format E}" Freeze ;j' Detach Wrap E{ﬂ {gz} Calculate Parameters
Accrual Start Dt Last Accrual Dt Stop Accrual Accrual Method Base Method Rebate Method Accrued Interest Inde
11/12/2019 11/27/2019 N INTEREST BEARING ACTUAL/360 NONE 0 PRIMN &

»

Setup = Administration 2 System - User Defined Parameters

User Defined Parameters 38 Close
Parameters Sadd | FEd || [ view || o At
View = Format = g v [ Detach B Now Parameter (¥ Croste Copy [T Show Expression
& ACE_UDFZ3_NUM
Module Parameter Typse Parameter Name  Description Data typa Priarity Enabled

CUSTOMER SERVL.. TARGET PARAMETER ACC_UDF23_NUM - ADDITIONAL PLA.. NUMBER 1 N
ERV TARGET PARAMETER ACC_UDF23_NUM  ADDITIONAL PLA R

Formula Expression

Formula Definition  Solection Critoria

Fermula Definition e add | G Ear || ] View || o Audit
View = Format =[5 P i Detach Wre "]
o 5 Mathematical =
Seq ( Variable Constant Value o ] Enabled
(] TOTAL OF ALL PA.., ¥

e Use ‘Show Expression’ to view mathematical expression. This appears in the Formula
Expression section (in sequential order) in the Expression field.

e Use the ‘Create Copy’ feature to quickly create a new parameter with the existing
parameter details. User need to populate new Formula Definition Name during copying
existing Formula Parameter. This creates a new parameter in disabled state.

e A brief description of the fields is given below:

Field Description

Module Select the module from the drop-down list. The list is displayed based on the
modules that support User Defined Parameters calculation. Currently only
Customer Serving (accounts) is supported. This list will be extended in future
releases.

Parameter Select the type of parameter to be defined, either Target Parameter or Formula
Type Parameter from the drop-down list.

Parameter For Target Parameter, system displays the list of custom fields available in
Name user-defined table. Select the required Parameter from the drop-down list.

For Formula Parameter, this is a text field to record the new parameter name.
Specify the name of the formula parameter.

Description For Target Parameter, the description is auto-populated from user-defined table
and is Read-Only.

For Formula Parameter, specify the description of the formula parameter.

ORACLE

Financial Services



Field Description

Data Type For Target Parameter, the data type associated for the parameter is auto-
populated from user-defined table and is Read-Only.

For Formula Parameter, select the data type as one of the following from the
drop-down list — INTEGER/NUMBER, DATE

CHARACTER

Priority Specify the order in which system should evaluate the parameter definitions
while executing the batch job or on clicking ‘Calculate Parameters’ button.

For example, if a formula parameter A has dependency on parameter B, then B
has to calculated first in the order and priority is set as ‘0.

Enabled Check this box to enable the parameter definition.

Setup = Administration = System = User Defined Parameters = Formula Definition

e This section allows you to define a mathematical expression of the formula to evaluate
the parameter definition. The expression may consist of one or more sequenced entries.

e A brief description of the fields is given below:

Field Description

Seq Specify sequence numbers.

( Specify a left bracket, if you need to group part of your formula definition.
Variable Select the variable from the drop-down list which consists of a validated list

derived from user defined table type as indicated below:

For Number, system displays only numeric fields

For Date, system displays numeric and date fields

For String, system displays numeric and character fields

For Customer Service the list is derived from - USER DEFINED:

CUSTOMER SERVICE FORMULA PARAMETERS, which provides description
for the definition.

Constant Specify the constant value. Atleast one Variable or Constant is required per
Value definition.

For Number, system accepts only numeric fields
For Date, system accepts numeric fields

For String, system accepts humeric and character fields

Mathematical | Select the math operator to be used on the adjacent formula definition rows,
Operator from the drop-down list. The list displays all numeric operators (+,-,x and %)
however the support of mathematical operators depend on the on data type /
variable as indicated below:

For Number, system allows all numeric operators (+, -, X, and %).

For Date, system supports (+ and -) operators.

For String, system supports concatenation (i.e. +) operator.
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Field Description

) Specify a right bracket, if you are grouping part of your formula definition.

Enabled Check this box to enable the formula and indicate that it is included when

building a parameter definition

Setup = Administration 2 System 2> User Defined Parameters = Selection Criteria

Formuka Definition | Selection Criteria

Selection Criteria padd | A Ed || 5] view

oze [ Detach M @ checkCitena

Seq ( Parameter Comparison Operator Criteria Value 1 Logical Expression  Enabled
(1] ACCOUNT STATUS EQUAL ACTIVE *

o Audit

v Fomat+ | B
View Format =

e The sub tab is enabled only for Target Parameters and facilitates to define the selection
criteria indicating the type of accounts to be picked for computation.

e The parameters are derived from user defined table - Customer Service: USER
DEFINED: CUSTOMER SERVICE CRITERIA TYPE CODE

e A brief description of the fields is given below:

Field Description

Seq Specify sequence numbers.

( Specify left bracket.

Parameter Select the parameter from the drop-down list.

Comparison Operator

Select comparison operator from the drop-down list.

Criteria Value

Specify criteria value.

)

Specify right bracket.

Logical Expression

Select logical operator from the drop-down list.

Enabled

Check this box to enable the selection criteria.

Note: This solution is currently target to Account User Defined Parameters. This solution will be
extended to other tables in future releases.

2.20.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.21 Contract Maintenance Transaction

2.21.1 Overview

This feature enables customers to update Contract Information at the Account Level using a Non-
Monetary transaction. This transaction will update contract data that is populated during
origination process. System does not reschedule ongoing Account characteristic based on the
update.

2.21.2 Description

e By default, the contract information in Customer Service 2 Account Details 2>
Contract Information tab is populated from Origination screen after funding the
application and is a display only version of the same information found on the Funding
- Contract screen.

e Anew ‘ACCOUNT CONTRACT MAINTENANCE' non-monetary is added to update
below Contract Parameters.

Txn Parameter Account Columns Ul Fields
AMOUNT FINANCED ACC_AMT_FINANCED Amt Financed
DISBURSED LOAN AMOUNT ACC_LOAN_AMT -NA-

TOTAL DOWN PAYMENT ACC_TOTAL_DOWN_PMT_AMT | Down Pmt
AMOUNT

TOTAL SALES PRICE ACC_TOTAL_SALE_PRC Total Sale Price
APPLICATION CHANNEL ACC_APP_SOURCE_CD -NA-

CONTRACT DATE ACC_CONTRACT_DT Contract Dt
CONTRACT RCVD DATE ACC_CONTRACT_RCVD_DT Contract Recvd Dt
CONTRACT VERIFIED BY ACC_CONTRACT_VERIFY_BY Contract Verified By
CONTRACT VERIFIED DATE ACC_CONTRACT_VERIFY_DT Contract Verify Dt

e On posting of this transaction,
> System does not restructure Account based on the Account fields updated.
> System allows posting this transaction on All Product Type, Status and Conditions.

> System only updates parameter values entered by user. System does not update any
values left blank during posting of the transaction.

2.21.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.22 Vacation Ownership Asset Billing Enhancements

2.22.1 Overview

This enhancement covers the following Vacation Ownership functionalities of Master Account and

Associated Accounts.

e Collateral Changes [Origination, Servicing/Collections, Collateral Management]

e Asset Billing Rate Setup

e Asset Billing Rate Setup Upload file (Create and Update)

o Billing batch job related changes

e Linked Account Changes

e Add Balance Non-Monetary TXN to Account

e Consolidation of Points

e Pro-ration of TXN amount

2.22.2 Description
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1. Following new Lookup’s added:

Lookup Name

Lookup Value

Club Name UNDEFINED
Phase Number UNDEFINED
Building UNDEFINED
Site of Inventory UNDEFINED
Room/Unit Type UNDEFINED
Unit UNDEFINED
Week UNDEFINED
Resort Identifier UNDEFINED
Association Id UNDEFINED
FULL
Usage Type EVEN
ODD
Other Attribute 1 UNDEFINED
Other Attribute 2 UNDEFINED
Other Attribute 3 UNDEFINED
Other Attribute 4 UNDEFINED
Other Attribute 5 UNDEFINED
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2. Anew sub tab “Vacation Ownership” with below fields added in following screens only for

Collateral Type = HOME.

e Origination > Collateral > Home; (Next to Tracking)

e Servicing/Collections > Collateral > Home; (Next to Tracking)

e Servicing > Collateral Management >Collateral Details (Collateral Type = HOME) (Next to

Tracking)

> This tab allows only one record.

> Edit, View and Audit buttons are available.

. . Default | Mandato

Field Name Field Type Values | ry(Y/N) Comments

Club Name New LOV NA N

Points Number NA N
If the selected Asset Usage
Type Sub Code is FULL, this
field populated with total
Points, which are available in

- . “Points” field.

Billing Points Number NA N
If the selected Asset Usage
Type Sub Code is HALF, this
field populated with
“Points/2”, which are
available in “Points” field.

First Year Proration Check Box | N N

Phase Number New LOV NA N

Building New LOV NA N

Room/Unit Type New LOV NA N

Unit New LOV NA N

Week New LOV NA N

Usage Start Date Date NA N

Signature Grand Father Check Box | NA N

Plus Membership Type Check Box | NA N

PR Marking Check Box | NA N

Club Indicator Check Box | NA N

Resort Identifier New LOV NA N

Association Id New LOV NA N
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Field Name Field Type \?Zlfl?;g xll?ija;to Comments
New LOV Seed Data:

FULL (Sub Code: FULL)
Sub Code:

Usage Type FULL N FULL: Populate Full points in
Billing Points field
HALF: Populate Half points in
Billing Points field

Site of Inventory New LOV NA N

Expiration Date of Asset Date NA N

Asset Travel Date Date NA N

Membership 1 Opt Check Box | NA N

Membership 2 Opt Check Box | NA N

Membership 3 Opt Check Box | NA N

Membership 4 Opt Check Box | NA N

Membership 5 Opt Check Box | NA N

Other Attribute 1 New LOV NA N

Other Attribute 2 New LOV NA N

Other Attribute 3 New LOV NA N

Other Attribute 4 New LOV NA N

Other Attribute 5 New LOV NA N

Other Attribute 6 Date NA N

Other Attribute 7 Date NA N

Other Attribute 8 Date NA N

Other Attribute 9 Date NA N

Other Attribute 10 Date NA N
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e Above fields are added to:
> Collateral (GET/PUT/POST) Web Service.
> Create and Update Collateral Upload files.
» APl Process
» Account Onboarding
>  Application Entry (GET/PUT/POST) Web Services.

e A new user defined table added for Vacation Ownership Tracking Attributes only for
Home Collateral.

e A new tracking attribute block added under Collateral >Collateral (Home) >Vacation
Ownership Details table in Origination and Servicing\Collections.
> This table has Edit, Audit button.

> These attributes are loaded when user loads the tracking attributes from Collateral
>Collateral (Home) >Tracking
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e The below fields added to following screens:
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» Origination > Collateral > Home table
>  Servicing > Collateral > Home table
>  Servicing > Collateral Management >Collateral Details >HOME table.

Default | Mandatory

Values | (Y/N) CollEIC

Field Name | Field Type

Indicates the asset considered for

Billing Check Box N Y billing or not.
Due Amt New LOV - o .
Current This field specifies where this asset
Account . Current | Y . o
Type Linked Account considered for billing.
Master Account

Consolidate This flag represents weather to

Points at Check Box N Y consolidate the points at Master

Master Account or not

Trade This filed used to decide whether to

Eligible Check Box Y Y keep the Asset Status ACTIVE or
INACTIVE as part of Trade Process.
This field used to identify the assets
at associated accounts to

. consolidate the points at Master

Points Account.

Consolidatio | LOV NONE | N

n Type Associated Account Assets, which
has same Points Consolidated Type
as Master Account, will be
consolidated

F e [l Y

Censn
Code
155 SITEPMASE D N HOME VACATIOR_OWAIE  HOA OCCURIED BY CW | LINCEFINED GUETOMER moa

Pristary Description Asset Class Ascet Type Sub Type Gecugancy Lien Status Lign EversDate  Second Lien Molder Comments Lien Asleate Dntity  Entty lame Identficsson ®

Homwe

[ save and sty || () Gave and Retun | GaBetum

Tvne & Descrintion

e The above fields are added to:
> Collateral (GET/PUT/POST) Web Service.
> Create and Update Collateral Upload files.
» APl Process
» Account Onboarding
> Application Entry (GET/PUT/POST) Web Services.

e When billing flag is checked and Due Amt Account Type = Current Account, billing
batch job posts the transactions based on Asset Billing Rate setup in Current account.
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e When billing flag is checked and Due Amt Account Type = Linked Account, billing batch
job posts the transactions based on Asset Billing Rate setup in Linked Account of current
Account.

* When billing flag is checked and Due Amt Account Type = Master Account, billing batch
job posts the transactions based on Asset Billing Rate setup in Master Account of current
Account.

Note:

e |f the Due Amt Account Type configured as “Linked Account” at Master Account, it has no
significance since Master Account do not have any Linked Account.

e User should provide required asset parameters to qualify for the Asset based billing.

Points Consolidation:

When “Consolidate Points at Master” flag is “Y”, system consolidates points at Master Account of
the associated accounts, where the “Points Consolidation Type” is same as associated account
“Points Consolidation Type”.

e Anew “STATUS POINT CONSOLIDATION CODES” look up added to define which
Accounts with which status considered for point’s consolidation.

> Apart from account status, system only considers the Asset with “ACTIVE” status and
Expiry Date Greater than the GL Date for point’s consolidation.

> This point’s consolidation happens in following scenarios.
- New account added under a Master Account. (Ul Funding process, API,

Onboarding, Master Account Maintenance Transaction and Multi Account
onboarding).

- Account Status Change

-  Current Account Level Asset maintenance.
Collateral POST/PUT/GET Web Services
Collateral Create/Update File upload
Collateral Maintenance from Ul
Add New Asset Transaction
Substitution of asset Transaction

e Anew batch job (SET-ASE: ASEPRC_BJ 100 01) is added to update the consolidated

points at Master Account level asset, if the Actual Asset at associated account “Expiration
Date of Asset” is less than the GL date.

e This batch job expected to run before the billing batch job to update the consolidated
points, which considered for Billing at Master Account.
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Example:

Point’'s Maintenance expected at actual asset at Associated Account, any
changes done at Master account asset points will not flow down to the Actual
Asset at Associated Account.

If there is an update happens at Master Account level Asset Point's and
subsequently any change in actual asset at Associated Account, system
recalculates the points and override the points at master account.

Example:

Consolidated points at Master Account = 1000 which are result of two accounts
with 700 points and 300 points.

If user changes the points at Master Account from 1000 to 1200

Subsequently if there is update in any one of the Associated account from 700 to
800, the total points shown at the Master Account > Asset: 800+300 = 1100 (not
1200).

Master Account:

If Master Account level points are “0” Maser Account M1>Asset M

Billing | Consolidate Points Points Points at Master
at Master Consolidation Type | Account
Y N P1 1000+700+500 = 2200

Associated Accounts:

Account 1> Asset 1

Master Billing Consolidate Points Consolidation | Points at Current
Account # Points at Master | Type Account
M1 N Y P1 1000

Account 2> Asset 2
Master Billing Consolidate Points Consolidation | Points at Current
Account # Points at Master | Type Account
M1 N Y P1 700

Account 2> Asset 3
Master Billing Consolidate Points Consolidation | Points at Current
Account # Points at Master | Type Account
M1 N Y P1 500

Note: Points Consolidation is only applicable to Actual Points not for Billing Points.

Linked Account field addition in Origination and Servicing/Collections:

1. Anew “Linked Account” field is added in Origination >Master Account tab.
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Field Field | Default Mandator Comments
Name Type | Values y(Y/N)
This field displays the Accounts associated
with Customers added as an applicants and
the Link to Existing Customer flag = Y.
This field exclude the accounts which are
Linked UNDEFINE already associated with other Accounts i.e.
account | OV | b N already linked to some other account
This field exclude Accounts with Master
Account flag = .
This field shows the look up values as
Customer ID — Title — Account #.
origination x e
ot Agp = Suby Uit Status g“l"r‘a’wm Froducer Neme :If:";f‘ GOt ieting Customer '_'_’I“'f'lf:_tf, Contact Sedes Agent e
aijor/2018 0000001235 UNDEFINED APPROVED - BANK  DECISIONED MI-00001 ; GRAN... (618)-975-6345 ¥ h 4 DEMOSLER AL
Summary  Applcand  Regquest | Decdslon Corracl . Master Account  Coriments | Trackg  Document Verllation  Corvespondence
Master Account Details
view = Forat > B i petac U]
Master Account _“‘:'I'_l'u‘”'“ Lirked Accoust Baymant Hierarchy
| NPEFINED UNDEFINED
Master Account Details
Il Save end stey || Save and Return || GaRetum
: 8|

e Above fields are added to

>

Queue Parameters
Criteria based Condition Parameters

e Above fields are added in following processes.

>

API Process
Account Onboarding

e Including regular origination edits, following API/Account Onboarding edits are added.

>
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An Edit added to validate if the Account # provided in “Linked Account” field is invalid.

Edit Name

Default Type | Enabled

Invalid Account # provided in Linked Account field | Error N

An API edit added to validate if the Account # provided in “Linked Account” field is
belongs to customers added as a applicants and the Link to Existing Customer flag =
Y.

Edit Name Default Type Enabled
Current and Linked Account # should
Error N
have at least one common customer
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e Once the application funded with “Linked Account” field with a valid account #, system
updates that account # in Linked Account field of newly created Account and newly
created account # updated in Linked Account.

» Ex: if the Application (Account 1) funding with Account 2 as Linked Account
After Funding
Account 1: Linked Account = Account 2
Account 2: Linked Account = Account 1
e Added the following Contract Edits.

> The following Contract Edit added to ensure Billing Cycle and Due day of current
application should be same as the Linked Account Billing Cycle and Due Day.

Edit Name Default Type | Enabled

Current and Linked Account # should have

same Billing Cycle and Due Day Warning N

- If the current application billing cycle and due day is not matching with Linked
Account, system fires the - “Billing Cycle and Due day are not matching with
Linked Account” edit.

- If current application is linked to existing Linked Account and product is has
“Same billing cycle flag = Y” system does not validate the billing cycle and due
day based on same billing cycle flag, the precedence is given to Linked Account
Billing cycle and Due day.

> The following Contract Edit added to ensure Product/Funding Type of current
application is same as the Linked Account Product Type if the current application is
going be Associated with Linked Account.

Edit Name Default Type | Enabled

Product and Funding type does not match

with Linked Account Warning N

- If the current application Product/Funding Type is not matching with Linked
Account, system fires the “Product and Funding type does not match with Linked
Account” edit.

> An Edit added to validate if Current Application and Linked Account belongs to same

Company.
Edit Name Default Type | Enabled
Current and Linked Account should belong
Error N
to same Company
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“LinkedAccountXrefNumber” element added in Account Onboarding Service under
“ApplicationData” parent element to accept Linked Account Xref number if the Master
Associated Accounts created using single payload.

Following validations provided as part of Account Onboarding Service
- If aninvalid Linked Account Xref Number provided, system shows an error

message “Invalid Linked Account XREF Number

<<LINKED_XREF_NUMBER>>".

- If an Associated Account is already has a Linked Account Number, system
shows an error message Linked Number <<LINKED_XREF_NUMBER>> already
linked to other account.

- If the provided Account is a Master Account, system shows an error message
“Master Account Number <<LINKED XREF_NUMBER>> cannot be linked”.

The “Linked Account” filed added in Servicing\Collection >Account Details tab.

. Field Default Mandator
Field Name Type | Values V(Y/N) Comments
Linked Read |\ N Propagated from Origination
Account Only Added using Transaction.

Above field are added to:

- Queue Parameters
- Criteria based Condition Parameters

A new “Linked Account Maintenance” non-monetary transaction provided to add
the Linked Account field.

Descr | Gr | Actio | Mo | Syste | En | Tx | Statem | B | Man | Statem | G
iption |0 |n net | m abl | n/B | ent a |ual |ent L
u ary | Defin | ed |al TXn t Print

p ed Ty | Type c
Yes/N pe h
0
Linked | Ac | POS | N No N NO | NONE N Y N N
Accou |co | T NE
nt un
Maint | ts
enanc
e
Following are the Transaction parameters.
Paramet | Param | LOV Defau | Displ | Mand | Comments
er Name | eter Values It ayed | atory(
Type Value | (Y/N) | Y/N)
S
Date Date NA Syste |Y Y Transaction posted
m date
Date
Maintena | LOV ADD ADD Y Y To decide whether to
nce Type ADD/UPDATE/REMO
UPDATE VE a Lined Account
REMOVE
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Paramet | Param | LOV Defau | Displ | Mand | Comments
er Name | eter Values It ayed | atory(
Type Value | (Y/N) | Y/N)

Linked Text NA NA Y Y Account # to which
Account Box this account is going
# to link.

If the Account # invalid
show an error
message << Invalid
Linked Account # >>

If user provides
Master Account #,
system will not allow to
post this transaction
and shows an error
message <<Provide
Linked Account # is a
Master Account>>

Validate Check NA Y Y Y This field is to define
Common | Box whether the common
Custome customer between the
r account and Linked
Account validated or
not.

If the Parameter = Y
and if there is no
common customer
between Account and
Linked Account,
system shows an error
message “No
Common
customer/business
found” and not allowed
to post the transaction.

If this parameter = N
and if there are no
Common Customer
exists between
Account and Linked
Account still system
allowed to post
transaction.

Validate Check | NA Y Y Y This field is to define
Same Box whether the same
Billing Billing Cycle and Due
Cycle Day between the

and Due Account and Linked
Day Account validated or
not.
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Paramet
er Name

Param
eter

Type

LOV
Values

Defau
It
Value

Displ
ayed
(YIN)

Mand
atory(
Y/IN)

Comments

If the Parameter =Y
and if the Billing Cycle
and Due Day of the
Account is different
from Linked Account
Billing Cycle and Due
Day, system should
shows an error
message “Billing Cycle
and Due day are not
matching with Linked
Account” and not
allowed to post the
transaction.

If this parameter = N
and if the Billing Cycle
and Due Day is
different still system
allowed to post the
transaction.

Validate
Same
Company

Check
Box

NA

This field is to define
whether the Linked
Account provided in
transaction
parameters and the
Account where this
transaction posted
belongs to same
Company or not.

If the Parameter set to
Y, system validates if
the Linked Account
and Account where
this transaction are
belongs different
company and show an
error message saying,
“Current and Linked
Account should belong
to the same
Company”.

If the Parameter set to
N, system will not
validate if the
company is same or
different.

Reason

LOV

NA

NA

Reason code for
posting this
transaction.
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Paramet | Param | LOV Defau | Displ | Mand | Comments
er Name | eter Values It ayed | atory(
Type Value | (Y/N) | Y/N)
S
Commen | Text NA NA Y N Provide if any related
t Box comments

> If the above transaction posted successfully with Maintenance Type = ADD, system
updates the Linked Account filed of Source Account with Account # provided in
Transaction parameters. Similarly, the Source Account # updated in Linked Account
# filed of Account # provided in transaction parameter.

- Ex: if the transaction posted in Associated Account 1 with Account 2 as Linked
Account

After successfully posting of transaction

Account 1: Linked Account = Account 2

In addition, Account 2: Linked Account = Account 1
» For Maintenance Type = ADD

- If the Current Account or Linked Account is already associated with other
Account, system errors out the transaction and show an error message
“Current/Linked Account is already associated with another Linked Account” and
does not allow to post the transaction.

- When transaction posted successfully, system posts the comment in Current and
Linked Account.

<< Linked Account is Added <Account #> >>
> For Maintenance Type = UPDATE

- When transaction posted successfully, system posts the comment Current and
Linked Account.

<< Linked Account is Updated <Account #> >>
> For Maintenance Type = Remove

- If the Linked Account # field is UNDEFINED in transaction posted account,
system shows an error message <<No Linked Account Exists>> and not allowed
to post the transaction

- Ignore the Linked Account #, Validate Common Customer, “Validate Same Billing
Cycle and Due Day” and Validate Same Company while posting the transaction
with this Maintenance Type.

- When transaction posted successfully, system posts the comment Current and
Linked Account.

<< Linked Account is Removed <Account #> >>

Asset Billing Rate tab in Setup:

An Asset Billing Rate Tab added in Setup > Products, next to the Fees menu.

e The following header and details table added at Asset Billing Rate tab.
> Asset Billing Rate Definition
> Asset Billing Rate Details

e Following fields added to Asset Billing Rate Definition table.
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> Add, Edit, View and Audit buttons are available and access controlled.

Field Name _Fr;e;c; LOV 5:{32? )l\//é?(r/\s)ator Comments
Y Once the record saved system
Name Text Box NA | NA makes this field read only.
This field is unique.

Description Text Box NA | NA Y
Enabled Check I na | N Y

Box
Selection Criteria
Company LOV ALL Y
Branch LOV ALL Y
Product LOV ALL Y
State LOV ALL Y
Channel LOV ALL Y
Asset Type LOV ALL Y
Asset Sub Type LOV ALL Y
Club Name LOV ALL Y
Phase Number LOV ALL Y
Building LOV ALL Y
Room/Unit Type | LOV ALL Y
Unit LOV ALL Y
Week LOV ALL Y
Signature Grand | Check N Y
Father Box
Plus Membership | Check N Y
Type Box
PR Marking EQECK N Y
Club Indicator Check N Y

Box
Resort Identifier LOV ALL Y
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Field Default | Mandator

Field Name Type LOV values | y(Y/N) Comments
Association Id LOV ALL Y
Usage Type LOV ALL Y
Site of Inventory | LOV ALL Y
Min Points Number 0.00 Y
Max Points Number 0.00 Y

Additional Attributes

Membership 1 Check N Y
Opt Box
Membership 2 Check N Y
Opt Box
Membership 3 Check N Y
Opt Box
Membership 4 Check N Y
Opt Box
Membership 5 Check N Y
Opt Box
Other Attribute 1 | LOV ALL Y
Other Attribute 2 | LOV ALL Y
Other Attribute 3 | LOV ALL Y
Other Attribute 4 | LOV ALL Y
Other Attribute 5 | LOV ALL Y
. 12/31/4 | Y
Other Attribute 6 | Date 000
Other Attribute 7 Date 12/31/4 |'Y
000
Other Attribute 8 Date 12/31/4 | Y
000
Other Attribute 9 Date 12/31/4 | Y
000
Other Attribute 10 12/31/4 | Y
Date
000
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Setup> Products > Asset Billing Rate

Asset Billing Rate Definition|

e Following field added to Asset Billing Rate Details table.
> Add, Edit, View and Audit buttons are available and access controlled.

Asset Billing Rate Definition

Default Mandatory

Values (Y/N) Cmimis

Field Name Field Type LOV

Start Date Date Sys Date | Y Start Date of Record

This LOV shows the
Transaction LOV NA Y Transactions where the
Transaction code = “FOTH%”

Add a new LOV with following
values.

Flat Amt
FLAT

Calc Method New LOV AMOUN | Y Rate
T Flat Amt + Rate

Tiered Rate

Slab Formula

Amount field

Render only when Calc
Method is equal to

Flat Amt
Flat Amt + Rate

Flat Amt Number 0.00 Y

Slab based Formula

Rate field

Rate Number 0.00 Y Render only when Calc
Method is equal to
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Rate
Flat + Rate

This LOV have following
values which represents
provided Rate and Flat Amt
of which frequency.

Frequency New LOV Monthly Y MONTHLY
QUARTERLY
SEMI ANNUALLY
ANNUALLY

% of Calc Amt | Number 100.00 v This filed available for all

Calculation Methods.

This field not allowed “0”
value.

Render only when Calc
Method is equal to

Base Points Number 1 Y Slab based Formula
Rate

Flat Amt + Rate
Tiered Rate

This slab points used for Calc
Method “Slab based
Formula”.

Slab Points Number 0.00 Y Render only when Calc

Method is equal to

Slab Formula

This % increase is used for
Calc Method “Slab Formula”.

% Increase Number 0.00 Y Render only when Calc
Method is equal to

Slab Formula

If user use this field to
Min Amt Number 0.00 Y configure a min cap for the
resulted transaction Amt.

If user use this field to
Max Amt Number 0.00 Y configure a max cap for the
resulted transaction Amt.

This indicates the Rate

Billing Year Number NA Y belongs which billing year.

2-97 ORACLE

Financial Services



Billing Year stamped in billing
amount txns (mainly FOTH%
txns) Description.

Enabled

Check Box

N

Y

Enabled indicator

e Once the record added, user able to only enable or disable the record in Edit mode and
rest of the details read only.

Setup> products >Asset Billing Rate > Asset Billing Rate Details:
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Multiple Billing Asset Rate Indicator:

A “Multiple Billing Asset Rate” Indicator added in following screens:

Field Field Default | Mandatory
Name Type — Values | (Y/N) (el
“Indicates whether multiple asset rates are
applicable for one billing period or not.
Multiole Billing period is considered from current due
up date to the next due date. Multiple rates are
Billing Check
N Y fetched only when rate end date (rate start
Asset Box
Rate date + rate frequency) ends one or more
cycle(s) before the next due date i.e. current
rate record does not cover the entire billing
period.”

e Setup> Contract > Billing

e Origination >Contract > Billing
e Servicing >Contract > Billing
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Coatract x

Contract Definition

T e T

Bate Con & Adjustments

uuuuuuu

Billing Batch job changes:

Billing batch job is enhanced to do the following process:

Following process done before the due calculation.

Pick the Vacation Ownership parameters from Servicing >Account >Collateral (Home) >
Vacation Ownership tab.

> For an Asset If the selected Usage Type sub code is “FULL", system consider the
Full points for rate derivation and “Billing points” field considered for Transaction
Amount calculation.

> For an Asset If the selected Usage Type sub code is “HALF”, system considers
“Billing Points = Actual points/2” field for Transaction Amount calculation but rate
derived using full points.

> If the “First Year Proration” flag is Y then the rate derived using full points, but the
actual transaction amount calculated based on prorated points not on full points.
> The prorated points calculated based on Asset “Usage Start Date”.

> If the usage start date year is equal to first due year, then system prorate the points
based on following formula.

First Due Date = 01/01/2018
Usage Start Date = 01/10/2018
Prorated Points = Actual Points * (13-1)/12= Actual Points *1
If the Usage Start Date = 03/10/2018
Prorated Points = Actual Points * (13-3)/12= Actual Points*10/12
> If the usage start date year is before the due date year, batch job consider the full
points for transaction amount calculation no proration required.

Match the Collateral Vacation Ownership parameter with “Asset Billing Rate” setup with
best match and system check the “Multiple Billing Asset Rate” indicator at Account
Details >Contract >Billing level to decide whether multiple asset rates are applicable for
one billing period or not.

> Ifthe “Multiple Billing Asset Rate is set to N”, System picks the latest rate which is
less than or equal to DUE DATE. In this case, only one best match record fetched to
arrive at Transaction Amount and no multiple asset rates are applicable for one billing
period.

> If the “Multiple Billing Asset Rate is set to Y”.
- System fetches multiple rates only when rate end date (rate start date + rate

frequency) ends one or more cycle(s) before the next due date i.e. current rate
record does not cover the entire billing period.”

- Even though “Multiple Billing Asset Rate” is set to Y but if there is no
applicable rate available for the Due period beyond the Rate End date, system
will apply the same rate which is picked for Due Period Less than or Equal to
Due End Date.

Post the matched transactions at account level based on calculation method.
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» Asset Billing Rate Details related fields stamped on the transaction posted for the
calculated amount.

- Asset Id (Assets)

- Asset Rate Id (Asset Billing Rate Definition)

- Asset Rate Details Id (Asset Billing Rate Details)
- Rate Start Date (Asset Billing Rate Details)

- Rate Frequency (Asset Billing Rate Details)

- Calculation Method (Asset Billing Rate Details)
- Rate (Asset Billing Rate Details)

In case of Tiered Rate, Effective Rate is stamped.
Ex: Effective Rate Calculation

0-500 points — rate 2.5 per point,

501-1000 — rate 4.5 per point,

1001-9999 - rate 6 per point.

Let us say there are 2000 Billing points.
Calculated Amt = 500*2.5 + 500*4.5 + 1000*6 = 9500.
Effective rate = 9500/2000 = 4.75 per point

- Base Points (Asset Billing Rate Details)

- Slab Points (Asset Billing Rate Detalils)

- % Increase (Asset Billing Rate Details)

- Billing Year (Asset Billing Rate Detalils)

Validations:

If the respective balance for transaction is missing, batch job fails the transaction posting
and show the error failure message <<"Account #: Transaction posting failed Balance not
available”™> in Batch > Request Results block and not allowed to process the account
due amount calculation.

If the transaction posting failed because of access grid configuration or product
configuration at transaction codes, batch job shows an error message << Account #:
Transaction posting failed <Reason> >> and not allowed to process the account due
amount calculation.

If the Resulted transaction amount is less than Min Amount defined, batch job takes the
Min amount and post the transaction.

If the Resulted transaction amount is greater than Max Amount defined, batch job takes
the Max amount and post the transaction.

Calculation Methods:

Flat Amount:

If the selected transaction has a Calculation method as “Flat Amount”, billing batch job post the
transaction with amount in Flat Amt field.

If the Frequency = Annual and Billing Cycle = Monthly
» Transaction Amount = (Flat Amt/12)

If the Frequency = Monthly and Billing Cycle = Annual
> Transaction Amount = (Flat Amt*12)

If the Frequency = Annual and Billing Cycle = Quarterly
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» Transaction Amount = (Flat Amt/4)

e If the Frequency = Quarterly and Billing Cycle = Annual
» Transaction Amount = (Flat Amt*4)

e If the Frequency = Annual and Billing Cycle = Semi Annual
» Transaction Amount = (Flat Amt/2)

e If the Frequency = Semi Annual and Billing Cycle = Annual
» Transaction Amount = (Flat Amt*2)

e |If the Frequency = Annual and Billing Cycle = Annual
» Transaction Amount = (Flat Amt /1)

e If the Frequency = Annual and Billing Cycle = Annual
> Transaction Amount = (Flat Amt *1)

Note: For other combination of Frequency and Billing cycle above calculation taken as reference.

Rate:

If the selected transaction has a calculation method as “Rate”, billing batch job calculate the
transaction amount using below formula.

e If the Frequency = Annual and Billing Cycle = Monthly

» Transaction Amount = (Rate/12)*(Billing Points at collateral / Base Points)
e |If the Frequency = Monthly and Billing Cycle = Annual

» Transaction Amount = (Rate*12)*( Billing Points at collateral / Base Points)
e If the Frequency = Annual and Billing Cycle = Quarterly

» Transaction Amount = (Rate/4)*( Billing Points at collateral / Base Points)
e If the Frequency = Quarterly and Billing Cycle = Annual

» Transaction Amount = (Rate*4)*( Billing Points at collateral / Base Points)
e If the Frequency = Annual and Billing Cycle = Semi Annual

» Transaction Amount = (Rate/2)*( Billing Points at collateral / Base Points)
e If the Frequency = Semi Annual and Billing Cycle = Annual

» Transaction Amount = (Rate*2)*( Billing Points at collateral / Base Points)
e If the Frequency = Annual and Billing Cycle = Annual

» Transaction Amount = (Rate/1)*( Billing Points at collateral / Base Points)
e |If the Frequency = Annual and Billing Cycle = Annual

» Transaction Amount = (Rate*1)*( Billing Points at collateral / Base Points)

Note: For other combination of Rate Frequency and Billing cycle above calculation taken as
reference.

Flat Amt + Rate:

If the selected transaction has a calculation method as “Flat Amt + Rate”, billing batch job
calculate the transaction amount using below formula.

Transaction Amount = Flat Amt + Rate * (Billing Points at Collateral/Base Points)
Note: Rate adjusted based on Frequency and Billing Cycle as mention in “Rate” Method.

Tiered Rate:

Added new “Tiered Rate” sub table below the Asset Rate Billing Definition table.
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e This tab enabled only if the transaction calculation method selected as “Tiered Rate”.
> Once the record added, user can only be able to enable/disable the record on edit.

Rest of the fields are read-only.

Following fields are available in this table.

Field . Default | Mandatory
Name Field Type LOV values (Y/N) Comments
Points Text field Points from where the

NA | O Y . ; .
From (Number) respective rate is applicable
Rate Text field NA | 000 v Rate for defined points

(Number) range

Enabled | Check Box NA N Y Enabled Indicator

If the selected transaction calculation method is “Tiered Rate”, system selects the
Asset Billing Rate Details record using Actual Points at Asset and other asset
parameters and calculate the transaction amount deriving the rate from Tiered Rate
table.

Transaction Amount = (Tiered Rate)*(Tiered Points / Base Points)

Note: If the range not maintained for any points the same result in “0” rate and the
Transaction Amount becomes “0”. Ex: Actual Points are 8000 and Setup
Maintained Points From = 10000 Rate = 0.55 and Base Points = 1, in this case
the transaction amount results into “(0*(8000/1) =0)

Ex: For first million points, rate to be considered is 0.66 with Base Points =1000.
For Remaining points, rate to be considered is 0.60 with Base Points = 1000.

If CLUB Asset has 1.5 million points, then Transaction Amount would be = 1million *
(0.66/1000) + 0.5 million * (0.6/1000) = 660 + 300 = 960.

Note: Rate adjusted based on Frequency and Billing Cycle as mention in “Rate”
Method.

Slab Formula:

If the selected transaction calculation method is “Slab Formula”, batch job calculate the
transaction amount using below formula.

Transaction Amount = [Flat Amt] + Ceil[\{Actual Points - Base Points)/Slab
Points}*\{%Increase / 100)*Flat Amt}]]

Ex: Transaction Amount = [491.32+ [{(61000-5000)/2500}*{(30.4/100)*491.32}]]

= [491.32+ [Ceil {22.4}*{149.36}]]
= [491.32+3435.28]

Transaction Amount = 3926.6

Create and Update Asset Billing Rate setup upload files provided.

¢ Following is the file format and sample upload file.

@ &

Rate_Upload.xlsx Asset_billing_rate_s

etup txt

e Abatch job “IJARPRC_BJ 100 _01" under SET-IFP added to process the Create/Upload
Asset Billing Rate setup records.

e Name of the record is the unique identifier to update the records in Asset Billing Rate
Definition Header and Details table.
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> System allows to add the Tiered Rate Details Only when the Calc Method = “Tiered
Rate”.

> If the Tiered Rate Details provided for Calculation Methods other than “Tiered Rate”,
system errors out the record and put the record in bad file Error message << Tiered
Rate Details are not required for Calc Method {Method}>>

e In case of existing details record, user can only Enable/Disable the record and rest of the
details are non-updatable.

e User can add a new details record, in this case, all the fields will be mandatory and
default values are applicable.

e Apart from Name in Header in Asset Billing Rate Definition, rest of the fields are non-
mandatory and only when the user provides, system updates that respective field and
rest of the field should be As Is.

o If the provided name of the record not matching, batch job errors out the record and put
the record in bad file with error message << Record not found >>.

Common Validations:

e Values provided in fields, which are of lookup type validated with lookup code. If the code
is not matching, batch job errors out the records and put them in bad file with error
message <<Lookup value not matching>>.

* Negative values are not be accepted in case of number fields.
e Base Point’s field not allow negative, “0” and decimal values.

Non-Monetary transaction to a Balance at Account level:

A new non-monetary transaction provided to add a balance to an Account.

Financial Services

Descrip | Gro | Act | Mon Sys'tem Ena | Txn/Bal | Statement | Bat | Man | Stateme | G
tion u ion | etar e bled | Type Txn Type ch | ual nt Print L
p Y | Yes/No yp yp
Add
Acc
Balance | ot | PO Iy No N | NONE | NONE N [y [N
to an ST
S
Account
Following transaction parameters are available:
Parameter Paramet Default Displaye | Mandato
Name er Type — Values d (Y/N) ry(Y/N) CemimETE
System Transaction
Date Date NA Date Y Y posted date
Balance Type | LOV EXN—TYPE—C NA Y Y
Charge off LOV CHARGEOFF_ | CHGOFF v v
Method METHOD_CD | BALANCE
Write-off WRITEOFF_M
Method LOV ETHOD_CD WAIVE Y Y
ORACLE
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Parameter Paramet LoV Default Displaye | Mandato Comments
Name er Type Values d (Y/N) ry(Y/N)
Reschedule LOV RESCHEDULE SOLLOVE v v
Method _METHOD_CD BALANCE

Sort Number NA NA Y Y
Billed LOV YES_NO_CD NO Y Y
Accrued LOV YES_NO_CD NO Y Y

Non

Performing LOV YES _NO_CD NO Y Y
Rollover

Non NON_PERFOR

Performing LOV M_TXN_TYPE | NONE Y Y
Balance Type _CD

Enabled LOV YES_NO_CD YES Y Y

If the balance type already loaded, system shows an error message in Result <<Balance

already available>> and not allowed to post the transaction.

If the product type not configured for the balance type at Transaction Codes setup,
system shows an error message in transaction result << Balance Type not mapped to
Product type>>. (follow similar validation of Contract Balances)

Provided Balance Type validated with LOV value codes of TXN_TYPE_CD and if the
code not matches then, system shows an error <<Balance Type Doesn’t Exist >>.

Mock Statement for Master Account:

A new “Statement” is added section before “Other” section and the following fields added
to Setup >Contract [LOAN/LINE/LEASE] >Statement section.

The Statement preference mode field moved under Statement section.

Field Field LoV Default
Name Type | Values values Mandatory(Y/N) Comments
Mock Check This field decides if this account
Statemen Y/N N Y is included in Mock statement
Box )
tReq Generation or Not
Enabled only Mock Statement
Mock Mandatory Only Req=Y
New January to hen * K o ]
Start LoV | December | AN when “Moc | Field indicate what is the start
Month Statement Req = Y" | month of Mock Statements
period.
Mock Mandatory Only
Statemen | LOV 1to 12 when “Mock Egab_le\((j only Mock Statement
t Cycles Statement Req = Y” 9=
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Field Field LoV Default

Name Type | Values values Mandatory(Y/N) Comments
This field used to specify how
many numbers of billings to
generate, post Mock Statement
Start Date.

Mock P Enabled only Mock Statement

oC re Rea=Y

Statemen Numb 0.00 N q

t Days er Pre statement days for Mock
Statements generation.

e These fields propagated to Origination Contract when user selects the respective
instrument.

* A new Statement Section added before the “Others” section and the following contract
parameters added in Origination >Contract > Statement section.

e The Statement preference mode field moved under Statement section.

Field Field LoV Default

Name Type | Values values Mandatory(Y/N) Comments

Mock Check This field decides if this

Statement Box Y/N N Y account is included in Mock

Req statement Generation or Not
Enabled only Mock

Mock Mandatory Only Statement Req = Y

New January to hen * K o )

Start LOV | December | 9AN when “Moc | Field indicate what is the
Statements period.
Enabled only Mock
Statement Req =Y

Mock Mandatory Only o )

Statement | LOV | 1to 12 when “Mock This field used to specify

Cycles Statement Req = Y” | how many numbers of
billings to generate, post
Mock Statement Start Date.
Enabled only Mock

Mock Pre Statement Req =Y

Numb

Statement | 0.00 N Pre Statement Days for

Days Mock Statements
generation.

Above fields available only when Master Account flag = Y in Origination > Master Account tab.

e |If the Flag is unchecked, system refreshes the fields and makes them as Read-Only.

e As part of the API/Funding/Onboarding, the Mock Run date next will be set up based on
following logic.
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Ex: if the Contract date = 6/1/2018
First Payment Date = 7/1/2018
Mock Start Month = January
Mock Start Date = 1/1/2019 (Derived based on Start Month)
Mock Pre Statement days = 60
Mock Statement Run Date Next = 1/1/2019 — 60 days = 11/2/2018

> Validation: If the resulted Mock Statement Run date next < Contract Date or GL
Date, The Mock Start Date is moved to next year same month.

Ex: if the Contract date = 6/1/2018
First Payment Date = 7/1/2018
Mock Start Month = July
Mock Start Date = 7/1/2018 (Derived based on Start Month)
Mock Pre Statement days = 60

Mock Statement Run Date Next = 7/1/2018 — 60 days = 5/2/2018 which is Less than
Contract Date then:

Mock Statement Start Date will be 7/1/2019
Mock Statement Run Date Next = 7/1/2019 — 60 days = 5/2/2019

e A new “Statement” section added after the “Others” section and the following fields added
at Servicing > Account Details > Contract Information > Statement section.

> The Statement Consolidation and Statement Preference Mode fields moved under
Statement section.

> The respective fields propagated from origination will be update in Servicing
>Account Details >Contract Information >Statement section.

Field Name Field Type | LOV \?glfl?lejg (l\<|{m;iatory Comments
Month | Readonly form Onginaior
hsﬂtgggrserit Days Read Only E)rﬁﬁ %Jﬁgtjier?ation

e A new “Statement” section added after the “Others” section and the following fields added
at Servicing >Account Details >Statement Section.

> The Statement Consolidation and Stmt preference mode fields moved under
Statement Section.

> The respective fields propagated from origination will be update in Servicing
>Account Details >Contract Information >Statement section.

. Field Default | Mandato
Field Name Type LOV Values | ry(Y/N) Comments
Mock Read Propagated form Origination
Statement onl and can be updated using
Req y Maintenance Transaction
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. Field Default | Mandato
Field Name Type LOV Values | ry(Y/N) Comments
Mock S
Statement Read Propagated form Ongmaﬂon
and can be updated using
Run Date Only : :
Maintenance Transaction
Next
Mock Read Propagated form Origination
Statement onl and can be updated using
Cycle y Maintenance Transaction
Mock Pre Read Propagated form Origination
Statement onl and can be updated using
Days y Maintenance Transaction
> Provided a new non-monetary Mock Statement Details Maintenance Transaction.
Descri | Gro | Act Ao || s ) (B Txn/Ba ST Bat | Man Sl G
tion y ion etar | Defined | abl | Tvoe ent Txn ch | ual ment L
P P y Yes/No | ed yp Type Print
Mock
Statem
ent Acc PO
Details gunt ST N No N NONE NONE N Y N N
Mainte
nance
> Following are the Transaction parameters.
Paramete | Paramet | LOV Default | Displaye | Mandato Comments
r Name er Type Values | Values | d (Y/N) ry(Y/N)
Date Date NA System v v Transaction posted
Date date
Mock YES
Statement | LOV NO Y Y '\Rﬂgctiitgtg?qsgg
Req Ind NO q
Mock Statement Start
Mock Date
Statement | LOV Y N Mandatory Only when
Date Mock Statement Req
Indicator = “YES”.
Mock Statement cycle
which is used to find
Mock out the End Month
Statement | LOV 1to 12 Y N
Cycles Mandatory Only when
Mock Statement Req
Indicator = “YES”.
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Pre Statement days
for Generating the

Mock Pre Mock Statement.
Statement Text Box NA Y N
Days (Number) Mandatory Only when

Mock Statement Req
Indicator = “YES".

e This transaction allowed to post only from Master Account.

e Mock Statement Start date, Mock Statement Cycle and Mock Pre Statement Days cannot
be NULL When Mock Statement Required IND is YES.

e |f the Account has Mock Statement Req Indicator = “YES”, if user wants to update Mock
Statement Req Indicator = “NO” using this transaction, system refreshes the “Mock
Statement Date”, Mock Statement Cycles” and Mock Pre Statement Days to NULL.

A new batch job added to generate Mock Statements based on Mock Statement Details.

e This batch job only picks the account that has “Mock Statement Req = Y” and Master
Account Flag = Y.

e Batch job runs on Mock Statement Run Date Next and generates the number of dues
based on Mock Statement Cycles.

e Batch job mocks the billing batch job operations and generate the statements for future
dues of Master and Associated Accounts.

e Following is the format for Mock Statement for Master Account.
Mock Statement
v11.xIsx

e Sample file — Master Account Customer Mock Statement

&

Master_Account_Cu
stomer_Mock_Stater

Columa Definitions
e = Pt

2.22.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.23 Associated Accounts View

2.23.1 Overview

This requirement provides ability to view all Associated Accounts of a Master Account from
Associated and Master Account in customer servicing.

2.23.2 Description

An “Associated Accounts” radio button added in Customer Servicing >Account (s) table next to
Group follow-up radio button.

e Default Value of the Radio button is “N”.

e [If useris in a Master Account and selects this radio button, system shows Associated
Accounts of the master account in Account(s) table including master account.

> If no Associated Accounts exists for a Master Account then system shows only
Master Account record in Account(s) table.

e |If the user is in an Associated Account and selects this radio button, system shows the
Accounts Associated with Master Account of the current account - which should include
Master Account as well.

» If current is not associated with any master account then system shows only current
account record.

> If the Current Account is, the only Associated Account of its Master Account then
system shows Current Account and Master Account records in the Account (s) table.

Ex: if A1 has M1 as Master Account
M1 also has A2 and A3 as associated Accounts

> Ifuserisin M1 and Select this radio button, System shows M1, Al, A2 and A3
Accounts in Customer Servicing >Account(s) table.
> Ifuserisin Al account and selects this radio button, System shows A1, M1, A2 and
A3 Accounts.
- If user selects M1 record from Account (s) table, system loads the M1 account
details in respective sub tabs.

e By selecting individual account record from Account(s) table, system loads the respective
detail in all the servicing >Account tabs. (Similar to “Show All” radio button functionality).

Hm

e The existing “Statement Consolidation” field added to Customer Servicing >Account (s)
table (right most corner).

8 a

2-109 ORACLE

Financial Services



e The “Statement Consolidation” and “Linked Account” fields added to Associated
Accounts Sub tab in Customer Servicing >Account (S) (right most corner).

2.23.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.24 Tiered Calculation

2.24.1 Overview

In points based Vacation Ownership Industry, Tiers used to classify memberships into different
levels based on total points at Master Accounts. Each level of membership offers more perks
than the level before it like different billing rates or servicing care levels etc. This requirement
enhances OFSLL to support Tier Calculation at Master Account.

2.24.2 Description

Two new fields Resale Indicator(Y/N) and Grand Father Points (Number) added in Collateral
Management > Home > Vacation Ownership, Origination > Collateral > Home > Vacation
Ownership and Servicing > Collateral > Home to calculate Total Tier and Grand Father Points at
Master Account.

Field Type | Default | Comments Reference
Name Values

Resale Chec | N On disabling this checkbox system considers Asset | NA
Indicator | kbox Billing Points and Grand Father Points for Formula

Parameters TOTAL TIER POINTS and TOTAL
GRAND FATHER POINTS

Grand Num | O The system considers these points for Formula NA
Father ber Parameter calculation of TOTAL GRAND FATHER
Points POINTS

Two new Customer Service = Formula Parameters added to calculate Total Tier Points and
Total Grand Father Points. The logic of calculation is given below:

TOTAL TIER POINTS:

e For given Account number, system picks-up all associated accounts. If given account
number is not master account then system uses the master account number that given
account to pick up all associated accounts.

e For selected Accounts, sum the total “Billing Points” for all the Assets where Resale
Indicator =N, “Expiration Date of Asset” > GL Date, Asset Status should be ACTIVE and
Account status should be maintained in “STATUS POINT CONSOLIDATION CODES”
lookup.

TOTAL GRAND FATHER POINTS:

e For given Account number, system picks-up all associated accounts. If given account
number is not master account then system uses the master account number that given
account to pick up all associated accounts.

e For selected Accounts, sum the total “Grand Father Points” for all the Assets where
Resale Indicator =N, “Expiration Date of Asset” > GL Date, Asset Status should be
ACTIVE and Account status should be maintained in “STATUS POINT
CONSOLIDATION CODES” lookup.

2.24.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.25 Trade

2.25.1 Overview

In case of Vacation ownership industry, it is common for a customer to go for the Exchange of the
Timeshare or Vacation Plan within or another club. This process of exchanging existing timeshare
with a new one is called as Trade. This enhancement is used to support trading of existing

account with a new account within a same company.

This functionality supports below features of trading of Account:

Trade Enquiry
Trade

Trade Fix
Rescission
Cancellation

2.25.2 Description

Trade Flow:

2-112

Below is the high-level process flow used to depict trade flow in OFSLL

c
5 Start dentify Account(s) | ) ot contract Equity Equity > [ QR > —
= to be Traded Available?
©
.S
80 Rollback
= Unhandled errors in
o 74)% processing 1), 2) and 3) [| Muti Account Creation
> And Txn Posting
£ Place Trade Request
o3 with Multi Account/ 21
° Trade Transaction 2]
=t
= Posting
=
|
Validate Equity?
v Yes No
POST Trade Enquiry i i
€ Transaction — Yy
S
9 1) POST
& POST Trade Txns been)
=} Trade Txn wil fail MANUAL Rbgate/account | |
< Trade Fix Status to TRADED
3
UPDATE UPDATE
o POST New Condition
Equity OUT with i
e ty o EQUITY MISMATCH ErRiyjoUT with
quity Transfer O RING TRADE Equity Transfer
Amount Amount
v v v v
UPDATE UPDATE
Create new Account i
Equity IN with NO UPDATE i
o Rty of Old Equity Transfer on Equity IN Ly wilh
5 Account 24 quity Equity Transfer
g Amount Amount
o
s}
5 i Update Trade detail
i Update Trade details Update Trade details pdate Trade details

entry status as
COMPLETED

entry status as FAILED

entry status as
COMPLETED

[

Trading of Accounts involves transfer of owner Trade Equity from an existing Account to
a new Account. This calculation differs based on implementation need. OFSLL facilitates
configuration of this formula using user defined parameters for target field

ACC_EQUITY_AMT.
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e Equity transferred on old account is called as “Equity Out”. Equity received on new
account is called as “Equity In”.

e When customer decides to Trade his existing account for a new account, Agent can use
Third-party Origination System/OFSLL Customer Service Screen to post a Trade Enquiry
transaction to calculate old account Trade Equity.

Once customer agrees to perform trade based on the trade equity available and terms and
conditions of the new account then system provides below facilities to perform trade

e Agent creates a new account by providing Trade Equity of Account in itemization. This
process can be done using Account on boarding or OFSLL origination system.

e Post Add Trade Details transaction to list the Trade Equity that needs to be transferred
from old account to the new account. These details will be visible in Account Details =
Trade Details.

e Post the Trade Transaction, system calculates Trade Equity available on the account for
a given transaction date.
Trade Equity matched:

» This case occurs when Sum of Equity provided in new account itemization = Sum of
Equity Details provided in Traded Details Table = Sum of Equity available on the old
Account.

>  System automatically posts “EQUITY OUT TRANSFER” on old account, “EQUITY IN
TRANSFER” on the new Account and update Trade Equity on old and new account.

»  Status of Trade Details entries updated as COMPLETED.

> If there is no Trade Equity available on the old account after transferring equity then
system updates status of the Account as TRADED.

> For traded accounts system also posts adjust minus transaction for all the available
balances indicating no due available on the account.

Trade Equity is mismatched:

> If Trade Equity of the new account itemization does not match with Trade details or
available Trade Equity on old account then system considers the case as trade
mismatch.

>  “EQUITY MISMATCH DURING TRADE” condition posted on the old Account.
>  “EQUITY MISMATCH?" transaction posted instead of TRADE transaction.

» Trade transaction posted.

>  Status of Trade Details entries updated as FAILED.

» Tofix this traded system supports the below:

“UPDATE TRADE DETAILS” transaction used to update Trade Details Equity
Transfer Amount.

- Manual “TRADE FIX” transaction posted to transfer the Equity Transfer Amount.
- Status of Trade Details entries updated to COMPLETED.

- If there is no Trade Equity available on the old account after transferring equity
then system updates status of the Account of TRADED.

- For traded accounts system also posts adjust minus transaction for all the
available balances indicating no due available on the account.

Trade Enhancements:

Below enhancements are added in OFSLL to support trading of Accounts.

Account on-boarding:

e TradeDetails block is added in Account on boarding service to populate Trade Equity
Details while boarding of new account.
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e OFSLL supports posting Generic Post Transactions during boarding of new Account.
This can be on new account or on a different account.

e There is a single commit for transactions and on-boarding process i.e. if there is any
issue with Account on-boarding or generic post transaction then system rolls-back entire
transaction and will not board new account or post transaction.

Itemizations:
e A new set of itemization groups are created to record Equity In and Rollover Interest.

> ITM INCOMMING EQUITY [IEQ]
> ITM ROLLOVER INTEREST [IRI]

Balance:

e In case of Vacation Ownership industry customer can pay agreed down payment in
multiple tranches. To record this OFSLL is enhanced to add a new balance type called
“DOWN PAYMENT". This is currently available for LOAN/LEASE Product types and will
be enhanced for LINE in future releases.

> If Down Payment balance is available on the Account then existing
ACC_TOTAL_DOWN_PMT_AMT value will be populated into open balance.

> ACC_TOTAL_DOWN_PMT_AMT_PD value will be populated into paid balance. This
field is only available in Account on-boarding WS.

e Anew flag “Track Down Payment Balance” is added in Setup = Contract.

> Ifthe flag value is Y, system validates if “DOWN PAYMENT” balance is loaded. Error
message “DOWN PAYMENT BALANCE NOT LOADED?” displayed if not loaded.

> If flag values is N, system does not validate “DOWN PAYMENT” balance.

puted Interest Delinguency

* Late Charge Grace 10

Rebate

Payment Caps

jalances = Amortized Balances | Ttemizations | Fees

Trade Details:

A new tab Trade Details is added in Customer Service = Account Details = Traded Details to
record Trade Equity and Equity Details Transferred.
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ASSO_ABHI_INT_0012

Summary | Collections = Customer Service | Account Details | Customer Details = Customer Preferences = Transaction History | Pmt Modes = Bankr > ¥

Account Details | Statements = Rate Schedule | Insurances = Condition Details = Securitization | Contract Information | Trade Details
Trade Details =l view || o Audit
View v Format E:‘ Freeze aj' Detach Wrap Qﬁ}
Trade . . . . Current Qu
Equity Equity In Equity Out RevRec Equity Target RevRec Equity Ind
1,333.19 700.00 0.00 1,150.00 1,876.70 N =
»
Equity Transfer Details (5] view || & Audit
View ~ Format v [ Freeze ,ﬁ' Detach Wrap @(’] Show All
From Account # To Account # Equity Transferred

ASSO_ABHI_INT_0013 700.00

Field Name

Comments

Trade Equity

Used to store current Account Trade Equity
This is a calculated field and Read-only.
New field ACC_EQUITY_AMT

Equity In Used to store sum of all Equity transferred from different old Accounts
contributing to trade
Updated using Equity In Transfer Transaction. This filed is also Read
only.
New field ACC_EQUITY_IN_AMT

Equity Out Used to store sum of all Equity transferred to different new Accounts as

part to trade

Updated using Equity Out Transfer Transaction. This filed is also Read
only.

New field ACC_EQUITY_OUT_AMT

Trade Transfer Details

From Account #

Trade old Account Number

To Account #

Trade new Account Number

Equity Transferred Used to store Equity transferred Account as part to trade
Trade Type Trade Type LOV selected during trade transaction posting
Status Used to store status of the trade “OPEN/COMPLETED/FAILED”

ADD TRADE DETAILS

TRANSACTION:

e Anew “ADD TRADE DETAILS” Non-Monetary transaction is created to add entries into
Trade Details Table.

e This Transaction posted on the Source Account.
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e Source and destination account entries should be available to process the transaction
successfully.

e Below comment will be posted on account on successful posting on transaction

e “TRADE DETAILS ADDED ON <DATE> WITH TO <ACCOUNT NBR>, TRADE
AMOUNT <VALUE>, TRADE TYPE AS <TRADE TYPE> AND <COMMENT>"

Describtion Gro | Actio | Monet | Txn/Bal | Statement | Bat | Manu | Stateme | G
P up n ary Type Txn Type | ch al nt Print L
ADD TRADE
DETAILS TRD | POST | N N N N Y N N
Parameter code Sort Required | LOV
TXN DATE 1 Y NA
AMOUNT 2 Y NA
ACCOUNT NBR 3 Y NA
UPGRADE
SPLIT
TRADE TYPE 4 Y COMBINE
COMMENT 5 Y NA

UPDATE TRADE DETAILS TRANSACTION:

e Anew “UPDATE TRADE DETAILS” Non-Monetary transaction is created to update
entries into Trade Details Table.

e This Transaction also posted on the Source Account.

e Source and destination account entries should be available in OPEN/FAILED status to
process the transaction successfully.

e Below comment will be posted on account on successful posting on transaction

e “TRADE DETAILS UPDATED ON <DATE>WITH TO <ACCOUNT NBR>, TRADE
AMOUNT <VALUE>, TRADE TYPE AS <TRADE TYPE> AND <COMMENT>"

Description | Group | Acti | Monet | Txn/Ba | Statement | Bat | Manu | Statem | GL
on ary | Type | Txn Type ch al ent
Print
UDPATE TRD PO | N N N N Y N N
TRADE ST
DETAILS
Parameter code Sort Required | LOV
TXN DATE 1 Y NA
ORACLE
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Parameter code Sort Required | LOV
AMOUNT 2 Y NA
ACCOUNT NBR 3 Y NA
UPGRADE
SPLIT
TRADE TYPE 4 Y COMBINE
COMMENT 5 Y NA

TRADE ENQUIRY TRANSACTION:

e A new TRADE ENQUIRY monetary transaction is created to determine Trade Equity of
an account for a specific valid up to date.

e This transaction result is based on target parameter configuration define for
ACC_EQUITY_AMT.

e On successful posting of the transaction system will post an Account comment
“ACCOUNT TRADE EQUITY PROVIDED TO FOR AMOUNT USD <AMOUNT> VALID
UPTO <DATE>"

e Valid up to date cannot be backdated before any of the below transactions
> Payment
> Trade
> Trade Fix

e This transaction result is categorized into three sections

Section 1:

Displays set of predefined values
ACCOUNT NUMBER = <Account Number>
MASTER ACCOUNT NUMBER = <Master Account Number>
ACCOUNT CURRENCY = <Account Currency>

Example
ACCOUNT NUMBER = 20010002982
MASTER ACCOUNT NUMBER = 20010002992
ACCOUNT CURRENCY = USD

Section 2:
Display results based on configuration
<UDP FORMULA VARIABLE DESCRITION> = <VALUE>
Example
TOTAL OF EQUITY IN ITEMIZATION GROUP = USD 2000
DOWN PAYMENT PAID BALANCE = USD 3500
ADVANCE PRINCIPAL PAID BALANCE = USD 3205
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Section 3:

Display results based on configuration
<UDP ACC_EQUITY_AMT DESCRITION> = <VALUE>

Example

ACCOUNT TRADE EQUITY = USD 8600
**rxx Transaction Posting Successful **x+*

Complete Output:
ACCOUNT NUMBER = 20010002982

MASTER ACCOUNT NUMBER = 20010002992
ACCOUNT CURRENCY =USD

TOTAL OF EQUITY IN ITEMIZATION GROUP = USD 2000

DOWN PAYMENT PAID BALANCE = USD 3500

ADVANCE PRINCIPAL PAID BALANCE = USD 3205

ACCOUNT TRADE EQUITY = USD 8600
*rrex Transaction Posting Successful **x+*

TRADE TRANSACTION:

Descriptio | Gro | Acti | Mone | Txn/Bal | Statement Bat | Man | Statemen | G
n up on tary Type Txn Type ch ual t Print L
TRADE TR | PO

ENQUIRY | Q ST Y NONE NONE N Y N N
Parameter code Sort | Required

TXN DATE 1 Y

TRADE ENQUIRY VALID UPTO DATE |2 Y

TRADE ENQUIRY LTR PRINT 3 Y

COMMENT 4 Y

Trade transaction is used to transfer Trade Equity from old Account to new Account. Different
types of trade [Upgrade, Split and Combine] are illustrated in the example below.
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ACC1

SHO From Account

To Account|Equity Transfer

Jury

ACCL

ACC2 10000

ACC2 - Upgrace

SHG From Account

1|ACCL

2|ACC2

3|ACC2

ACC3- Split

SMO [From Account |To Account|Equity Transter
1|ACC2 ACC3 13000
2|ACC3 ACCS 13000

To Account|Equity Transfer
ACC2 10000
ACC3 13000
ACCH 17000
ACC4 - Split

SMO From Account |To Account|Equity Transfer

1|ACC2 ACCY 17000

2|ACCH ACCS 17000

ACCS - Combine

SMO From Account

-

ACC3

ha

ACCH

To Account|Equity Transfer
ACCS 13000
ACCE 17000

e This transaction will be posted on old account once the trade details are populated using
Add/Update Trade Details transaction or Account on-boarding.

e OFSLL categorize accounts as Equity and Non-Equity based accounts for Trade

processing.

> Equity Accounts: Accounts with equity greater than zero. For e.g. Associated

account.

> Non- Equity Accounts: Accounts with equity less than or equal to zero. For e.g.

Master and Linked accounts

e On successful posting of trade, system performs below on old and new accounts.

Old Account — Traded

New Account Created

Account Status will be updated as Traded

Automatic EQUITY IN TRANSFER transaction is
posted

Equity details are updated in Customer Service - Traded Details and are marked as

“Completed”

Below comment will be posted

“ACCOUNT TRADED ON <DATE>WITH
TOTAL TRADE EQUITY <VALUE> AND
<COMMENT>"

Below comment will be posted

“ACCOUNT EQUITY IN RECEIVED ON <DATE>
FROM ACCOUNT NUMBER <ACCOUNT
NUMBER> WITH VALUE <VALUE>, <TRADE
TYPE> AND <COMMENT>"

Account Equity out field will be decreased
with value provided in “AMOUNT” field in
Customer Service->Trade Details

Account Equity In field will be increased with
value provided in “AMOUNT” field in Customer
Service->Trade Details

If Trade Eligible flag is set to = Y, Asset
status will be updated to “IN ACTIVE” or
else will status will continue to be
“ACTIVE".
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Old Account — Traded

New Account Created

All user posted conditions will remain on
Traded Account. System defined condition
like DELQ will be remove as there will not
be any outstanding on the account.

System will report one last Metro-1l on
Traded Account as PAID OFF

Future Billing and ACH processing is
stopped

Adjustment minus transaction will be
posted for all open balances on traded
Account to mark the outstanding amount
as zero

System automatically post EQUITY OUT
TRANSFER transaction

System automatically post EQUITY IN
TRANSFER transaction

If “PROCESS MASTER ACCOUNT" is
YES, then corresponding Master Account
will be posted with automatic TRADE
transaction.

If “PROCESS LINKED ACCOUNT" is YES,
then corresponding Linked Accounts will
be posted with automatic TRADE
transaction.

o Below validations are performed on E

quity and Non-Equity Account.

Equity Accounts

Non-Equity Accounts

If Customer Service->Trade Details are not
available, system validates and display
error message “No Data found for Trade”

System will validate and display error messages
of Accounts if there is any outstanding balance
exist

System validates trade details equity
amount to be transferred and displays
error message “Trade Transaction amount
cannot be greater than account Trade
Equity”

If a non-Equity account is a Master account and
it has multiple Linked and Associated Accounts
with status not in [TRADED, VOID and Account
Close Indicator =N] then will validate and throw
an error message “Invalid status for Associated
Accounts”.

Account involved in Trade should belong to
same company

If a non-Equity account is a Linked account, then
system will validate Account if associated
account status is TRADED. During this process,
system will throw an error message “Invalid
status for Associated Accounts”.

Old Account and New Account should
belong to same Product Type and Funding

Type
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Equity Accounts

Non-Equity Accounts

If VALIDATE COMMON CUSTOMER =Y
then system should validate and throw
error message “At least one customer
should be common between the old and
the new account”

System validates if Sum of Equity In
itemization of new Accounts # Sum of
Trade Equity of Old Accounts # Sum of
Equity Transfer Amount in Trade Details,
then System will post “EQUITY
MISMATCH DURING TRADE” condition
on this Account and also posts TRADE
MISMATCH TRANSACTION instead of
TRADE Transaction.

Common Validations

System validates and display error message “Backdating of transaction is allowed for date after
<<<Max Date>>> if the transaction is posted backdated before any of the below transactions:

Payment
Trade
Trade Fix

System validates and does not allow to post transaction on account with status =Traded

Descrip | Gro | Acti | Monet | Txn/Bal Statement Bat | Man | Statement | G
tion up on ary Type Txn Type ch ual Print L
TRADE | TRD .I;OS Y N N N Y N N
Parameter code Sort | Required | LOV

TXN DATE 1 Y NA

PROCESS MASTER ACCOUNT 2 Y YES, NO

PROCESS LINKED ACCOUNT 3 Y YES, NO

VALIDATE COMMON CUSTOMER | 4 Y YES, NO

COMMENT 5 Y NA

TRADE FIX TRANSACTION:

e This transaction is similar to Trade transaction and should be posted if the trade is failed.

ORACLE

Financial Services



e Validations and process flow of Trade Fix is similar to trade but it will check “EQUITY
MISMATCH DURING TRADE" condition is posted on old Account before posting this

transaction.
Descrip | Gro | Acti | Monet | Txn/Bal Statement Bat | Man | Statement | G
tion up on ary Type Txn Type ch ual Print L
-II;E(ADE TRD .IP_OS Y N N N Y N N
Parameter code Sort | Required | LOV
TXN DATE 1 Y NA
PROCESS MASTER ACCOUNT 2 Y YES, NO
PROCESS LINKED ACCOUNT 3 Y YES, NO
VALIDATE COMMON CUSTOMER | 4 Y YES, NO
TRADE FIX REASON 5 Y HINKED ACCOUNT

EQUITY MIS MATCH

COMMENT 6 Y NA

TRADE MISMATCH TRANSACTION:

e This transaction will be posted automatically by OFSLL when trade transaction is failed
due to Equity miss match.

Descrintion Gro | Acti | Mone | Txn/Bal | Statement Bat | Man | Statemen | G
P up on tary Type Txn Type ch ual t Print L

TRADE TR | PO

MISMATCH | D ST Y N N N N N N

Parameter code Sort | Required | LOV

TXN DATE 1 Y NA

PROCESS MASTER ACCOUNT 2 Y YES, NO

PROCESS LINKED ACCOUNT 3 Y YES, NO

VALIDATE COMMON CUSTOMER | 4 Y YES, NO

COMMENT 5 Y NA

EQUITY OUT TRANSFER:
e This is used to transfer Trade Equity from old account. This transaction will be
automatically posted by OFSLL as part of Trade and Trade Fix.
2-122 ORACLE

Financial Services



e Account Equity Out field [ACC_EQUITY_OUT_AMT] will be updated with transaction
“AMOUNT".

e Below comment will be posted on posting of this transaction.

e “ACCOUNT EQUITY OUT TRANSFERRED ON <DATE> TO ACCOUNT NUMBER
<ACCOUNT NUMBER> WITH VALUE <VALUE>, < TRADE TYPE > AND

<COMMENT>"
Descript | Gro | Acti | Monet | Txn/Bal | Statement Bat | Man | Statement | G
ion up on ary Type Txn Type ch ual Print L
EQUITY
ouT TR | POS
TRANSF | D T Y N N N N N N
ER
Parameter code | Sort | Required | LOV
TXN DATE 1 Y NA
ACCOUNT NBR | 2 Y NA
AMOUNT 3 Y NA
COMMENT 4 Y NA
UPGRADE
TRADE TYPE 5 Y SPLIT
COMBINE

EQUITY IN TRANSFER:

e This is used to transfer Trade Equity into new account. This transaction automatically
posted by OFSLL as part of Trade and Trade Fix.

e Account Equity In field [ACC_EQUITY_IN_AMT] updated with transaction “AMOUNT".
e Below comment posted on posting of this transaction.

e “ACCOUNT EQUITY IN RECEIVED ON <DATE> FROM ACCOUNT NUMBER
<ACCOUNT NUMBER> WITH VALUE <VALUE>, < TRADE TYPE > AND
<COMMENT>"

Gro | Acti | Mone | Txn/Bal | Statement Bat | Man | Statemen | G

Description up |on | tary Type Txn Type ch |ual |tPrint L

EQUITY IN TR | PO

TRANSFER D ST Y N N N N N N

Parameter code | Sort | Required | LOV

TXN DATE 1 Y NA

ACCOUNT NBR | 2 Y NA
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AMOUNT 3 Y NA

COMMENT 4 Y NA
UPGRADE

TRADE TYPE 5 Y SPLIT
COMBINE

EQUITY IN MAINTENANCE:
e This transaction is used to override Account Equity In field [ACC_EQUITY_IN_AMT].

e Once posted system does not validate amount transferred using trade. It just overrides
the amount provided by the user.

e Below comment posted on posting of this transaction.

e “ACCOUNT EQUITY IN MAINTAINED ON <DATE> WITH VALUE <VALUE>,
<REASON> AND <COMMENT>".

Description Gro | Act | Mone | Txn/Bal | Statement Bat | Man | Stateme | G
P up |ion | tary Type Txn Type ch | ual nt Print L

EQUITY IN TR | PO

MAINTENANCE | D ST Y N N N Y N N

Parameter code | Sort | Required | LOV

TXN DATE 1 Y NA

AMOUNT 2 Y NA

COMMENT 3 Y NA

RESCISSION:

e After successful completion of trade, customer can come back requesting to VOID newly
created account. OFSLL supports this functionality using this transaction.

e Post this transaction on new account. This transaction results the following on old and
new accounts.

e Post this transaction to reverse trade in ‘Upgrade’ (one-to-one) or ‘Combine’ (many-to-
one) scenarios.

Existing (old) / Source Account

New / Target Account

Reverses TRADE transaction and updates
Equity Out value to zero.

If Trade transaction is posted on Linked and

Reverses all active transaction on the multiple
new Accounts created from Combine or One-to-

Master Account, the same is reversed and
account status is reverted to earlier status.

One trade and Void the new Accounts.

Removes Equity Out value updated in
Account Details > Traded Details screen.

Removes Equity IN and Trade Equity value
updated in Account Details > Traded Details
screen.

Comment is posted in the format

Comment is posted on multiple new
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Existing (old) / Source Account New / Target Account
ACCOUNT TRADE REVERSED DUE TO Accounts in the format RESCINDED ON

RESCISSION ON <DATE> FOR THE <DATE> FOR THE <REASON> AND
<REASON> AND <COMMENT>. <COMMENT>.
Descript | Gro | Acti | Monet | Txn/Bal | Statement Bat | Man | Statement | G
ion up on ary Type Txn Type ch ual Print L
RESCIS | AC | POS
SION c T N N N N Y N N
Parameter code Sort | Required | LOV
TXN DATE 1 Y NA
PROCESS MASTER ACCOUNT | 2 Y YES, NO
COMMENT 4 Y NA

STATUTORY RESCISSION
REASON CODE 3 Y

LATE RESCISSION

TRADE REVERSAL:

e This transaction should be posted to reverse trade in Upgrade (one-to-one) or Split (one-
to- many) scenarios.

e This transaction works similar to RESCISSION and should be posted on old account.
e System reverses Trade transaction on old Master and Linked account if posted.

Description Gro | Acti | Mone | Txn/Bal | Statement Bat | Man | Statemen | G
P up on tary Type Txn Type ch | ual t Print L
TRADE AC | PO
REVERSAL | C ST N N N N Y N N
Parameter code | Sort | Required | LOV
TXN DATE 1 Y NA
COMMENT 4 Y NA
STATUTORY RESCISSION
REASON CODE | 3 Y
LATE RESCISSION
CHARGE OFF:
e This transaction is enhanced to add a new input transaction parameter “PROCESS
MASTER ACCOUNT".
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e |f this parameter is Y then system automatically posts CHARGE OFF transaction on
Master and Linked Account associated to it.

o If system is unable to post this transaction of Master and Linked Account associated,
then entire transaction is rolled-back.

Parameter code Sort Required LOV

PROCESS MASTER ACCOUNT | 2 Y YES, NO

Trade Details Report

Added a BIP report to display traded accounts and accounts which are created as part of the
trade within the date range provided.

e Following fields added as input parameter for report:

Field Name Field Type | Comments

Company LOV Populated with Company setup maintained

Product Type | LOV LOAN/LINE/LEASE, Default value should be ALL
Trade Status LOV COMPLETED/FAILED, Default value should be ALL
From Date Date It should refer to LAST_UPDATED_DT of Trade Details
To Date Date It should refer to LAST_UPDATED_DT of Trade Details
Report Format | LOV NA

e This report is required daily, and a batch job created to generate the Report. The report
batch job lists all accounts traded and created as part of Trade as on report generation
date.

e The Report batch job is available under existing SET-RPT 40: Servicing Reports

e The report displays all accounts where “Trade Details” are populated i.e.
Last_Updated_Dt as on report generation date

e If an account has multiple assets then points added and displayed for accounts.
e Primary customer details are displayed on reports.
e The data in report grouped by Company/Branch.

2.25.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.26 Revenue Recognition

2.26.1 Overview

In Vacation Ownership Industry, Vendors recognize revenue when equity becomes greater than
or equal to threshold value (X) % of net sale price of the asset on the contract. This feature
enables user to configure Current and Target RevRec. Once target is meet on an Account then
system will mark the Account as qualified.

2.26.2 Description

New Account fields are added in Customer Service = Account Details = Trade Details to
record Revenue Recognition fields. Below is the brief overview of each field

Summary = Collections | Customer Service = Account Detalls | Customer Details =~ Customer Preferences  Transactlon History | Pmit Modes = Bankrupicy | RepofForex

Account Details | Statements | Rate Schedule  Insurances | Condition Details | Securitization | Contract Information | Trade Details

Trade Details [=] view || & Audit
View = Format ~ [ f ki Detach Wi 5]
= o A g % o Current Qualification Month End JiRatt Date of Previous
Eqquity Out Reviter Equity Target RevRec Equity T Qualification Tnd Date of Quadification Qualification
0,00 1,250.00 284.40 ¥ Y 09/30/2019 12:00:00 AM
1
Equity Transfer Details L] view || &2 Audit
View v Format » [ Freeze [ Detach Wrag Bl show ai
. # : 5 Equity 3
From Account # To Account # Tranutarred Trade Type Status
No data to display.
¥
Field Description

Display the current Account Revenue Recognition Equity Amount. The
value is populated based on calculation defined in User Defined
Parameters.

RevRec Equity

Display the Target Revenue Recognition Equity Amount the Account

Target RevRec should meet. The value is populated based on calculation defined in
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Equity

User Defined Parameters.

Current
Quialification Ind

Here Y’ indicates that the Contract Equity is ‘greater than or equal to’
Account Revenue Recognition Equity.

Month End
Quialification Ind

Here Y’ indicates that account is marked as qualified at end of month.

Date of
Quialification

Account Revenue Recognition Qualifier Date.

Date of Previous
Quialification

Last Account Revenue Recognition Qualifier Date when the account
was previously qualified
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Qualification details are updated using two batch jobs

e SET-REV1: DAILY REVENUE RECOGNITION PROCESSING batch job is used to
process on daily basis to check if Account Revenue Recognition Equity is ‘greater than or
equal to’ Target Revenue Recognition Equity. If yes, the Current Qualification Indicator is
set to 'Y’. However, the above validation is ignored and Current Qualification Indicator is
always set to ‘N’ if Target Revenue Recognition Equity is not meet or Account has any
conditions available in lookup REVREC QUALIFIER EXCLUSION ACCOUNT
CONDITION [REVREC_QUAL_EXCLUDE_COND_CD]

e SET-REV2: MONTH END REVENUE RECOGNITION PROCESSING batch job is used
to process on month end to populate below.

> If Current Qualification Indicator =Y and Month End Qualification Indicator =N, then
batch job updates the following:
- Month End Qualification Indicator =Y
- RevRec Last Qualification Date with NULL
- RevRec Qualification Date with Current Month End Date

> If Current Qualification Indicator =N and Month End Qualification Indicator =Y, then
batch job updates the following:

- Month End Qualification Indicator =N
- RevRec Last Qualification Date with RevRec Qualification Date
- RevRec Qualification Date with NULL

>  If (Current Qualification Indicator =Y and Month End Qualification Indicator =Y) or
(Current Qualification Indicator =N and Month End Qualification Indicator =N) then
batch job has no updates.

Example of use cases for batch job update

Dateof | Surent | arth End Ao | quaication | Lest Qualfcatr
Indicator PROCESS)
01-Jan-19 N N
15-Jan-19 Y N
31-Jan-19 Y Y 31-Jan-19
01-Feb-19 N Y 31-Jan-19
28-Feb-19 N N 31-Jan-19
01-Mar-19 Y N 31-Jan-19
31-Mar-19 Y Y 31-Mar-19
01-Apr-19 Y Y 31-Mar-19
30-Apr-19 Y Y 31-Mar-19
01-May-19 | N Y 31-Mar-19
15-May-19 | Y Y 31-Mar-19
31-May-19 | Y Y 31-Mar-19
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2.26.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.27 Financial Services Cleanup

2.27.1 Overview

From the current release, support to Fax In Service is deprecated. Few parameters removed as
part of FIN SERV CLEAN UP.

2.27.2 Description

The following parameters removed as part of FIN SERV CLEAN-UP.

Parameter Description

FIN_TIMEOUT This parameter is used to define the polling interval for Fax-
in service, i.e. minutes after which the Fax-in service would
poll to establish a connection periodically. Input parameter
value is numeric.

FIN_IMAGE_STATUS_CD This parameter is used to set-up default image status for fax-
in service. The input parameter values are ‘RUSH’, ‘NEW’,
‘SKIP’, ‘BAD’, ‘PROCESSED’ and ‘PURGED".

FIN_POP_PASSWORD This parameter is used to define the pop password to access
the fax-in service. Input parameter value is user (System
Administrator) defined.

FIN_ POP_SERVER This parameter is used to define the pop server to receive
the faxes in fax-in service. Input parameter value is location
and path of the server.

FIN_POP_USERNAME This parameter is used to define the pop username to
access the fax-in service. Input parameter value is user
(System Administrator) defined.

FIN_STORAGE_DIRECTORY | This parameter is used to set-up the Oracle directory object
name for storing the images received through the fax-in
service. Input parameter value is user (System
Administrator) defined.

FIN_TEMP_DIRECTORY This parameter is used to define the temporary directory to
be used for the fax-in service. Input parameter value is user
(System Administrator) defined.

FIN_DOWNTIME_BEGIN This parameter is to define the start of period for down time
of Fax-in service. Input parameter value is time in 24 hour
format.
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Parameter Description

FIN_DOWNTIME_END This parameter is used to define the end of period for down
time of Fax-in service. Input parameter value is time in 24
hour format.

FIN_ ERROR_LIMIT This parameter is used to define the error limit for Fax-in
service. Input parameter value is numeric.

2.27.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.28 Web Services

2.28.1 Overview

New Restful web services added and enhanced 10 existing web services.

2.28.2 Description

Following new web services introduced:

Asset tracking attribute Update Service
Credit Bureau Update Service

Master Account Rolledup Balance Details
Update account tracking attribute Service
Business tracking attribute Update Service
Customer tracking attribute Update Service
Create Securitization Service

Delete Account Service

Calculate Parameter Update Service

Below web services are updated:

For more details refer to the swagger documentation.

Validate Token Service

Scheduler Service

Scheduler Force Re-Submit service
Asset Create Service

Asset Update Service

Asset Fetch Service

Producer Service

Producer Update Service
Calculator Service

Account Onboarding Service
Account Details

Account Tracking Attribute Fetch Service

2.28.3 Seed Data
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Refer ‘Appendix: Seed Data’ chapter.
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2.29 Web Services — Reqgion code dependency

2.29.1 Overview

Existing Web services in OFSLL has dependency with Region code and works only if the region
code is setto 1

2.29.2 Description

Dependency with region code removed and RESTFUL services in OFSLL works irrespective of
region code.

2.29.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.30 Securitization Pool Service

2.30.1 Overview

Securitization functionality enhanced with below new capability:

e Enabled securitization file upload to do following actions:

Add Accounts to
Remove Accoun

pool
ts from the pool

Transfer account from Pool A to Pool B (for configurable statuses).

2.30.2 Description
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Service facilitates the following:

Following use cases are addressed:

e The purpose of this file definition is to allow the following actions:

Add Accounts to
Remove Accoun

pool
ts from the pool

Transfer account from Pool A to Pool B (for configurable statuses).

Action on running of batch job:

Sl no. | Pool Id in File Pool Id on Action Action Details
Current Account
1 I= UNDEFINED | UNDEFINED Add to new Pool Post ‘Add Account’
(ABCD) transaction on Pool ABCD
2 UNDEFINED 1= UNDEFINED Remove Account Post ‘Remove Account’
(ABCD) from existing Pool | transaction on Pool ABCD
3 I= UNDEFINED | = UNDEFINED Remove Account Post ‘Remove Account’
(ABCD) (EFGH) from existing Pool | transaction on Pool EFGH
a(r;glAdd to New Post ‘Add Account’
P transaction on Pool ABCD
4 SAME as Pool SAME as Pool Id | Do Nothing and Show Error — Account
Id on Account in file (ABCD) Report error already mapped to Pool.
(ABCD)

Field Details and Validations:

Mand

Field Description Data Type atory Validation
L Valid Pool Id should be provided
Pool Id This f|eld shoqld Varchar2(30) | No and additional validations are
consists of valid pool Id
documented below.
Account This field should Account number should be valid
Number consists of valid Varchar2(30) | Yes and additional validations are

account numbers

documented below.
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System check validations related to accounts and ignores any qualification of query
criteria to upload accounts to pool

File definition is comma separated file.

If the account is transferred from Pool A to B, system posts transactions on each pool.

‘Remove Account’ transaction on pool A and ‘Add Account’ transaction on Pool B.

Txn: ‘Remove Account’ on From Pool Transaction would be posted on pool A with
following information

Reason: Pool Account Transfer
Date: System date of file upload.

Txn: ‘Add Account’ on To Pool transaction would be posted on pool B with
following information

Reason: Pool Account Transfer

Date: System date of file upload.

Note: This txn is posted, only after validating ‘From & To Pool Id’ details.

If the account is transferred from Pool A to UNDEFINED, system posts transaction on
pool A.

‘Remove Account’ transaction on pool A would be posted.

Validation Error
Applicable | Field Validation Action / Comment
. Message
to Action
If the pool Id provided | Pool ID Pr.ocesses valid rows a}nd
Lo - ; rejects the corresponding
134 Pool Id in file is not existing or | doesn't g
) record and show reason in
NULL exist
error log.
If the pool status is not | Invalid rper%((::?ssiﬁs ::lglrlri?\(l)vrsl d?:d
12,34 Pool Id in the configured list of | Action J P 9
record and shows reason in
statues (From and To) | Code.
error log.
If the account number | List of .
) X ; Processes valid rows and
is not found, batch job | rejected . i
Account . rejects the corresponding
1,2,3,4 rejects the records — 4
No. , : record and show reason in
corresponding record Reject arror lo
to upload / transfer Reason 9.
If the system
parameter List of Processes valid rows and
Account POOL_ACTIVE_ACC | rejected rejects the correspondin
1,3 OUNTS ONLYisY | records — J ponding .
No. ' . : record and shows reason in
and file contain Reject error o
accounts other than Reason 9:
‘Active’
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Validation Error
Applicable | Field Validation Action / Comment
. Message
to Action
List of
If the pool > Account | rejected
Company is different | records — _
from Pool Company Reject Processes valid rows and
13 Compan Reason rejects the corresponding
’ pany | or Account Company | (Cannot records and shows reason in
of From and To Pools | process error log.
are different, system record,
rejects record. Company
Mismatch)
If the pool > Product
Type belongs to ‘Loan’ | List of
and file contains rejected
‘Lease’ accounts or records —
vice-versa Reject .
Reason Pr_ocesses valid rows a_md
Product If the pool > Account rejects the corresponding
1,3 . (Cannot .
Type Product Type is 10CESS records and shows reason in
different from Pool P error log.
record,
Or Account Product Product
Type of From and To Type
Pools are different, Mismatch)
system rejects record.

Setting up the configuration:

o System allows to Add / Remove accounts from pool only for the configured pool statuses.

e To enable this, created new lookups as follows:
POOL_ADD_ACC_CRITERIA (CRITERIA TO ADD REMOVE ACCOUNT FROM POOL)

POOL_REMOVE_ACC_CRITERIA (POOL CRITERIA FOR REMOVING ACCOUNT)
Following seed data maintained in base:

POOL_ADD_ACC_CRITERIA|CRITERIA TO ADD REMOVE ACCOUNT FROM

POOL|N|Y

POOL_REMOVE_ACC_CRITERIA|POOL CRITERIA FOR REMOVING
ACCOUNT|N[Y
POOL_ADD_ACC_CRITERIA|H||2|HELD|N|Y
POOL_ADD_ACC_CRITERIA|O||1]OPEN|N|Y

Assumption:

POOL_REMOVE_ACC_CRITERIA|N||2INEW|N[Y
POOL_REMOVE_ACC_CRITERIA|O||1|OPEN]|N|Y

e User expected to create the pool from screen and mention the exiting pool ID in file to
upload accounts to existing pool. (File does not create any new pool).

e System allows transfer of Account between two pools ignoring the pool class / type.

2.30.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.31 Linking an existing Asset / Business from AOB WS

2.31.1 Overview
Currently in Account Onboarding web service (WS), users / third-party system cannot link an

existing asset or business. Enhanced such that system links the customers and the users can link
the existing Asset / Business.

2.31.2 Description
Link existing Business from AOB WS

Introduced the following new elements to the AOB service:

Parent Element in Data ..
AOB Element Type Description
Business Details BusNumber Number System generated unique business
number
ApplicationContract | LinkExistingBusiness Indicates whether the account should
; . Varchar . . 4
Details Indicator be linked to existing business

e A new system parameter “AUTO GENERATE BUSINESS NUMBER FOR CONVERSION
PROCESS” is used by the system to determine if the Business Number should be
generated automatically or provided by the external interface.

e UpdateBusinessinfo: [existing element] this filed is used to update existing business
details with new details provided as part of the new Account onboarding request.

> If there are any changes in the BusinesDetails block, system overwrites the business
details

> If there are any changes in the Business Address or Business Telecom, system
creates the new business address/ telecom details instead of overwriting the
information.

> System also inserts a system-generated comment with New Values and Old Values
in a single comment.

e LinkExistingBusinessind: [new element] this field is used to link existing business
provided with new Account.
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> If this is 'Y’ and if the business number exists, the AOB having
CreditLimitMaxAmount system will show an error, “Max limit is not required for
existing business”

> If user expects to utilize the credit limit amount, system checks the following values
from the AOB and then utilizes the amount.

- UpdateBusinessinfo = 'Y’
- LinkExistingBusinessIndicator = 'Y’
- BusinessNumber should exist in the system with Credit Limit greater than ‘0’

Criteria Changes to existing business

If Business having Limits | If Available Amount is less than Liable Amount of contributed
‘Credit Limit greater than | Account, system sends error message as ‘No limit available to add
‘0’ the business’

Limit Expiry Dt should be less than the process date
Adjusting the limit as follows
Total Utilized Amt = Add Liable Amount to this field

Available Amt = Deduct Liable Amount from this field.

If Linked Business not No impact on the Credit Limit Fields and ignores the limit details
having Limits

Or

UpdateBusinessinfo =
AN)

Note: Liable Amount = ‘AmountFinanced’ element from the AOB

System checks whether ‘Business Number’ provided in the AOB request or not.

Step 1: if Business Number provided =Y (not equal to UNDEFINED/NULL)

Checking, Link Existing Business Ind is Y’

e If Business Number is not found then system throws an error that Valid Business Number
is required

e |If Business Number found then system Links It (No need to check system parameter)

» If Update Business Info = Y then update existing details from request
> If Update Business Info = N then ignore the request details

e Link Existing Business Ind = N (Update Info Flag not applicable)

> If Auto Generate Business Number = Y then system throws error that Business
Number must be system generated

> If Auto Generate Business Number = N then create new business record using
provided business number

Step 2: if Business Number provided = N (UNDEFINED/NULL) (Update Info Flag not
applicable)

Checking Link Existing Business Ind = Y,

e Then throw error that Valid Business Number is required

Checking Link Existing Business Ind = N

ORACLE

Financial Services



e If Auto Generate Business Number = Y then create new business record using a system-
generated business number

o If Auto Generate Business Number = N then system throws error that Valid Business
Number is required

e System also check, sum of the ‘CreditLimitUtilizationPercent’ fields is not greater than
100 which includes for:

> SBL — all relation’s CreditLimitUtilizationPercent + Business —
CreditLimitUtilizationPercent

> BUS — Business CreditLimitUtilizationPercent
>INV - all relation’s CreditLimitUtilizationPercent

e Even if the customer does not have any limits, this check happens. l.e., say for SBL
account there are one Primary with limits, one secondary without limits and business with
limits. System still checks the sum of all CreditLimitUtilizationPercent fields of
Primary/Secondary/Business and it should not be more than 100.

Link existing Asset from AOB WS
e Introduced following new elements to the AOB service

“EEm [E el 7 Element Data Type | Description
AOB
Appll_catlonCOIIateraI AssetNumber VARCHAR?2 | Stores asset number
Details

UpdateAssetinfo | Varchar Asset override indicator
ApplicationContract LinkExistingAsset Varchar Indicates whether the account
Details Indicator should be linked to existing asset

e A new system parameter “AUTO GENERATE ASSET NUMBER FOR CONVERSION
PROCESS” used by the system to determine if the Asset Number is to be generated
automatically or provided by external interface.

> UpdateAssetinfo: [New element] this filed is used to update existing asset details
with new details provided as part of the new Account onboarding request.

» LinkExistingAssetind: [New element] this field is used to link existing assets
provided with a new Account.

System checks whether ‘Asset Number’ provided in the AOB request or not

Step 1: if Asset Number Provided = Y (not equal to UNDEFINED/NULL)

e Checking, Link Existing Asset Ind is 'Y’
> If Asset Number is not found then system throws an error that Valid Asset Number is
required
> If Asset Number found then system Links It (system will not check system parameter)
- If Update Asset Info = Y then updates existing details with request details
- If Update Asset Info = N then ignores the request details
e While linking the asset to an account using the asset number provided in the AOB, asset

status should be in New, Inactive, or Released, only then system links to an account and
change the asset status to ‘Active’

o If the request came with Update Information flag and the AOB collateral status is in New,
Inactive, or Released, only then system links to the new account and change the asset
status to ‘Active’ and update all other asset details [only collateral block]
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e Note: if an asset linked to another account, system inserts an asset history record and
link to new on-boarded account.

e Link Existing Asset Ind = N (Update Info Flag not applicable)

> If AUTO GENERATE ASSET NUMBER =Y then throws error that Asset Number
must be system generated

> If AUTO GENERATE ASSET NUMBER = N then creates new Asset record using
provided Asset number

Step 2: Asset Number Provided = N (= UNDEFINED/NULL) (Update Info Flag not applicable)

e Link Existing Asset Ind =Y
> System throws an error that Valid Asset Number is required
e Link Existing Asset Ind = N

> If AUTO GENERATE ASSET NUMBER =Y, then system creates new Asset record
using system-generated Asset number.

> If AUTO GENERATE ASSET NUMBER = N, system throws an error that Valid Asset
Number is required.

2.31.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.32 Credit Bureau Onboarding WS

2.32.1 Overview

When OFSLL is being implemented in new geography, one of the challenges is to do a Credit
Bureau integration. Hence, to overcome this, we are providing the new generic credit bureau web
service. Using this service during the OFSLL implementation, team has to get request from Credit
Bureau, do convert the same to the OFSLL Put Request, and call the web service (one-time activity).

2.32.2 Description

Setup > User > Credit Bureau

e Introduced new ‘External Report’ indicator to the Setup > Credit Bureau > Report
Formats > Report Format Details

e On click on ‘Add’, this field defaults with ‘N’

Setup > Webhook

e Introduced a new non-mandatory LOV as Bureau and system refers to the
‘CRB_SOURCE_CD’ LOV. On clicking ‘Edit’, this LOV becomes read only along with
Channel in the Event Details section

e While saving the record with an enabled indicator as 'Y’, system does not allow saving if
it is the same Bureau once again. if exist, shows an error ‘Record already exists with
same bureau’

e To add a new record, disable the existing record and enable the new record with the new
Bureau

Origination / Customer Service > Credit Bureau changes

e  While submitting the request, system checks if the External Report indicator is ‘Y’, if it is,
system checks the Webhook channel details from the webhook setup. If it exists, then
allows submitting the request.

e On submitting the request, system creates the Json Payload with the following
information and sends it to the service URL identified in the webhook setup

» Credit Request Details | Consumer Details | Address Details | Business Details |
Business Address Details | Credit Bureau Parameters | Credit Bureau Report
Formats | Report Format Details

o After submitting the record based on the External Report indicator is 'Y’, system accepts
the response from the /common/creditbureau WS

Credit Bureau PUT Web-service

Put(Create Bureau Response)

e Once the credit request is sent to Service URL, using this service, third party user can
send the actual response using this service so that OFSLL can show it on OFSLL
screens

e Each Report Header should have either customer details/business details in a single
block

> If the user provides both, the system should ignore the other values and create the
record. i.e., if the request-id belongs to the applicant/customer, then ignore the
business values.

e In servicing, only Bureau Report is applicable.
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Validations:
o |If the report has the ‘External Report’ flag as 'Y’, then only system accepts the request
e System validates the request-id and report id, if not sends an error response.
e ‘Status’ is validated with ‘CRB_REQ_STATUS_CD’
e ‘Source’ is validated with ‘CRB_SOURCE_CD’
e ‘Score Model' is validated with ‘BUREAU_SCORE_MODEL_CD’

e System accepts this service if the request status is in ‘SUBMITTED’ only, if not, sends an
error.

System will change the ‘Bureau Details > Status’ based on the CREDIT_REQUEST_DETAILS >
CRL_CRB_REP_STATUS_CD as follows

CRL_CRB_REP_STATUS_CD Bureau Details >
Status

Primary Secondary

Completed / Completed No Hit | Completed / Completed No Hit Completed

Completed / Completed No-Hit | FAILED FAILED

FAILED Completed / Completed No-Hit FAILED

FAILED FAILED FAILED

Submitted Completed / Completed No-Hit/ | Submitted

FAILED

Completed / Completed No-Hit | Submitted Submitted

| FAILED

WAITING/CANCELLED/RUNNING/READYPENDING Sends an Error
response

e Once the Bureau Details > Status is changed to either ‘Completed / Failed’, system
changes the ‘Dashboard > System Monitor > Jobs > Credit Request > ‘Status’ to
‘Completed / Failed’

e Provided the new ‘Report Summary’ elements to the SCR_CRED_SUMMARY User
Defined Table as part of the Seed Data for user to configure it for Scoring Models
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2.32.3 Screen Changes

Setup > User > Credit Bureau

Report Format Details

View + Format « % Freeze Detach <=l Wrap Elﬂ
Report Report Type Report Class :“ﬂ‘:\,zsq“m Score Type
|| CREDITREPORT ~ ACROFILE W/ON-L... CONSUMER ¥

Report Format Details

Report CREDIT REPORT Multi Request

*Report Type  ACROFILE W/ON-LINE DIRECTORY { v Allowed
Score Type

* Report Class  CONSUMER
Addl Product

o Add | FEdt | [F]view | o Audt

Addl Product Inguiry Limit Default External Report
L N
E Save and Stay. E Save and Return (:zﬁemrn

Inquiry Limit w
* Defaul

Setup > Webhook

Webhook
Webhook
view v Format + (58] Freere igfiDetach | ol Wrap B 48 Generate 3 Test
Channel Authentication Modg Bureau Enabled
|| bureau_webhook BASIC EXP N
<
Webhook
Channel  BUREAU_WEBHOOK * authentication  gasIc -
Client Secret  ZXKMGVWQWIPUPLVIFRaUXDSM  a mode
Key hiR2NpT2KSVVEVXhNaUosLmVSS * User Name
npkvOlpT2KWFIVSkUMDIMSWI3a
. . - i " * password
Service URL  http: /fwhf00igr.in.orade.com:8003/ic/apifinteg
Test SEWiEE http: ffwhf00ls].in.orade. com: 5004fwebhook se
* Enabled []

[%] Close

geadd | AEdit | [E View | < Audit

E Save and Stay, E Save and Return (:z Return

Verified

2.32.4 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.33 Delete Account WS

2.33.1 Overview

In OFSLL, the only way to delete the accounts is, using the purging batch jobs. Once the purging
days criteria met then accounts will be deleted from archived tables. Now, using the new web
service, user can delete the accounts in ad-hoc.

2.33.2 Description

e Introduced a new ‘Delete Account Service’ [/servicing/account] is used to delete any type
of void accounts (loan/line/lease) from system.

e Those void accounts need to be on-boarded via Account On-Boarding service only i.e.,
application funded from origination and converted accounts are not allowed to delete
even those are voided.

2.33.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.34 Calculator Web Service Enhancement

2.34.1 Overview

Flexible Repayment Options provided for Lease Calculator web service to provide the results
according to Ul.

2.34.2 Description

Following “Flexible Repayment Options” calculations elements provided for Lease product also
for “INTEREST RATE” method.

e  Skip Payment
e User Defined
e Graduated
> Step up
> Step Down
> Bullet Payment

o “Extendable Balloon” is not required for Lease, if provided system sends an error.

Validations:

For “Product Type = Loan” then, if following elements are provided in the request, system sends
an error message as “For product type Loan, ‘CalcMethodCd’ and ‘ColMethodCd’ are removed.”
Because, these two elements are not related to Loan

e "CalcMethodCd"
e "ColMethodCd"

Note: For “Product Type = Lease” if "CalcMethodCd" and "ColMethodCd" are not provided in the
request then following error message is provided.

Error Message: "Element/value is required".
2.34.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.35 Reports
2.35.1 Overview

New Reports are introduced and existing one report is updated based on 14.8 Enhancements.

2.35.2 Description

Five new reports are introduced in Customer Servicing for below business requirements

e Account Asset:
> Provide list of all active accounts under available on an Account
e Funding Accounts Log Details:

>  Provide list of all Accounts that are funded between the dates provided. This report is
used when customer is using only OFSLL servicing system and not origination.

e Master Account Payment Log:

» Provide the payment details received on Master, Linked and Associated Account.
e Payment Allocation Details:

> Displays all allocation buckets to which payment is applied for an Account.
e Trade Details

» Lists all the Accounts which were traded and accounts which are created as part of
the trade within the date range provided in input parameters.

Existing “GL Posting Log” report is enhanced to support configurable 1-10 GL headers instead of
existing hard coded headers.

2.35.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.36 GL Posting Log Report Changes

2.36.1 Overview

Currently, the GL posting log report shows only 5 segments. Now, system shows all 10 segments

2.36.2 Description

Existing GL Posting Log report been modified to include additional segments.

e Currently, the report displays only 5 segments, the enhanced report how displays
Segments 1-10

From Date: 10/01,/2018

Report : GL Posting Log
Date: 10/22/2019 15:11 PM
21/2019 To" 10,35

ORACLE’

Financial Services Lending and Leasing

Company: NLO02

ALL AMOUNT ARE IN N2D
Date | Description | Segment | Segment | Segment | Segment | Segment | Segment | Segment | Segment | Segment | Segment Dr Amount | Cr Amount
1 2 3 4 5 3 7 8 9 10
PAYMENT - 110000 | c2-001 27.15 0.00
ADVANCE
PAYMENT - 110000 | cB 002 | 11222 323232 129.00 0.00
ADVANCE
PAYMENT - 200000 CB-001 0.00 27.15
ADVANCE
PAYMENT - 200000 | cB-00z | 11222 323232 0.00 199.00
ADVANCE
PAYMENT - 110000 CB-002 11222 323232 105.85 0.00
ADVANCE
BILLED
PAYMENT - 200000 | CB-002 | 11222 323232 0.00 105.85
ADVANCE
BILLED
Company Total: 332.00 332.00
Company: US01
ALL AMOUNT ARE IN USD
Date | Description | Segment | Segment | Segment | Segment | Segment | Segment | Segment | Segment | Segment | Segment Dr Amount | Cr Amount
1 2 3 4 5 3 7 8 9 10
10/15 | PAYMENT 110000 | CB-001 11.00 0.00
/2019 | ADVANCED
BILLED
10/15 | PAYMENT 200000 | CB-001 0.00 11.00
/2019 | ADVANCED
BILLED
10/17 | PAYMENT 110000 | CB-001 | ACTIVE | PRODUCT | FUNDING | FURDING | FUNDING | FUNDING | FUNDING | FUNDING 10,986.32 0.00
/2019 | ADVANCED _TYEE _TYPE | _TYPE | _TY¥PE _TYPE _TYPE _TYPE
BILLED
16/17 | PAYMENT 300000 | CB-001 | ACTIVE | UNDEFIN | UNDEFIN | UNDEFIN | UNDEFIN | UNDEFIN | UNDEFIN | UNDEFIN 6.00| 10,986.32
/2019 | ADVANCED ED =0 =0 ED =D ED =D
1of2

2.36.3 Seed Data

Refer ‘Appendix:

Seed Data’ chapter.
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2.37 Account Asset Details Report

2.37.1 Overview

Provide new BIP report to display list of all active assets available on accounts.

2.37.2 Description

‘Account Asset Details Report’ provided with following input parameters:

Field Name Field Type | Comments

Company/Branch LOV Default Value is ALL

Product Type LOV LOAN,LINE,LEASE: Default Value is ALL

Assets Sub Type Lov It refers to Asset Sub-Type Setup
Default Value is ALL

Account Number Text Field Default Value is ALL

Asset Phase Lov It refers to ASE_PHASE_NBR_CD

Number Default Value is ALL

Asset Inventory Site Lov It refers to ASE_INVENTORY_SITE_CD
Default Value is ALL

Report Format LoV PDF,CSV,EXCEL,DATA,HTML

Default Value is PDF

e This report generated daily; a batch job provided to display the report. This report

displays active asset details available on account.

e In‘SET-RPT40’ Batch Job Set, provided new batch job for ‘Account Asset Details Report’

with Company as ‘ALL’, so that Company level filter used for required report.

e The Report pulls all account’s asset details (Status =Active) irrespective of account

status.

e If an account has multiple assets, then multiple entries for account will be available with

different asset details in generated report.

e Ifinvalid account # inputted or if account does not have active asset available, then report

generated would be blank.
e Report displays Primary Customer details.
e Report grouped by Company/Branch.
e Sample Report provided in Figure 1 below.
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Report : Account Assets Detail Report
Date: 12/4/2019 19:56 PM

RACLE’
Financial Services Lending and Leasing

Company : AUSO1
Branch :RUS01
Haster Rccount # First FLddT Tast Generacion | Contract | Polnts | Building | Unit | Week Tite | Associa ase T=ag: Aszet
Account # Name Name Name Date tion Id Start Date | Identification #
UNDEFINED | 20180100168 LINE NAVEEN 01-JAN- AR
506 RUS 5C5 2018
UNDEFINED | 20180100168 LINE NAVEEN 01-JAN- AR
514 RUS 5Cé 2018
UNDEFINED | 20180100168 LINE WEEKLY 01-JAN-
522 2018
UNDEFINED | 2018010018 [ LINE NRVEEN 01-JAN- AR
530 RUS 5C5 2018
[UNDEFINED | 20180100188 TINE TAVEEN GI-JAN- R
548 RUS 5C% 2018
[ ORDEFINED | 20180100168 | LINEA WEERLY GI-JAN-
564 2018
[ ORDEFINED | TIRE TRVEEN GI-JAN- )
€05 RUS 5C6 2018
TUNDEFINED | 20180100163 | LINE 2 WEEKLY 01-JAN-
€13 2018

2.37.3 Seed Data
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2.38 Funding Accounts Log Details Report

2.38.1 Overview

Provide new BIP report to display list of all accounts, funded within the dates provided in Input
Parameters and their asset details.

2.38.2 Description

‘Funding Accounts Log Details Report’ provided with following input parameters:

Field Name Field Type | Comments

Company/Branch | LOV Default Value is ALL

Product Type LOV LOAN,LINE,LEASE Default Value is ALL

Asset Type LOV It refers to Asset Type Setup, Default Value is ALL
From Date Date It refers to ACC_ACTIVE_DT

To Date Date It refers to ACC_ACTIVE_DT

Report Format LOV PDF,CSV,EXCEL,DATA,HTML, Default Value is PDF

e This report generated daily, a batch job provided to display the report. This report
displays only accounts funded as on report generation date.

e In‘SET-RPT40’ Batch Job Set, provided new batch job for ‘Funding Accounts Log
Details’.

e The Report displays “Trade Type” details if the account is created as part of Trade or else
the field is blank

e Accounts grouped by Company/Branch and Asset Type. If there are multiple assets
associated to an account then multiple entries for account will be available with different
asset details in generated report.

Report : Funded Ac
141201

ccounts Log ORACLE"
0198 19:52 PM Financial Servi

1of483

2.38.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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3. Appendix: Seed Data

Seed data for all the impacted modules against specific enhancement is available in the below
attached worksheet.

Seed_Data_
14.8.0.0.0.xIsx

To view, you can either click on the icon or open from attached documents in left menu.
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https://docs.oracle.com/cd/F22291_01/pdf/refdocs/ofsll_release_notes_attachments/Seed_Data_14.8.0.0.0.xlsx�
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4.Patches and Bugs

Bug Id

Bug Description

Fix Description

NA

NA

NA
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-NA-

5. Security Fixes
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-NA-

6. Limitations and Open issues
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7.Components of the Software

7.1 Documents accompanying the software

The various documents accompanying the software are as follows:

e Product Release Notes
e Product Installation Guide
e Installer Kit

e User Manuals and Installation manuals - These can be accessed from the link
https://docs.oracle.com/cd/F22291 01/index.htm

7.2 Software Components

Software Components of this patch release are as follows:

e Core
> Ul Components Ear file (JSF, XML, XLF, JSFF)
> Stored Procedures (Packages, Views, Java Stored procedures)
> Reporting Components(Data models(xdm), Reports(xdo, rtf))
> BIP /canned reports
e Interface
» Stored Procedures (Packages, Views, Types)
> The WSDL files for the service supported
»  XSD Structure (dictionary) for the web service
> Configuration files for the web service
> Java classes for the web service
> The service documents — describing the services
>  Extensibility Document — Describes customization for the services.
e Installation utilities
>  Script based installation for Database components
> Installation documents for Database, Ul, Web services
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8. Annexure — A: Environment Details

Component Deployment | y;achine operating | software Version
option System
Oracle WebLogic
Enterprise
Edition(Fusion
Middleware 12.2.1.3.0
Infrastructure installer
—includes ADF and
Application RCU)
server
Oracle JDK 1.8.0 221
Oracle
Enterprise
Linux 7.x L
(64 Bit) Application
Development 12.2.1.3.0
Framework
Qraclg Database Oracle Database 12.1.0.2.0
Fmanmal . Server Enterprise Edition /122.0.1.0
Services Centralized /18.3.0.0.0
Lending and
Leasing Reporting Oracle Business 12.2.1.3.0/
Server Intelligence Publisher | 12.2.1.4.0
Windows Microsoft Edge 44.17763.8
10 (Patch (64 Bit) 31.0
Version
1703) Mozilla Firefox
(64 Bit) 68.2.0esr
Client
Machines 78.0.3904.
Google Chrome 108
(64 Bit) (Official
Build)
Mac OS X Apple Safari 13
(64 Bit)
ORACLE
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9. Annexure — B: Third Party Software Details

For information on Third Party Software Details, refer to Licensing guide available in OTN library -
https://docs.oracle.com/cd/F22291 01/pdf/refdocs/Licensing Guide.pdf
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